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SOP 001: Routine Cell Culture 
 

Description: Cell culture refers to the removal of cells from an animal or plant and their subsequent 

growth in an optimal artificial environment. The cells may be removed from the tissue directly and 

disaggregated by enzymatic or mechanical means before cultivation, or they may be derived from a cell 

line or cell strain that has already been established. All cell culture must be undertaken in a 

microbiological safety cabinet using aseptic technique to ensure sterility. 

 
SOP 001.1 Preparing an Aseptic Environment 

 
1. Turn on the hood by: 

a. Opening the hood curtain to the correct position to maintain laminar air flow. 

b. Removing the lip and leaving it safely aside. Press on/off button. Confirm ‘yes’ by 

pressing set. Wait 10 seconds and turn the light on. 

 
2. Spray all surfaces with 70% (w/v) ethanol including pipettes, pipette guns, tubes racks and tip 

boxes. 

 

Tip: All pipettes should be purchased pre-autoclaved/sterilised or need to be autoclaved prior 

to use including glass 9” Pasteur pipettes. All media, supplements and reagents must be sterile 

to prevent microbial growth in cell culture. Some reagents and supplements will require filter 

sterilization if they are not provided sterile. 

 

SOP 001.2 Preparation of Growth Medium 
 

Before starting, check the information given with the cell line to identify what media type, additives 

and recommendations should be used (Most cells are listed with the ATCC for culture protocols). 

Most cell lines will be grown using DMEM culture media or RPMI culture media with 10% Foetal 

Bovine Serum (FBS), 2 mM glutamine and antibiotics can be added if required (see table below). 

 

Check which culture media and culture supplements the cell line you are using requires before starting 

cultures. Culture media and supplements should always be sterile. Purchase sterile reagents when 

possible, only use under aseptic conditions in a culture hood to ensure they remain sterile. 

 

Table 1. General example using DMEM media: 

DMEM - Remove 50 ml from 500 ml bottle then add the other constituents. 450 ml 

10% FBS 50 ml 

2 mM glutamine 5 ml 

100 U penicillin / 0.1 mg/ml streptomycin 5 ml 

 

SOP 001.3 Thawing Cells 
 

Method A (Fast-thaw) – used for most cells lines. 

 

1.  Prepare 50mL of pre-warmed culture media in a T75cm2 flask. 

 

2. Remove cyrovial containing the cells in 10% dimethyl sulfoxide (DMSO) from liquid 

nitrogen or -80°C and hold tightly in the palm of your hand to allow for fast thawing. 

 

Tip: DMSO is a cryoprotectant added to cell media to reduce ice formation and thereby 

prevent cell death during the freezing process. Approximately 10% is used in most cell lines 

in a slow-freeze method. This concentration at room temperature is too toxic and may 

decrease cell viability at room temperature. 
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3. Immediately transfer the cryovial to 37°C waterbath, ensuring the O-ring is held above water 

level. 

 

4. Once only a small ice cube remains, spray the cyrovial with 70% (w/v) and transfer to a 

biological safety cabinet. 

 

5. Reverse pipette a few times to thaw the remaining ice cube and transfer the entire contents of 

the cryovial to the T75cm2 flasks containing the culture medium. 

a. 1mL of 10% DMSO will dilute in 50mL culture medium to 0.2% DMSO. 

 

6. Incubate for 24 hours at 37°C, 5% C2O. 

 

Method B (Fast-thaw) – used for most cells lines. 

 

1. Prepare 10mL of pre-warmed culture media in a 15mL centrifuge tube. 

 

2. Remove cyrovial containing the cells from liquid nitrogen or -80°C and hold tightly in the 

palm of your hand to allow for fast thawing. 

 

3. Immediately transfer the cryovial to 37°C waterbath, ensuring the O-ring is held above water 

level. 

 

4. Once only a small ice cube remains, spray the cyrovial with 70% (w/v) and transfer to a 

biological safety cabinet. 

 

5. Reverse pipette a few times to thaw the remaining ice cube and transfer the entire contents of 

the cryovial to the centrifuge tube containing the culture medium. 

 

6. Pellet the cells at 1200rpm (700g), for 5 mins at maximum acceleration and deceleration. 

 

7. Pour or aspirate the supernatant containing the DMSO and resuspend in 10mL of fresh 

growth medium. 

 

8. Transfer to a T75cm2 flask and incubate for 24 hours at 37°C, 5% C2O. 

 

Method C (Slow-thaw) – for primary or delicate cell lines. 

 

1. Prepare 10mL of cold growth medium in a 15mL centrifuge tube on ice. 

 

2. Remove cyrovial containing the cells from liquid nitrogen or -80°C and transfer on dry ice. 

 

3. Immediately transfer the cryovial to 37°C waterbath, ensuring the O-ring is held above water 

level. 

 

4. Once 50% is thawed, spray the cyrovial with 70% (w/v) and transfer to ice in a biological 

safety cabinet for the remaining time to thaw. 

 

5. Reverse pipette a few times to thaw the remaining ice cube and transfer the entire contents of 

the cryovial to an empty 15mL centrifuge tube pre-cooled on ice. 

 

6. Add 1mL of cold media drop by drop over 1 minute. Add 2 mL of cold media drop by drop 

over the next minute. Add 3mL of cold media drop by drop over the next media and add 4mL 

of cold media drop by drop over the last minute. The pace of drop should increase with time. 
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Table 2. Media added to cell pellet in slow-thaw method 

1ml media added over 1st minute 

2ml media added over 2nd minute 

3ml media added over 3rd minute 

4ml media added over 4th minute 

10 ml                           4 minutes 

+ 1ml (sample) 

11ml total volume 

 

7. Once all media is added, the tube can be removed from the ice and kept at room temperature. 

Pellet the cells at 700g, for 5 mins at maximum acceleration and deceleration. 

 

8. Pour or aspirate the supernatant containing the DMSO and resuspend in 10mL of fresh 

growth medium. 

 

9. Transfer to a T75cm2 flask and incubate for 24 hours at 37°C, 5% C2O. 

 

SOP 001.4 Checking Cells 

 
Cells should be checked microscopically daily to ensure they are healthy and growing as expected. 

Attached cells should be mainly attached to the bottom of the flask, round and plump or elongated in 

shape and refracting light around their membrane. Suspension cells should look round and plump and 

refracting light around their membrane. Some suspension cells may clump. Media should be pinky 

orange in colour.  

 

Discard cells if:  

 

1. They are detaching in large numbers (attached lines) and/or look shrivelled and grainy/dark in 

colour.  

 

2. They are in quiesence (do not appear to be growing at all).  

 

SOP 001.5 Sub-Culturing 

 
Split ratios can be used to ensure cells should be ready for an experiment on a particular day, or just to 

keep the cell culture running for future use or as a backup. Suspension cell lines often have a 

recommended sub-culture seeding density. Always check the guidelines for the cell line in use. Some 

slow growing cells may not grow if a high split ratio is used. Some fast growing cells may require a 

high split ratio to make sure they do not overgrow. Note that most cells must not be split more than 

1:10 as the seeding density will be too low for the cells to survive.  

 

As a general guide, from a confluent flask of cells: 1:2 split should be 70-80% confluent and ready for 

an experiment in 1 to 2 days. 1:5 split should be 70-80% confluent and ready for an experiment in 2 to 

4 days. 1:10 split should be 70-80% confluent and ready for sub-culturing or plating in 4 to 6 days. If 

cells are less than 70-80% confluent but you wish to subculture them on (e.g. Friday before the 

weekend) then they should be split at a lower split ratio in order to seed the cells at a high enough 

density to survive e.g. use 1:2 or 1:5 split. 
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SOP 001.6 Splitting  

 
1. When the cells are approximately 80% confluent (80% of surface of flask covered by cell 

monolayer) they should still be in the log phase of growth and will require sub-culturing. (Do 

not let cells become over confluent as they will start to die off and may not be recoverable). 

 

2. To sub-culture, first warm the fresh culture medium at 37°C water bath or incubator for at 

least 30 minutes. Then carry out one of the appropriate following procedures:  

Sub-culturing attached cell lines requiring trypsin  

 

Note: not all cells will require trypsinization, and to some cells it can be toxic. It can also induce 

temporary internalization of some membrane proteins, which should be taken into consideration when 

planning experiments. Other methods such as gentle cell scraping, or using very mild detergent can 

often be used as a substitute in these circumstances.  

 

1. When ready, carefully pour off media from flask of the required cells into waste pot 

(containing approximately 100 ml 10% sodium hypochlorite (bleach)) taking care not to 

increase contamination risk with any drips.  

 

2. Using aseptic technique, pour/pipette enough sterile PBS into the flask (approx 10mL) to give 

cells a wash and get rid of any FBS in the residual culture media. Tip flask gently a few times 

to rinse the cells and carefully pour/pipette the PBS back out into waste pot. This may be 

repeated another one or two times if necessary (some cell lines take a long time to trypsinize 

and these will need more washes to get rid of any residual FBS to help trypsinization).  

 

3. Using pipette, add enough trypsin EDTA to cover the cells at the bottom of the flask.  

a. In 25 cm2 flask approx 1 ml,  

b. In 75 cm2 flask approx 5 ml,  

c. In 175 cm2 flask approx 10 ml.  

 

4. Roll flask gently to ensure trypsin contact with all cells. Place flask in 37°C incubator for 1-3 

minutes depending on the cell line. Different cell lines require different trypsinization times. 

To avoid over-trypsinization which can severely damage the cells, it is essential to check 

them every few minutes.  

 

5. As soon as cells have detached (the flask may require a few gentle taps) add some growth 

media to the flask that contains 10% FBS (the FBS in this will inactivate the trypsin). 

a. In 25 cm2 flask approx 3 ml,  

b. In 75 cm2 flask approx 7 ml,  

c. In 175 cm2 flask approx 15 ml.  

 

6. To achieve a single cell suspension, pipette all the cell suspension against the back wall of the 

flask to disrupt the cells ten times (working your way down the flask wall), and against the 

back corner ten times to separate any joined cells. 

7. Pellet the cells at 1200rpm (700g), for 5 mins at maximum acceleration and deceleration. 
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8. Pour or aspirate the supernatant containing the trypsin and resuspend in 10mL of fresh growth 

medium. 

 

9. Pipette required volume of cells into new flasks at required split ratio. These flasks should 

then be topped up with culture media to required volume.  

a. E.g. in 25 cm2 flask approx 5-10 ml  

b. In 75 cm2 flask approx 10-30 ml  

c. In 175 cm2 flask approx 15-50 ml.  

 

10. Make sure flasks are labelled with the cell line, passage number, split ratio, date, operator 

initials and the vial number of the cells. Place flask(s) straight into 37°C; CO2 incubator and 

leave cells overnight to recover and settle.  

Note: Changing media  
If cells have been growing well for a few days but are not yet confluent (e.g. if they have been split 

1:10) then they will require media changing to replenish nutrients and keep correct pH. If there are a 

lot of cells in suspension (attached cell lines) or the media is staring to go orange rather than pinky 

orange then media change them as soon as possible.  

 

1. To media change, warm up fresh culture media at 37°C in water bath or incubator for at least 

30 mins. Carefully pour of the media from the flask into a waste pot containing some 

disinfectant. Immediately replace the media with 10 ml of fresh pre-warmed culture media 

and return to CO2; 37°C incubator.  

Sub-culturing of suspension cell lines  
 

1. Check guidelines for the cell line for recommended split ratio or sub-culturing cell densities.  

 

2. Take out required amount of cell suspension from the flask using pipette and place into new 

flask.  

a. E.g. For 1:2 split from 10 ml of cell suspension take out 5 ml.  

b. For 1:5 split from 10 ml of cell suspension take out 2 ml.  

 

3. Add required amount of pre-warmed cell culture media to fresh flask.  

a. E.g. For 1:2 split from 10 ml add 5mls fresh media to 5 ml cell suspension.  

b. For 1:5 split from 10 ml add 8mls fresh media to 2 ml cell suspension. 

 

Tip: The passage number is the number of sub-cultures the cells have gone through. Passage number 

should be recorded and not get too high. This is to prevent use of cells undergoing genetic drift and 

other variations. 

 

SOP 001.7 Seeding Cells for Experiments 

 

1. Collect cells in a single cell suspension using one of the above protocols. 

 

2. Prepare the haemocytometer by sterilising with ethanol and wiping using Kim Wipes. Breathe 

on the cover slip and then place in the middle of the haemocytometer until the cover slip does 
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not move. The presence of Newton’s refraction rings under the coverslip indicates proper 

adhesion (Rainbows should appear where the cover slip contacts the haemocytometer). 

 

3. Withdraw 9.5µl of the cell suspension into the haemocytometer by placing the pipette at the 

interface of cover slip and the haemocytometer. 

Tip: Always remember to invert the tube just before collecting cells for the haemocytometer as cells 

will settle to the bottom. 

 

4. Using the microscope, count the cells within the four outer quadrants (4x4 grid) using a cell 

counter. Always include cells on the left and bottom line and exclude cells on the top and  

right lines. 

 

5. Take the average of the four quadrants and calculate the cell number according to the 

formula of the haemocytometer: 

(A + B + C + D)/ 4 = χ x 104 

 

6. Determine the number of cells needed for the experiment based on the seeding 

density. 

 

7. Using cross multiplication determine how much of the mixture is required and how 

much media is needed to create the stock solution. 

Cell Counting Example: 

1. 154 + 167 + 165 + 147 = 653 

653/4 = 163.25 

163.25 x 104 cells/ml = 1.63 x 106 cells/ml 

2. We have 1.63 x 106 cells/ml 

We need 0.5 x 105 cells/dish 

0.5 x 105 cells/dish x 10 dishes = 5 x 105 cells 

3. We need 2ml of stock per dish 

2ml/dish x 10 dishes = 20ml of stock 

0.5 x 106 : x ml 

1.63 x 106 : 1 ml 

x = (1 x 0.5 x 106)/(1.63 x 106) = 0.5/1.63 = 0.3067 ml = 307µl 

Stock Solution = 307µL of cell mixture + 19.693ml of media  
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SOP 001.8 Cryopreserving Cells 
 

1. Prepare cell density between 1x106 – 5x106 cells / mL in the appropriate freezing medium for 

the cell line and aliquot 1ml into pre-labelled cyrovials. 

 

2. Supplement with 10% dimethyl sulfoxide (DMSO) and immediately transfer into a 

frosty boy kept at room temperature. 
 

3. Transfer the frosty boy to -80°C freezer overnight and remove cryovials for long-term 

storage at −80 °C (−112 °F) or liquid nitrogen. 

 

Tip: DMSO may also be used as a cryoprotectant, added to cell media to reduce ice formation 

and thereby prevent cell death during the freezing process.  Approximately 10% may be used 

with a slow-freeze method, without it, up to 90% of frozen cells will become inactive. 

 

SOP 001.9 Aseptic Cleaning after Cell Culturing 

1. Make sure all lids are screwed on tightly before removing them from the hood. 

 

2. Dispose of any containers/tubes in the yellow bag biological material waste bin. 

 

3. Empty used pipette tips into the sharps container and when disposing of waste liquid, 

dilute with bleach and then pour down the sink with running water. 

 

4. Place pipettes and tube racks back in their relevant areas. 

 

5. Wipe down the hood with ethanol and make sure no excess supplies are left in the 

hood. 

 

6. Turn off the hood using the on/off switch. 

 

7. Replace the silver lip and make sure it is attached securely. 

 

8. Turn on UV lamp for at least 20 minutes. 

  

https://en.wikipedia.org/wiki/Liquid_nitrogen
https://en.wikipedia.org/wiki/Cryoprotectant
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SOP 002: H2AX Immunofluorescence Staining 
 

Description: Gamma-H2AX (H2AX) is a biomarker for DNA double strand breaks. Upon induction 

of DNA double strand breaks, the histone variant H2AX becomes phosphorylated on serine 139 on the 

highly conserved C-terminal SQEY motif to form H2AX. This specific phosphorylation event is then 

detectable by immunofluorescence staining. 

 

SOP 002.1 Cell Preparation (Time: 20 to 30 minutes) 

 

Procedure: 

 

1. Approximately 18 hours prior to staining wash cells with PBS, resuspend in fresh media and 

return to 37oC.  

 

2. Wash cells twice with PBS by centrifugation at approximately 150g rpm and resuspend in 

fresh media.  

 

3. Count cells and adjust cell density to approximately 0.5 million cells/ml of media. 

a. Cell count can be made either by automated method (e.g. Sysmex blood cells counter 

with filter size between 5 to 18 microns) or by using Trypan blue exclusion assay 

using cell counting chambers. 

 

Tip: When staining for different cell lines for γH2AX foci comparison care must be taken to ensure all 

the cell lines are growing at the same exponential phase of growth 

 

Tip: Excess number of cells (>800 cells per cm2) leads to lack of uniformity in staining. 

 

4. Dispense an aliquot of this cell suspension (2 to 3 ml per well) into cell culture plate (6 or 8- 

well plate) 
 

SOP 002.2 Staining  

 

Procedure: 

 

1. Assemble cytospin clips, filter cards and slides with appropriate labeling (When assembling 

cytospins make sure that the whole in filter card coincides with the funnel). 

 

2. Expose cells to either γ-radiation or X-rays (Time: dependent on dose of radiation and type of 

irradiator). 

 

Tips:  
i) In case of suspension cells it’s preferable to irradiate cells in cell culture dishes than in falcon tubes 

to ensure the uniformity in the radiation dose received by cells 

ii) To see the immediate effect of radiation on cellular events keep cells on ice for 5 to 10 minutes prior 

to and during irradiation.  

 

3. After irradiation incubate cells at 37oC for required time (For peak γH2AX level- 30 minutes 

to 1 hour) 
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4. Wash cells twice with cold PBS by centrifugation and resuspend in fresh PBS. 

 

5. Dispense 100 to 150 µL of this cell suspension into each cytospin funnel and spin at 500 rpm 

for 5 minutes.  

 

6. Separate slides from cytospins and allow cells to moderate air dry (Time <15 minutes) 

 

Tip: Do not let cells dry for longer time as it disintegrates cellular morphology and circles should be 

made around smear with a liquid blocking pen to ensure that cells will not dry due to liquid running off 

the slide when staining. 

 

7. Fix cells with 2 or 4% PFA at RT. 

 

Tip: Compared to ethanol/methanol a better fixation was observed with Para-formaldehyde (PFA). In 

case of suspension cells a fixation for 5 minutes at RT is optimal whereas in adherent cells longer 

fixation times (e.g. 15 to 20 minutes) are needed. Do not store the fixed slides at -20oC for further 

staining since it resulted in high back-ground fluorescence.  

 

8. Wash cells with PBS for 2x 5 minutes. 

 

9. Permeablise cells with Triton-X 100 at RT 

 

Tip: Compared to Tween-80 we observed a better signal in cells permeabilised with Triton-X 100. 

Depending on cell type it may be necessary to change the permeabilisation time. For example, in case 

of K562 cells permeabilisation for 5 minutes at RT is sufficient whereas in case of Keratinocytes a 15 

minute permeabilisation is required. 

 

10. Wash cells with PBS for 3x 5 minutes. 

 

11. Block cells in 1% BSA for 3X 10 minutes at RT. 

 

Tip: We compared blocking efficiency using serum (derived from same species the secondary 

antibodies are derived) and Bovine serum albumin in PBS. BSA was more efficient in minimizing non-

specific binding of secondary antibodies compared to anti-serum. When compared different blocking 

times (an overnight blocking at 4o Cs a 3x10 minute and 3x20 minute blocking at room temperature).  

An optimal blocking was obtained when cells are added 1% BSA for 3 times with 10 minutes incubation 

each time.  

 

12. Add approximately 50 µL of primary antibody (1: 500 diluted in 1% BSA) to each slide 

 

Tips:  

i) Compared to Rabbit polyclonal antibody a better staining was obtained with Mouse monoclonal 

antibody. 

ii) Pre-incubation of primary anti-body with 1% BSA at 4oC overnight yielded better staining compared 

to fresh diluted stock. 

iii) Incubation of primary antibody at RT for 90 minutes reduces back-ground staining compared to 

overnight incubation at 4oC (which might be the case if staining many cell lines simultaneously for foci 

at different time points).  

iv) Storing the diluted antibody at 4oC for more than 3 to 4 days reduced the activity 

v) To stain different markers simultaneously use antibodies raised in different species (e.g. Mouse anti-

γH2AX and rabbit anti-methyl H3K9).  

 

13. Incubate cells at RT for 90 minutes on a rocking platform at 250 rpm speed.  
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Tip: It’s recommended to incubate cells in a moist chamber as it will prevent cells and antibody from 

drying.  

 

14. Wash cells with PBS for 3x 5 minutes.  

 

15. Add approximately 50 µL of (1: 1000 diluted in 1% BSA) secondary antibody to each slide. 

 

16. Incubate cells at RT for 45 to 60 minutes on a rocking platform at 250 rpm speed.  

 

Tips:  
i) To stain different markers on same slide use secondary antibodies with different species specificity 

and florescence emission wave length (e.g. Anti-mouse Alexa 488 and anti-rabbit Alexa-546). 

ii) It’s recommended to incubate cells in a dark moist chamber to avoid fading and drying of secondary 

antibody. 

 

17. Wash slides with PBS for 3x 5 minutes. 

 

18. Add approximately 50µL of 1:500 diluted (in PBS) TOPRO-3 to each slide. 

 

19. Wash slides with PBS for 3x 5 minutes. 

 

20. Remove excess moisture form slides and add anti-fade solution. 

 

Tip: It’s recommended not to dry cells completely before adding anti-fade solution. 

 

21. Leave slides overnight in a dark moist chamber and following day place a coverslip and mount 

them with nail polish. 

 

Tip: It’s recommended to use confocal specific coverslips and a clear nail polish. While placing 

coverslip on slide care should be taken to avoid the formation of any air bubbles. 

 

SOP 002.3 Image Acquisition 

 

Procedure: 
 

i) Images acquired on confocal microscope reveal better spatial resolution and are optimal for 

illustration of molecular changes in a cell. 

 

ii) Since the size of γH2AX foci may be lower than 0.5 µM, it’s recommended to acquire images with 

at least 0.5 µM step size along Z-axis and 63X oil immersion objective lens are preferred compared to 

either higher or lower magnification.  

 

iii) For foci counting from many cells it’s preferable to use a scan speed of 8 and image size of 1024X 

1024 pixels. But to illustrate the spatial relationship between different proteins it’s recommended to use 

a scan speed of 6 with image size of 2048 X 2048 pixels. 

 

iv) When imaging for multiple channels a sequential line scan acquisition is recommended compared 

to frame scan to avoid specimen bleaching and if using 63X objective a zoom factor of 3 or 4 will 

produce a better resolution. 
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SOP 002.4 Quantification of Foci (Time < 1 hour per for 4 to 5 microscopic fields) 

Image analysis and foci counting can be done using various software packages (e.g. Metamorph, 

Image-J and Imaris etc.). Using Metamorph, foci can be counted from images acquired on various 

confocal (Zeiss LSM, Olympus, Nikon etc.) and fluorescence microscopes. The procedure for foci 

counting in Metamorph is described here. 

 

Procedure: 

 

1. Open γH2AX image stacks either directly from File menu or by using Build number stacks. 

 

2. Go to Process menu and chose Stack arithmetic.  

 

3. Chose Maximum projection and select the planes to be included and click OK.  

 

4. Save the resulting image as a γH2AX Tiff. file and open DAPI image.  

 

5. Go to regions and select a region drawing tool and draw regions around nuclei. 

 

6. Now click on γH2AX Tiff image and go to Process menu and select Morphological filters.  

 

7. Now chose Top-Hat and select γH2AX image as a source image.  

 

8. Apply Top-Hat filter and resulting image will be a binary image with less noise and reduced 

variation in foci intensity. 

 

Tip: Care should be taken when choosing Top-Hat values, optimal values can be obtained by visual 

comparison of images before and after applying filters. 

 

9.   Go to Process menu and select Threshold image.  

 

10. Choose inclusive threshold and select the lower and higher threshold values. 

 

Tip: It is usually the threshold values that effect foci number, therefore much attention is required 

when selecting threshold values. This can be best achieved by counting foci number using different 

threshold values in cells exposed to lower than 2 Gy γ-radiation and then compare foci number with 

naked eye counting. The optimal threshold value is the one that minimizes the inclusion of 

background and maximize the foci inclusion. 

 

11. Select DAPI image and go to Regions menu and select Transfer regions option.  

 

12. Select Source image as TOPRO-3 and destination as Top-Hat and click OK.  

 

13. Once the nuclear regions are transferred to Top-Hat go to Measure menu and select 

Integrated Morphometry Analysis.  

 

14. In pop-up window select Source image- Top-Hat and measure by Area.  

 

15. Select measure all regions except that touch edge of image and click on Measure to obtain 

foci number in all the corresponding nuclei in Top-Hat image. 

 

16. Now the foci numbers from each region can be exported into a MS-Excel file by using Log- 

Data option. 
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SOP 002.5 3D Reconstruction of Images (Time < 15 minutes per image) 

 

Procedure: 

 
3. To create 3D image from a stack in Metamorph go to Stack menu and choose 3D 

reconstruction. 

 

4. Select the angle of rotation (e.g. 160o, 320o).  

 

5. Select 3D reconstruction type- Maximum.  

 

6. Chose the plane of rotation (e.g. horizontal Vs vertical).  

 

7. Chose the Z-calibration distance. 

 

Tip: Its preferable to use the User specified Z-distance (optimal -0.5 µM). 

 

8. Chose OK to create a 3D reconstruction. 

 

SOP 002.6 Line Scan Analysis using Metamorph (Time < 15 minutes per image) 

 

Procedure: 

 
1. Open either a single plane image or stack file. 

 

2. Go to Measure Tool bars command and select Line scan analysis. 

 

3. Draw a line across the cell and this will automatically reveals the fluorescence intensity and 

distance of each marker along the path of line. 

 

Tip: To elucidate the spatial relationship of structures like γH2AX foci and histone methylation it is 

preferable to draw a line which spans the regions that are dense and poor in these structures 
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Materials  

A. Equipment 

Confocal microscope (Zeiss LSM 510 Meta Confocal) 

Gammacell 1000 Elite irradiatior (Nordion International Inc., Ontario Canada) 

Cytospin instrument (Shandon, Inc.)- For suspension cells 

CO2 incubator 

Filter Cards (Shandon, Inc.) 

Cytofunnels (Shandon, Inc.) 

Lab-Tek II chamber slides (Nalgene Nunc, IL, USA) 

Polysine slides (Menzel-Glaser, Germany) 

PAP pen (Abcam, UK, Cat. No. 2601) 

Micro Dissecting forceps 

Dark moist chamber 

Bench top rocker (Thermoline Scientific, Australia) 

Water bath 

Eppendorf tubes 

Falcon tubes (15 ml) 

Micropipettes 

Cell culture flasks (BD Biosciences, USA) 

Cell culture plates (BD Biosciences, USA) 

Class II laminar flow biological cabinet 

 

B. Reagents 

Bovine serum albumin (BSA) (Sigma-Aldrich); Cat. No. A7906 

Para-formaldehyde (PFA) (Sigma-Aldrich); Cat. No. 158127 

Triton-X 100 (Sigma-Aldrich); Cat. No. T8787 

Fetal bovine serum (JRH Biosciences, Melbourne, Australia) 

Gentamicin  

TOPRO3: (Invitrogen, USA); Cat. No. T3605 

ProLong-Gold anti-fade solution: (Invitrogen, USA); Cat. No. P36930 

Trypan blue (Sigma Aldrich); Cat.No. T6146 

 

C. Primary antibodies 

Mouse monoclonal anti-phospho hisotne- H2AX antibody (Millipore, USA); Cat. No. 16193 

Histone H3 (Mono-methyl K4) antibody (Abcam, Cambridge, UK); Cat. No. ab8895 

 

D. Secondary antibodies 

Alexa Fluor 488 goat anti- mouse IgG (H+L) (Invitrogen, USA); Cat. No. 11029 

Alexa Fluor 546 goat anti-rabbit IgG (H+L) (Invitrogen, USA); Cat. No. 11035 

 

E. Image analysis packages (One of) 

Metamorph (Molecular Devices, USA) 

Imaris (Bitplane Scinetific Solutions) 

Image-J (NIH, USA) 

other similar software packages  
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Preparation of reagents 
 

A. Triton X-100 

Dissolve 25 µL of Triton-X 100 in 25ml of PBS and mix thoroughly and this will be a 10X solution. 

Dilute 10X stock accordingly into PBS to obtain a working dilution of 0.1 or 0.5% of Triton-X 100. 

10X TSA can be stored either at RT or 4oC. 
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SOP 003: Analysis of H2AX Foci using FIJI (Image J) 
 

Description: This method is used to quantify H2AX foci in cells or tissue. 

 
1. Open the lsm./ nd2/TIF in FIJI is Just Image J.  

a. You will see a black and white image with a slide bar labelled ‘C’. A single image 

will correspond to every channel/fluorophore captured in order of the alignment on 

the microscope. For example on the Nikon AR1 microscope the fluorophore order is: 

DAPI > Alexa 488 > Alexa 568 > Alexa 647. 

b. The slide bar labelled ‘Z” refers to each slice taken in the Z – direction. 

 

2. Generate a maximum Z-projection of all channels. 

a. Go to Image > Stacks > Z-project 

b. In the projection menu select max intensity. The starting and stopping slice can be 

altered to exclude images that are out of focus. 

 

3. Split the image into its separate colours channels. 

a. Go to Image > Color > Split channels. 

 

4. To minimise background fluorescence and show staining restricted to within the nuclei, firstly 

convert each of the Z-projections to 8-bit by going to Image > Type > 8-bit. 

 

5. Adjust the threshold according to the nucleus 

a. Go to Image > adjust > Threshold 

b. Tick dark background and adjust the threshold so that the background is minimised 

and only the strong nuclear staining is evident. 

c. Click apply. 

 

6. Generate a binary image of this threshold blue channel. 

a. Go to Process > Math > Divide 

b. Divide by 255 to generate a binary image corresponding to a distribution of 0 and 1 

values. This image is the mask. 

 

7. Go to Process > Image Calculator and multiply the channel of interest by the blue nuclear 

channel. Ensure create new window is selected. The final product is an image that 

encompasses the staining of interest restricted specifically to within the nuclear regions. 

 

8. To count the number of foci in Z-projections, go to Process > Binary > Find Maxima.  

a. Tick light background and increase noise tolerance value to reduce non-specific 

staining.  

b. Tick preview point selection to check whether maxima detection coincide with 

discernible foci. 
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SOP 004: Mammalian Protein Extraction (MPER) 
 

Description: M-PER® Mammalian Protein Extraction Reagent extracts cytoplasmic and nuclear 

protein from cultured mammalian cells. M-PER® Reagent utilizes a proprietary detergent in 25 mM 

bicine buffer (pH 7.6) for mammalian cell lysis. 

 

SOP 004.1: MPER Extraction Protocol 
 

For adherent cell lines 

 
1. Carefully decant the growth medium for the cells. 

 

2. Briefly wash cells twice with PBS (-). 

 

3. Add 1mL of PBS (-) to the flask, plate or dish and scrape the cells using a rubber policeman. 

For suspension cell lines 
 

4. Pellet the cells by centrifugation at 1200rpm for 5 minutes at maximum acceleration and 

deceleration. 

 

5. Tap the cell pellet to break and resuspended in 1 mL of  ice cold PBS (-). 

 

6. Pellet the cells by centrifugation at 800rpm for 10 minutes. 

 

7. Remove supernatant and lyse the cells with MPER reagent 

a. For every 1 x 106 cells use 60µL MPER reagent (+ Pi). 

b. 40µL Pi to 1mL MPER reagent. 

 

8. Agitated for 10 minutes at 4°C (level 5 cold room or use rotator). 

 

9. Remove cell debris by centrifugation at 14,000g for 15 minutes at 4°C. 

 

10. Transfer supernatant containing the protein soluble fraction to fresh eppendorf (discard cell 

pellet/debris). 

 

11. Store at -80°C for long-term storage or continue to measure protein content by performing a 

Bradford Assay. 

Troubleshooting 

 

Problem Possible Cause Solution 

Low protein yield Protein expression is low Optimize the transfection procedure 

Insufficient amount of M-PER® 

Reagent was used 

Add more M-PER®  Reagent 

M-PER® Reagent was unable to 

penetrate the cell membrane 

Increase incubation time and shake 

more vigorously during incubation 

Unable to retrieve 

membrane protein 

M-PER® Reagent is for the 

extraction of nuclear and 

cytoplasmic protein 

Use MEM-PER®  Membrane Protein 

Extraction Reagent (Product No. 

23236) 
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SOP 004.2: MPER Extraction Protocol for 96-well plate following Seahorse assay 

 

Procedure: 

 
1. Wash cells twice with ice cold PBS (-) for 5 mins on ice on a rotating platform. 

 

2. Carefully aspirate supernatant and lyse the cells with 30µL MPER reagent/well. 

a. 40µL Pi to 1mL MPER reagent. 

 

3. Agitated for 10 minutes at 4°C (level 5 cold room or use rotator). 

 

4. Centrifuge the plate at 14,000g for 15 minutes at 4°C (level 1, level 2 plate centrifuge). 

 

5. Transfer supernatant to fresh 96-well plate (discard cell pellet/debris). 

 

6. Store at -80°C for long-term storage or continue to measure protein content by performing a 

Bradford Assay. 

Bradford Assay 

 

7. Transfer 10µL of protein to a fresh 96-well plate. 

 

8. Add 250µL Bradford Coomassie Reagent (stored in 4°C fridge, level 4). 

 

9. Incubate in foil at room temperature on a rotating platform for 10 mins. 

 

10. Measure absorbance at 595nm on a spectrophotometer (Level 2, Communal area). 

a. Select microplate manager 

b. Select > open –place plate with lid off in the plate holder 

c. Go to > File> new endpoint protocol. Select measurement filter to 595nm. Click > 

run. 

d. Go to > file > export to excel > save document on T: drive. 

 

11. Normalise raw Seahorse data to protein content. 
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SOP 005: Acid Extraction of Histone Proteins 
 

 

Description: Acid extraction of histones is carried out according to methods supplied by Upstate 

Biotechnology with some modifications. Approximately one medium flask of cells is routinely used 

in the acid extraction, however you might be able to get away with a small flask. 

 

Procedure: 

 

1. Cells are washed in 10ml of ice cold PBS (-) and pelleted at 800rpm for 10 minutes. 

 

2. Discard the supernatant and resuspend the pellet in 0.5ml PBS and transfer to an eppendorf 

tube. 

 

3. Pellet cells by centrifugation at 10,000rpm for 20 seconds and discard the supernatant. 

 

4. Very briefly, resuspend the pellet in 600μl of acid extraction lysis buffer containing 

Complete-mini protease inhibitor cocktail tablet (Roche Molecular Biochemistry) to initially 

pre-swell the cells and reduce the amount of PBS remaining in the eppendorf tube that can 

reduce the capacity to lyse the cells. 

a. Add 2μL of 1 M DTT per 4ml acid extraction buffer. 

 

5. Pellet the cells by centrifugation at 10,000rpm for 20 seconds and remove the supernatant 

from the tube. 

 

6. To lyse the cells, add 250μl (for a medium flask of cells, 100μl for a small flask) of acid 

extraction lysis buffer containing Complete-mini protease inhibitor cocktail tablets (Roche 

Molecular Biochemistry) to the tube and resuspend the cells by vortexing. 

 

7. Add 16.25μl of 5M Sulphuric acid (6.5μl per 100µl of lysis buffer added) to the sample and 

vortex quickly to disperse the acid. 

 

8. Leave the samples on ice for 1 hour, with intermittent vortexing every 15 minutes. 

 

9. Remove cell debris by centrifuging the samples at 13,000rpm at 4°C for 10 minutes. 

 

10. Transfer the supernatant fraction containing acid soluble proteins to a new eppendorf tube and 

discard the acid insoluble pellet. 

 

11. Precipitate acid soluble proteins with 9 volumes of acetone at -20°C for 1 hour, or overnight. 

(Preferably not overnight because the pellet will be to hard to resuspend) 

 

12. Centrifuge the samples at 13,000rpm for 10 minutes at 4°C to pellet the acid soluble proteins. 

 

13. Wash the proteins pellet in 70% ethanol, air dry, and dissolve in approximately 60µl water 

(less if using a small flask), while on dry ice for 1-2 hours, with intermittent pipetting to aid in 

resuspending the pellet. 

14. Undissolved pellet can be removed by brief centrifugation and the supernatant retained. 
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15. 5µg of protein is usually loaded for western analysis, but less has also been used with good 

results. 

 

Bradford M. (1976) Anal. Biochem 72, 248-254 

 

Acid extraction buffer 

Compound Concentration Concentration required Volume to add 

Water   95.67mls 

KCL 3M 10mM 333µl 

Hepes pH 7.9 1M 10mM 1ml 

MgCl2 50mM 1.5mM 3ml 

 **Add DTT at 0.5mM concentration, and protease inhibitors tablets immediately before use. 

100µl acid extraction lysis buffer dissolved in 50μl H2O. 

 

Others 

Compound Concentration Concentration Required Volume to add 

Sulphuric Acid 18M 5M 4.17ml 

Water   10.83ml 
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SOP 006: Western Blotting 
 

 

Description: Western Blotting is a widely used analytical technique used to detect specific proteins in 

a sample of tissue homogenate or extract. It uses gel electrophoresis to separate native proteins by 3D 

structure or denatured proteins by the length of the polypeptide. The proteins are then transferred to a 

membrane (typically nitrocellulose or PVDF), where they are stained with antibodies specific to the 

target protein 

 
 

SOP 006.1 Bradford Assay (Lowry Protein Assay)  

 

 

Procedure:  
 

1. Thaw pre-frozen protein samples on ice at all times. 

2. Use the Albumin standard (BSA) ampoules, 1mL [2mg/mL] (#23209, Thermo Scientific) of 

known protein concentration according to the table (-20°C freezer): 

Vial A B C D E F G H I 

µg/mL 2000 1500 1000 750 500 250 125 25 0 

 

3. Prepare diluted samples of unknown protein test samples. 

a. Make 1:5 dilution by using 4µL of sample to 16µL nuclease free dH2O 

b. Make 1:10 dilution by using 5µL of 1:5 dilution sample and 5µL nuclease free dH2O 

4. Pipette 10µL of diluted BSA standard in duplicate in a 96-well clear plate starting from I-A 

(0-2000µg/mL) 

5. Transfer 10µL of 1:5 dilution to appropriate well in singular. 

6. Transfer 5µL of 1:5 dilution to appropriate wells with 5µL nuclease free dH2O. 

7. Add 250µL Coomasie Blue Bradford reagent to all wells (4°C frigde). 

8. Cover in foil and incubate on a rotating platform for 10 minutes. 

TIPS:  

a) If samples are from a histone extraction method load 5µL of samples directly into the wells for 

protein detection. 

b) Samples that do not turn blue will have little protein due to insufficient cell numbers or poor 

protein separation method. 

 

9. Measure absorbance at 595nm on a spectrophotometer (Level 2, Communal area). 

a. Select microplate manager 

b. Select > open –place plate with lid off in the plate holder 

c. Go to > File> new endpoint protocol. Select measurement filter to 595nm. Click > 

run. 

d. Go to > file > export to excel > save document on T: drive. 

10. Prepare a standard curve and determine protein concentrations for test samples. 

11. Prepare protein sample to load 40µg-100µg/well in volume <20µL for 15-well gel or <40µL 

for 10 well gel. 
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SOP 006.2 Gel Electrophoresis 

 
Procedure:  

 
1. Heat samples on dry block heater at 70°C for 10min. This allows the protein to become more 

soluble. 

2. Set up the mini-chamber. If only running one gel, place a spacer into the second space. 

3. Remove comb and white strip from gels and place gel into the chamber with writing facing 

towards you. (Invitrogen – Novex mini cell). 

4. Clamp the gels into place. 

5. Pour 1x NuPAGE MOPS SDS or MES running buffer 2/3rds of the way always filling the 

centre chamber (See reagents A). 

6. Wash wells using the buffer and a syringe twice. 

7. Load 6µL of protein standard into the first well and load all other samples following. Try to 

do this quickly before the samples become viscous again. 

8. Place the chamber lid on correctly, attach red to red, black to black and connect correct 

colours to the powers supply. 

9. Set voltage to 150V for ~90-45mins and press start (running man). 

Tip: You’ll know the chamber is set up correctly if bubbles start forming form the base of the 

chamber. 

 

10. Stop the gel when the blue NuPAGE LDS buffer has reached the bottom of the gel. 

 

SOP 006.3 Gel to Membrane Transfer 

Materials 

 

 Transfer buffer tank 

 5 blotting pads for 2 gels or 6 blotting pads for 1 gel 

 Nitrocellulose membrane 

 Whatman paper- 2 sheets per gel 

 Acrylic plate 

 Gel cutter 

 Scraper 

 Roller 

 60mL Syringe 

Procedure: 

 

1. Label membrane with initial, date, sample, gel number. 

2. Pour NuPAGE transfer buffer into two rectangular trays (See reagents B). 

3. Start from the negative end of transfer chamber – soak 2 blotting pads in transfer paper and 

place down. 

4. Soak transfer paper stack. 

5. Add gel to the gel: 
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a. To remove the gel from the running tank cassette, over an acrylic plates use the gel 

cutter to break apart the cassette. 

b. Unlock hatch and take out the smaller side of the cassette. 

c. Turn the gel over and gently push through the running hole to push out the gel from 

the cassette. 

d. Keep the gel moist by pouring transfer buffer over with a large syringe. 

e. Use the spatula to cut away the fringe and thick bottom section. 

f. Lift the gel from the plate without touching the area where proteins are and flip 

upside down onto the filter paper. 

6. Soak transfer paper and place over the gel. 

7. Ensure there are no air bubbles on the membrane and use a roller to roll out any air pockets. 

8. Soak blotting pad and place over the transfer paper.  

9. Repeat steps 3-8 for a second gel. 

10. Place the transfer chamber into the mini cell tank and fill with transfer buffer to cover the 

blotting pads. 

11. Connect mini tank to a power supply and transfer overnight at 30V. 

SOP 006.4 Immunoblotting 

Procedure:  
 

1. Remove membrane from the transfer tank. 

2. Place in skim milk blocking buffer for 1 hour at RT or overnight at 4°C. This prevents non-

specific binding on antibodies (See reagents C). 

3. Discard skim milk and wash in PBST briefly (See reagents D). 

4. Add primary antibody – incubate according to antibody manufacturer. Prepare primary 

antibodies in primary incubation buffer (See reagents E). 

5. Remove antibody from membrane and DO NOT DISCARD – replace tube and recycle use. 

6. Wash membrane in PBST for 10 mins 3 times on a rotating platform at RT. 

7. Incubate in secondary antibody with lgG HRP for 1 hr at RT covered. 

8. Wash membrane in PBST for 10 mins 3 times on a rotating platform at RT. 

9. Cover the membrane in ECL (Enhanced ChemiLluminescent) made 1:1 with 

chemilluminescence buffer and reagent.  

a. Use approximately 0.5ml per membrane. 

10. Take the membrane over to the BioRad (Communal area on Level 1 and 3) for developing or 

level 5 dark room. 

SOP 006.5 Stripping Membrane for Immunoblotting Multiple Antibodies 

Procedure:  

 
1. 1x 5 min wash in PBST 

2. 2x 5 min was in sterilised milliQH2O (Ultra Pure H2O) 

3. 1x 5 min wash in 0.2M NaOH 

4. 1x 5min wash in sterilised milliQH2O (Ultra Pure H2O) 

5. 1x 5 min wash in PBST 

6. Place in skim milk blocking buffer for 1 hour at RT or overnight at 4°C. 
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Troubleshooting 

 

Electrophoresis Problem Possible Cause Suggested Solution 

Run taking longer time 

with recommended 

voltage.  

Running buffer too 

dilute.  

Make fresh running buffer and use a 1X 

dilution.  

Current too high and 

excessive heat generated 

with recommended 

voltage. 

Running buffer too 

concentrated.  

Make fresh running buffer and use a 1X 

dilution.  

Current too low or no 

current with 

recommended voltage.  

Incomplete circuit.  Remove the tape from the bottom of the gel 

cassette prior to electrophoresis; Make sure 

the buffer covers sample wells; check the 

wire connections on the buffer core.  

Streaking of proteins.  Sample overload. 

High salt 

concentration in 

sample.  

Load less amount of protein. Decrease the 

sample salt concentration by dialysis or gel 

filtration.  

Streaking of proteins.  Sample precipitates.  Increase the concentration of SDS in the 

sample. 

 

Streaking of proteins.  Contaminants such as 

lipids or DNA 

complexes in sample.  

Centrifuge or clarify the sample to remove 

particulate contaminants.  

Streaking of proteins.  Poorly poured gel.  Make sure the gel is poured evenly and all at 

once.  

Fuzzy bands.  Protein sample only 

partially denatured.  

Fully denature the protein.  

Fuzzy bands.  Protein sample only 

partially reduced.  

Make sure sufficient amount of DTT or ß-

mercaptoethanol is added.  

Fuzzy bands.  Gel run for too long.  Watch the front dye as an indicator for proper 

running time.  

Dumbbell shaped bands 

or “smiling” bands.  

Loading a large 

volume of sample 

causes incomplete 

stacking.  

Load appropriate volume of sample. If the 

sample is too dilute, concentrate it using 

ultrafiltration.  

Dumbbell shaped bands 

or “smiling” bands.  

Uneven electric field 

during run.  

Try to make sure the loading is symmetrical if 

the protein concentration is known.  

Dumbbell shaped bands 

or “smiling” bands.  

Uneven surface of 

the resolving gel.  

Try to make the resolving gel surface even 

while pouring the gel.  

Dumbbell shaped bands 

or “smiling” bands.  

Expired gels.  Use the gels before the specified expiration 

date.  
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Preparation of reagents 
 

A. NuPAGE® MOPS SDS Running Buffer  
[50 mM MOPS, 50 mMTris base, 0.1% SDS, 1 mM EDTA, pH 7.7] 

To make a 20x stock (2L) 

1. Dissolve the following reagents to 1.8L ultrapure water:  

MOPS 418.4 g  

TrisBase 242.4 g  

SDS 40 g  

EDTA 12.0 g  

2. Mix well and adjust the volume to 2L with ultrapure water. 

3. Store at +4°C. The buffer is stable for 6 months when stored at +4°C.  

To make a 1x stock (2L) 

Dissolve 100mL 20x NuPAGE MOPS SDS Running Buffer to 1.9L dH2O. 

B. NuPAGE® Transfer Buffer  

To make a 20x stock (2L) 

1. Dissolve the following reagents to 1.8L ultrapure water:  

Bicine: 163.2g 

Bis-Tris: 209.6g 

EDTA.2(di)Na: 12.0g 

2. Mix well and adjust the volume to 2L with ultrapure water. 

3. Store at +4°C. The buffer is stable for 6 months when stored at +4°C.  

To make a 1x stock (2L) 

Dissolve 100mL 20x NuPAGE Transfer Buffer to 1.5L dH2O and add 400mL methanol. 

C.  Blocking Buffer – 5% skim milk and PBST 

Dissolve 5g skim milk powder in 100mL PBST and stir for 10mins on magnetic stirrer. 

 

D. PBST (Phosphate Buffered Saline & 0.05% Tween 20) 
To make 2L, add 5mL of  20% Tween 20  slowly to 2L 1x PBS (-) 

 

E. Primary incubation buffer (3% BSA in PBST and 0.02% NaN3) 

To 50mL PBST, add 1.5g BSA and 50µL sodium azide. Mix on a suspension roller for 30 

mins at 4°C 
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Appendix A  
 

Gel Selection Guide 
Gel Min 

Resolution 

Max 

Resolution 

Sample 

Buffer 

Running 

Buffer 

Transfer 

Buffer 

NuPAGE 10% 

Bis-Tris (With 

MES)  

2.5 kDa  200 kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® MES 

SDS Running 

Buffer  

NuPAGE® 

Transfer 

Buffer  

NuPAGE 10% 

Bis-Tris (With 

MOPS)  

14kDa  220kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® 

MOPS SDS 

Running Buffer  

NuPAGE® 

Transfer 

Buffer  

NuPAGE 12% 

Bis-Tris (With 

MES)  

2kDa  200kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® MES 

SDS Running 

Buffer  

NuPAGE® 

Transfer 

Buffer  

NuPAGE 12% 

Bis-Tris (With 

MOPS)  

6kDa  200kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® 

MOPS SDS 

Running Buffer  

NuPAGE® 

Transfer 

Buffer  

NuPAGE 4-

12% Bis-Tris 

(With MES)  

2.5kDa  200kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® MES 

SDS Running 

Buffer  

NuPAGE® 

Transfer 

Buffer  

NuPAGE 4-

12% Bis-Tris 

(With MOPS)  

12kDa  220kDa  NuPAGE® 

LDS Sample 

Buffer  

NuPAGE® 

MOPS SDS 

Running Buffer  

NuPAGE® 

Transfer 

Buffer  

 
Appendix B  

 
Maximum Loading 

Well Num-

Thickness 

Max Loading 

Volume 

Max Protein Amount Max DNA Amount 

10-1.0 mm  25 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

10-1.5 mm  37 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

12-1.0 mm  20 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

15-1.0 mm  15 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

15-1.5 mm  25 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

17-1.0 mm  15 ul  0.5 ug/band with Coomassie  n/a  

5-1.0 mm  60 ul  2 ug/band with Coomassie  400 ng/band with EtBr  

9-1.0 mm  28 ul  0.5 ug/band with Coomassie  100 ng/band with EtBr  

 
Appendix C 

 
Running Conditions for Gel electrophoresis 

Gel Type Voltage for 

Electophoresis 

Expected Current  

(gel) 

Gel 

Runtime 

NuPAGE® Bis-Tris SDS-PAGE 

(Denaturing, non-reducing)  

200 Volts constant  100-125 mA (start), 

60-70 mA (end)  

35-50 

minutes  

NuPAGE® Bis-Tris SDS-PAGE 

(Denaturing, reducing)  

200 Volts constant  110-125 mA (start), 

70-80 mA (end)  

35-50 

minutes  
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Appendix D 
 
Transfer Conditions 

Gel Type Transfer Buffer Transfer 

Membrane 

Voltage 

for 

Transfer 

Expected 

Current 

(transfer) 

Transfer 

Time 

NuPAGE® Bis-

Tris SDS-PAGE 

(Denaturing, 

non-reducing)  

NuPAGE® Transfer 

Buffer with 10% 

methanol for transfer 

of one gel.  

Nitrocellulose 

or PVDF  

30 V 

constant  

Start: 170 

mA, End: 

110 mA  

1 hour  

NuPAGE® Bis-

Tris SDS-PAGE 

(Denaturing, 

reducing)  

NuPAGE® Transfer 

Buffer with 10% 

methanol for transfer 

of one gel., 

NuPAGE® 

Antioxidant for 

reduced samples.  

Nitrocellulose 

or PVDF  

30 V 

constant  

Start: 170 

mA, End: 

110 mA  

1 hour  

 

Appendix E 
 
Buffer Composition 

Buffer 1XComposition Storage 

NuPAGE® LDS 

Sample Buffer  

Glycerol_10%, Tris Base_141 mM, Tris HCl_106 mM, 

LDS_2%, EDTA_0.51 mM, SERVA® Blue G250_0.22 mM, 

Phenol Red_0.175 mM, pH 8.5  

+4°C  

NuPAGE® MES 

SDS Running Buffer 

MES pH 7.2_50 mM, Tris Base_50 mM, SDS_0.1%, EDTA_1 

mM, pH 7.3  

+4°C  

NuPAGE® MOPS 

SDS Running Buffer  

MOPS_50 mM, Tris Base_50 mM, SDS_0.1%, EDTA_1 mM, 

pH 7.7  

+4°C  

NuPAGE® Transfer 

Buffer  

Bicine_25 mM, Bis-tris (free base)_25 mM, EDTA_1.0 mM, 

Chlorobutanol_0.05 mM, pH 7.2  

+4°C  
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STANDARD OPERATING PROCEDURE 
 
 

Title:  Staining Gels with Coomassie Blue 

Document ID: 007 

Author: Katherine Ververis Date:  4 June 2013 

Effective date: 4 June 2013 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 4 June 2013 
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SOP 007: Staining Gels with Coomassie Blue 
 

 

Description: This method is used to stain protein samples after electrophoretic separation in a 

polyacrylamide gel. This detection of protein method can be used to measure protein sizes and weights. 

 

Solutions and Reagents: 

 

Coomassie stain – 1L (0.1% Coomassie R250, 10% acetic acid, 40% methanol) 

 

1g Coomassie R250 

100mL glacial acetic acid 

400mL methanol 

500mL ddH2O 

 

1. Add 100mL of glacial acetic acid to 500mL of ddH2O 

2. Add 400mL of methanol and mix 

3. Add 1g of Coomassie R250 dye and mix 

4. Filter to remove particulates 

5. Store at room temperature in a sealable container 

 

De-stain for Coomassie – 1L (20% methanol, 10% acetic acid) 

 

200mL methanol 

100mL glacial acetic acid 

700mL ddH2O 

 

1. Add 100mL of glacial acetic acid to 700mL of ddH2O 

2. Add 200mL of methanol and mix 

3. Store at room temperature in a sealable container 

 

Procedure: 

 

1. Remove SDS-PAGE gel from glass and rinse once in ddH2O in a suitable container with a lid. 

Try not to use a container much larger or much smaller than the gel and used freshly washed 

labware that has never been in contact with nonfat milk, BSA and other protein blocking 

agents to prevent contamination. 

 

2. Add enough Coomassie Stain to cover the gel by 1/2 inch (~ 1.5 cm). 

 

3. Microwave on high power for 40 seconds to 1 minute (until the Coomassie Stain boils). 

 

4. Incubate the gel in the Coomassie stain at least 1 hour. 

 

5. Pour off the Coomassie Stain. The Coomassie Stain can be recycled a couple of times by 

filtering it. 

 

6. Rinse twice in ddH2O or used De-stain solution to remove Coomassie Stain from the 

container.  

 

7. Add fresh De-stain solution to cover the gel by 3/4 inch (~ 2 cm). 

 

8. Tie Kimwipes in a simple knot and place 4 of them in the De-stain solution around the gel. 

Try to avoid laying the Kimwipes on the gel as this will cause an uneven de-staining. 
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9. Incubate the gel in the De-stain solution at least 1 hour on a rotating platform. 

10. Discard the stained Kimwipes and replace with fresh knotted Kimwipes. 

 

11. Incubate a second time for 10 minutes to overnight on a rocking table. Stop whenever the 

level of de-staining is sufficient for you.  

 

12. The used De-stain solution can be recycled a couple of times by storing it in a sealed 

container with sponges or Kimwipes to remove all traces of Coomassie Stain. 

 

13. Rinse the gel for 5 min with ddH2O three times 

 

14. Wrap the gel in plastic and acquire an image using the BioRad scanner (Level 3). Do not 

touch the gel without gloves. 

 

15. The gel can be stored in 1% acetic acid. 
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STANDARD OPERATING PROCEDURE 
 
 

Title:  Gel Doc Protocol 

Document ID: 008 

Author: Katherine Ververis Date:  4 June 2013 

Effective date: 4 June 2013 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 4 June 2013 
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SOP 008: Gel Doc Protocol 
 

 

Procedure: 

 

1. Login in using your baker account or login specified next to instrument. 

2. Open programme: Quantity One. 

3. File → Chemdoc XRS → Select chemihighsensitivity. 

4. Turn on → epi white light. 

5. Click live focus. 

6. Open draw and remove white panel if existing, place membranes on cleaned black glass.  

7. Centre membranes looking at the live focus on screen. 

8. Adjust arm above geldoc to chemihighsensitivity. 

9. Click → open under iris (adjust using up and down arrows). 

10. Using up and down arrows adjust zoom and focus- ensure the membrane is clearly visible. 

11. Tick → highlight saturated pixel. 

12. Click → freeze. 

13. Turn off → Epi white light (should see a black screen). 

14. Click → auto exposure → set time, numbers of images, interval. 

a. Total exposure time  300.00 (5 min) 

b. Starting exposure 10.00 (10 secs) 

c. No. of exposures 20 

15. Click → go! 

16. To stop prematurely click → freeze. 

17. Can tick automatic save button to save all images or save individual exposures using →File 

→ save as → select folder and file name. 

To adjust image without effecting quantification of bands: 

 

1. Click → Tools → Transform → adjust contrast → use toggle bar to set high and low densities 

→ save image. 

To take a white light image for the Molecular weight ladder: 

 

1. Click → select → EpiWhite. 

2. Click → manual exposure → select time → go. 

Western blot analysis using Quantity One 

 

1. Click > Volume rect. tool > circle band. 

2. Copy paste the same sized circle to all other bands. 

3. Click > Volume analysis report – select: density and max value. 

4. Plot density. 

5. Tabulate or graph results. 
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Title:  Immunofluorescence Staining of Cell Cultures 

Document ID: 009 

Author: Katherine Ververis Date:  26 February 2014 

Effective date: 26 February 2014 

Lab name: Epigenomic Medicine  

Version: 2  
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SOP 009: Immunofluorescence Staining of Cell Cultures 
 

Description: Immunofluorescence is a technique used for light microscopy with a fluorescence 

microscope and is used primarily on microbiological samples. This technique uses the specificity of 

antibodies to their antigen to target fluorescent dyes to specific biomolecule targets within a cell, and 

therefore allows visualisation of the distribution of the target molecule through the sample. 

 

 
Procedure: 

 

For adherence cells 
 

9. Aspirate the culture media and wash the cells 1x PBS (-) for 5 minutes.  

(Continue to step 5) 

 
For suspension cells 

 
1. Pre-clean slides with 70% ethanol and label accordingly: 

a. Cell line 

b. Treatment/ sample 

c. Secondary marker 

d. Initials/ Date 

 

2. Prepare cytospin holders by placing slide facing you in the casket first, Shandon filter card 

(smooth side up) second and cytospin funnel on top and lock in the casket. Fold over the filter 

card to expose sample label. Place them into the cytospin holders. 

 

3. Add 450µL of you cells sample into the funnel and cytospin cells at 500rpm, med 

acceleration for 5 minutes. 

 

4. Circle cell pellet with a Pap (wax) pen. 
 

 
DO NOT ALLOW CELLS TO DRY OUT AT ANY POINT THROUGHOUT 

 

 

5. Pipette 100µL of 4% paraformaldehyde (PFA)  for 10 minutes at RT. (See reagents A) 
a. PFA is used as a fixative following depolymerisation by heat to formaldehyde. 

 

6. Wash in 1x PBS (-) for 5 minutes on an orbital mixer at RT. (See reagent B) 
 

7. Add 100µL of 0.1% Triton X-100 for 10 minutes on an orbital mixer at RT. (See reagent C) 

a. Triton X-100 is a detergent used to permeabilize the cell membranes 

 

8. Wash 3 times in PBS (-) for 5 minutes on an orbital mixer at RT. 

 

9. Add 100µL 1% BSA for 20 minutes on a orbital mixer at RT. (See reagent D) 

a. Bovine serum albumin (BSA) is used as a blocking agent to prevent non-specific 

binding of antibodies. 

 

10. Blot off the BSA and add 100µL of primary antibody in 1% (w/v) BSA for 1 hour on an 

orbital mixer at RT, or overnight at 4°C on an orbital mixer. 
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a. Consult Epigenomic Medicine antibody inventory for optimised antibody dilutions or 

company product sheets for suggested dilution factors. 

 

11. Wash 3 times in PBS (-) for 5 minutes on a orbital mixer at RT. 

 

12. Add 100µL of secondary antibody in 1% (w/v) BSA (1:500 dilution) for 1 hr in a dark humid 

chamber on an orbital mixer at RT. (see appendix A) 

 
KEEP SLIDES IN A DARK HUMID CHAMBER THROUGOUT AND MINIMISE 

EXPOSURE TO LIGHT. 

 

13. Wash 3 times in PBS (-) for 5 minutes on a orbital shaker at RT. 

 

14. Add 100µL TOPRO-3 (1:1000 dilution) in PBS (-) for 10 minutes on an orbital mixer at RT 

 

15. Wash 2 times in PBS (-) for 5 minutes on an orbital mixer at RT. 

 

16. Blot of excess PBS using tissue and place a small drop of mounting medium (See appendix 

B) and coverslip. Remove air bubbles using a pipette tip and seal with 2 coats of nailpolish. 

 

17. Store at 4°C overnight before imaging. 

 

RT = room temperature 
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Preparation of reagents 
 

A. Paraformaldehyde 

To make 4% (w/v) stocks 

Weigh out 4g of PFA (Sigma, P6148, stored at 4°C cold room on level 4) in a fume hood and 

add 100mL dH2O. Dissolve in a shaking water bath overnight at 60°C or until all crystal have 

dissolved. In a fume hood aliquot stock into 2mL eppendorfs and store in -20°C freezer (level 

4, lab 3) for up to 2 years. Do not re-freeze after thawing. 

 

B. 1x PBS 

Dilute 1:10 (v/v) from 10x PBS stock. E.g. To make 2 L add 200mL of 10x stock to 1.8L 

dH2O. Working solution is stable at RT for 2 years. 

 

C. Triton X-100 

To make a 10% stock 

Dilute 1:10 (v/v) Triton X-100 (Sigma, T9284, 4°C fridge, level 4 lab 3). E.g. Add 10mL 

Triton X-100 to 90mL dH2O. 

To make a 0.1% working solution 

Dilute 1:100 (v/v) of 10% stock Triton X-100.  E.g. Add 1mL 10% Triton X-100 to 99mL 1x 

PBS (-). Working solution is stable at RT for 2 years. 

D. BSA 

To make a 10% stock 

Weigh out 5g of Albumin, from bovine serum (BSA) (Sigma-Aldrich, A7906, 4°C fridge, 

level 4 lab 3) and add 45mL dH2O in a 50mL falcon tube. Very slowly invert tube to start 

dissolving crystals. DO NOT shake quickly of bubble the solution. Once all crystals are no 

longer dry, dissolve on a rotating roller at 4°C for 30 minutes or until fully dissolved. Aliquot 

stocks into 2mL eppendorfs and store in -20°C freezer (level 4, lab 3) for up to 2 years. Do 

not re-freeze after thawing. 

To make a 1% working solution 

Dilute 1:10 (v/v) of 10% stock BSA.  E.g. Add 2mL aliquot of 10% BSA to 18mL 1x PBS (-). 

Working solution is stable at 4°C for 1 week. 
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Appendix A  
 
Secondary antibodies/fluorophores for immunofluoresence staining 
 

Catalogue Species 
raised in 

Species of 
detection 

Alexa Fluor® 
Dye 

Standard detecting 
colour 

A11001 goat mouse 488 green 

A11008 goat rabbit 488 green 
A11010 goat rabbit 546 orange 

A11012 goat rabbit 594 red 
A11031 goat mouse 568 red-orange 

A11032 goat mouse 594 red 

A11055 donkey goat 488 green 
A21082 donkey goat 633 far-red 

 
Appendix B 
 
Mounting mediums 

Name Base 
constituent 

Stored Type RI Compatible 
microscope 

EpiMed Antifade Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

DPX Plastic Fume 
hood, LG 
Morp lab 

Hard ~1.51 Best for FSX-
100/ light 
microscope 

Permount Oil Fume 
hood, L4 
lab 3 

Semi-
hard 
resin 

~1.53 Best for confocal 
imaging 

Pro-Long Gold 
Antifade 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Pro-Long Gold 
Antifade with 
DAPI 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Vectashield Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

Vectashield with 
propidium 
iodide 

Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 
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SOP 010: Immunofluorescence Staining of OCT Sections 
 

Description: Immunofluorescence is a technique used for light microscopy with a fluorescence 

microscope and is used primarily on microbiological samples. This technique uses the specificity of 

antibodies to their antigen to target fluorescent dyes to specific biomolecule targets within a cell, and 

therefore allows visualisation of the distribution of the target molecule through the sample. 

 
Procedure: 
 

1. Cut cyrosections 5µm (<10µm) to superfrost slides and air dry for 1 hour at RT or store at -

80°C.  

a. Cut embryo hearts at 10µm 

2. Circle tissue sections with a Pap (wax) pen. 
 

3. Fix tissues sections with 100µL of  2% paraformaldehyde in PBS for 20 minutes at RT. (See 

reagents A) 
a. PFA is used as a fixative following depolymerisation by heat to formaldehyde. 

 

4. Equilibrate the slides by washes in PBS (-) for 15 minutes on an orbital mixer at RT. (See 

reagents B) 
 

5. Permeabilize the tissue with -20°C 70% ethanol for 20 minutes. 

a. Freeze 70% ethanol the night before in -20°C. 

 

6. Wash 3 times in PBS (-) for 10 minutes on an orbital mixer at RT. 

 

Tip: At this point slides may be stored in sealed containers at 4°C for up to 2 weeks. 

 

7. Block the tissue with 50µL of 8% BSA in PBS-TT for 1 hour on an orbital mixer at RT or 

overnight at 4°C.  (See reagent C) 

 

8. Blot off the blocking buffer and add 100µL of primary antibody in 1% (w/v) BSA (See 

reagent D) and incubate overnight at 4°C in a humid chamber. 

a. Consult Epigenomic Medicine antibody inventory for optimised antibody dilutions or 

company product sheets for suggested dilution factors. 

 

9. Wash 3 times in PBS-TT for 10 minutes on an orbital mixer at RT. 

 

10. Add 100µL of secondary antibody in 1% (w/v) BSA (1:500 dilution) for 1 hr in a dark humid 

chamber on an orbital mixer at RT. (see appendix A) 

 
KEEP SLIDES IN A DARK HUMID CHAMBER THROUGOUT AND MINIMISE 

EXPOSURE TO LIGHT. 

 

11. Wash 3 times in PBS-TT for 10 minutes on an orbital shaker at RT. 

 

12. Incubate with 0.5mg/mL RNAse A for 30 minutes at 37°C. 

a. This prevents non-specific staining of the cytoplasm.  

b. If the protein of interest is in the cytoplasm skip to step 14. 

 

13. Wash 2 times in PBS-TT (-) for 5 minutes on an orbital shaker at RT. 

 

14. Add 100µL TOPRO-3 (1:1000 dilution) in PBS (-) for 10 minutes on an orbital mixer at RT 
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15. Wash 2 times in PBS-TT (-) for 10 minutes on an orbital mixer at RT. 

 

16. Blot of excess PBS using tissue and place a small drop of mounting medium (See appendix 

B) and coverslip. Remove air bubbles using a pipette tip and seal with 2 coats of nailpolish. 

 

17. Store at 4°C overnight before imaging. 

 

Preparation of reagents 

 

A. Paraformaldehyde 

To make 4% (w/v) stocks 

Weigh out 4g of PFA (Sigma, P6148, stored at 4°C cold room on level 4) in a fume hood and 

add 100mL dH2O. Dissolve in a shaking water bath overnight at 60°C or until all crystal have 

dissolved. In a fume hood aliquot stock into 2mL eppendorfs and store in -20°C freezer (level 

4, lab 3) for up to 2 years. Do not re-freeze after thawing. 

To make 2% (v/v) working solution 

Dilute 1:1 (v/v) from 4% stock using PBS (-). E.g. To make 4mL add 2mL of 4% stock to 

2mL PBS (-). Working solution must be made on the day and thrown away after use. 

 

B. 1x PBS 

Dilute 1:10 (v/v) from 10x PBS stock. E.g. To make 2 L add 200mL of 10x stock to 1.8L 

dH2O. Working solution is stable at RT for 2 years. 

 

C. 8%BSA in PBS-TT 

To make PBS-TT (0.5% Tween 20 and 0.1% Triton X-100 in 1x PBS) 

To make 1L, add 5mL of Tween 20 and 1mL of Triton X-100 to 994mL of 1x PBS. 

To make 8%BSA in  PBS-TT  
To make 50mL, weigh out 4g of Albumin, from bovine serum (BSA) and fill with PBS-TT to 

50mL in a falcon tube. Store at 4°C for 1 week. 

 

D. BSA 

To make a 10% stock 

Weigh out 5g of Albumin, from bovine serum (BSA) (Sigma-Aldrich, A7906, 4°C fridge, 

level 4 lab 3) and add 45mL dH2O in a 50mL falcon tube. Very slowly invert tube to start 

dissolving crystals. DO NOT shake quickly of bubble the solution. Once all crystals are no 

longer dry, dissolve on a rotating roller at 4°C for 30 minutes or until fully dissolved. Aliquot 

stocks into 2mL eppendorfs and store in -20°C freezer (level 4, lab 3) for up to 2 years. Do 

not re-freeze after thawing. 

To make a 1% working solution 

Dilute 1:10 (v/v) of 10% stock BSA.  E.g. Add 2mL aliquot of 10% BSA to 18mL 1x PBS (-). 

Working solution is stable at 4°C for 1 week. 
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Appendix A  
 
Secondary antibodies/fluorophores for immunofluoresence staining 
 

Catalogue Species 
raised in 

Species of 
detection 

Alexa Fluor® 
Dye 

Standard detecting 
colour 

A11001 goat mouse 488 green 

A11008 goat rabbit 488 green 
A11010 goat rabbit 546 orange 

A11012 goat rabbit 594 red 
A11031 goat mouse 568 red-orange 

A11032 goat mouse 594 red 

A11055 donkey goat 488 green 
A21082 donkey goat 633 far-red 

 
Appendix B 
 
Mounting mediums 

Name Base 
constituent 

Stored Type RI Compatible 
microscope 

EpiMed Antifade Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

DPX Plastic Fume 
hood, LG 
Morp lab 

Hard ~1.51 Best for FSX-
100/ light 
microscope 

Permount Oil Fume 
hood, L4 
lab 3 

Semi-
hard 
resin 

~1.53 Best for confocal 
imaging 

Pro-Long Gold 
Antifade 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Pro-Long Gold 
Antifade with 
DAPI 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Vectashield Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

Vectashield with 
propidium 
iodide 

Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 
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Appendix C 
 
 

 
 

Paraffin-embedded 
Tissue 

Frozen Tissue 

Fixation Pre-embedding Post-sectioning 

Sectioning Microtome Cryostat 
Storage Multiple years at room 

temperature 
1 year at -80 °C 

Advantages Preserves tissue 
morphology 

Preserves enzyme & antigen function 

Limitations Overfixation can mask 
the epitope 

Formation of ice crystals may negatively 
affect tissue structure 
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Title:  Immunofluorescence Staining of  Paraffin Sections 

Document ID: 011 

Author: Katherine Ververis Date:  26 February 2014 

Effective date: 26 February 2014 

Lab name: Epigenomic Medicine  

Version: 2  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 1 October 2009 

2 26 February 2014 (KV) 

 
  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 56 

 

SOP 011: Immunofluorescence Staining of Paraffin Sections 
 

Description: Immunofluorescence is a technique used for light microscopy with a fluorescence 

microscope and is used primarily on microbiological samples. This technique uses the specificity of 

antibodies to their antigen to target fluorescent dyes to specific biomolecule targets within a cell, and 

therefore allows visualisation of the distribution of the target molecule through the sample. 

 

 

Procedure: 

 
1. Cut microtome section between 3- 5µm (<10µm) to superfrost slides and incubate overnight 

in a dry conditions at 37°C. 

 

2. Deparaffinize by two consecutive washes in clean xylene for 10 mins and rehydrate in three 

consecutive washes in graded ethanol – 100%, 90%, 70% for 5 mins each. 

 

DO NOT ALLOW CELLS TO DRY OUT AT ANY POINT THROUGHOUT 

 

3. Dilute Antigen retrieval buffer solution 10x to 1x with PBS (-) and fill coplin jars. 

 

4. Microwave on High for 1.0 min (Press ‘TIME’ and use number pad to enter ‘1’, then press 

‘POWER’ and use the number pad to enter ‘9’). 

 

5. Microwave on Low for 10.0 min (Press ‘TIME’ and use number pad to enter ‘10’, then press 

‘POWER’ and use the number pad to enter ‘5’).  
 

Tip: When you have more slides than can fit into one coplin jar, microwave each jar 

separately for one minute, then place them all into the microwave for the second 

heating, and cooling period.  Ensures temperature stability when trying to heat more 

than one, at a time, on the high setting. 
 

6. Let cool to room temperature for 20 min before removing from the microwave or use the 

freezer mittens to remove. 

a. You can top up the coplin jar with PBS id the antifade has evaporated off, ensure the 

slides are submerged in solution. 

 

7. Equilibrate slides with two washes in 0.1% Tween 20 in PBS for 15 minutes on a orbital 

mixer at RT. (See reagents A) 

 

8. Circle the tissue using a wax (PAP) pen. 

 

9. Block slides 100µL of 1% BSA (v/v) for 1 hour and RT or overnight at 4°C.  (See reagents B) 

 

10. Blot off the blocking buffer and add 100µL of primary antibody in 1% (w/v) BSA and 

incubate overnight at 4°C in a humid chamber. 

a. Consult Epigenomic Medicine antibody inventory for optimised antibody dilutions or 

company product sheets for suggested dilution factors 

 

11. Wash 3 times in 0.1% Tween 20 in PBS for 10 minutes at RT on an orbital mixer. 

 

12. Add 100µL of secondary antibody in 1% (w/v) BSA (1:500 dilution) for 1 hr in a dark humid 

chamber on an orbital mixer at RT (see appendix A). 
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KEEP SLIDES IN A DARK HUMID CHAMBER THROUGOUT AND MINIMISE 

EXPOSURE TO LIGHT. 

 

13. Wash 3 times in 0.1% Tween 20 in PBS for 10 minutes at RT on an orbital mixer. 

 

14. Add 100µL TOPRO-3 (1:1000 dilution) in PBS (-) for 10 minutes on an orbital mixer at RT 

 

15. Wash 2 times in 0.1% Tween 20 in PBS for 5 minutes on an orbital mixer at RT. 

 

16. Blot of excess PBS using tissue and place a small drop of mounting medium (See appendix 

B) and coverslip. Remove air bubbles using a pipette tip and seal with 2 coats of nailpolish. 

 

17. Store at 4°C overnight before imaging. 

 

 

 
Preparation of reagents 
 

A. 0 .1% Tween 20 in PBS 

To make 2 L add 2mL of 100x stock Tween 20 to 2L 1x PBS. Working solution is stable at 

RT for 2 years. 

1x PBS 

Dilute 1:10 (v/v) from 10x PBS stock. E.g. To make 2 L add 200mL of 10x stock to 1.8L 

dH2O. Working solution is stable at RT for 2 years. 

 

B. BSA 

To make a 10% stock 

Weigh out 5g of Albumin, from bovine serum (BSA) (Sigma-Aldrich, A7906, 4°C fridge, 

level 4 lab 3) and add 45mL dH2O in a 50mL falcon tube. Very slowly invert tube to start 

dissolving crystals. DO NOT shake quickly of bubble the solution. Once all crystals are no 

longer dry, dissolve on a rotating roller at 4°C for 30 minutes or until fully dissolved. Aliquot 

stocks into 2mL eppendorfs and store in -20°C freezer (level 4, lab 3) for up to 2 years. Do 

not re-freeze after thawing. 

To make a 1% working solution 

Dilute 1:10 (v/v) of 10% stock BSA.  E.g. Add 2mL aliquot of 10% BSA to 18mL 1x PBS (-). 

Working solution is stable at 4°C for 1 week. 
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Appendix A  
 
Secondary antibodies/fluorophores for immunofluoresence staining 
 

Catalogue Species 
raised in 

Species of 
detection 

Alexa Fluor® 
Dye 

Standard detecting 
colour 

A11001 goat mouse 488 green 

A11008 goat rabbit 488 green 

A11010 goat rabbit 546 orange 
A11012 goat rabbit 594 red 

A11031 goat mouse 568 red-orange 

A11032 goat mouse 594 red 

A11055 donkey goat 488 green 

A21082 donkey goat 633 far-red 

 
Appendix B 
 
Mounting mediums 

Name Base 
constituent 

Stored Type RI Compatible 
microscope 

EpiMed Antifade Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

DPX Plastic Fume hood, 
LG Morp lab 

Hard ~1.51 Best for FSX-100/ 
light microscope 

Permount Oil Fume hood, 
L4 lab 3 

Semi-
hard 
resin 

~1.53 Best for confocal 
imaging 

Pro-Long Gold 
Antifade 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Pro-Long Gold 
Antifade with 
DAPI 

Glycerol -20°C 
freezer 
L 4, lab 3 

Wet ~1.47 All 

Vectashield Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

Vectashield with 
propidium iodide 

Glycerol 4°C fridge 
L 4, lab 3 

Wet ~1.47 All 

 
Appendix C 
 

 
 

Paraffin-embedded 
Tissue 

Frozen Tissue 

Fixation Pre-embedding Post-sectioning 

Sectioning Microtome Cryostat 
Storage Multiple years at room 

temperature 
1 year at -80 °C 

Advantages Preserves tissue 
morphology 

Preserves enzyme & antigen function 

Limitations Overfixation can mask 
the epitope 

Formation of ice crystals may negatively 
affect tissue structure 
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SOP 012: De-stain of Immunofluorescence Slides 
 

Description: This method is used to remove any existing antibodies or fluorescent tags on the slides 

when obtaining new tissue sections is not available. 

 

Procedure: 

 

1. Carefully remove the coverslip by wiping any existing nail polish with ethanol to remove he 

seal then with the slide immersed in PBS (-) carefully peel back the coverslip from the tissue 

section. 

a. Be carefully to not remove any tissue in the process. 

 

2. Treat with aqueous 0.025% potassium permanganate (dissolved in distilled water) for 1 

minute. 

 

3. Rinse in tap water – 3 dips. 

 

4. Immerse in 5% aqueous sodium thiosulphate until the section appears bleached (Or 1% oxalic 

acid can be used instead of thiosulphate) – overnight. 

 

5. Wash in water for 5 minutes then re-stain. Remember to keep slide sections hydrated at all 

times. 
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Version: 1  
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SOP 013: Analysing for Fluorescence Dyes in Two-Dimensional 
Maximum Z-Projections 

 
 

Description: This method requires the software FIJI is Just ImageJ available for free download for 

Windows, Mac OS or Linux in 64-bit or 32-bit. Download the latest version here: http://fiji.sc/Fiji 

 

 

Procedure: 

 
1. Open the lsm./ nd2/TIF in FIJI is Just Image J.  

a. You will see a black and white image with a slide bar labelled ‘C’. A single image 

will correspond to every channel/fluorophore captured in order of the alignment on 

the microscope. For example on the Nikon AR1 microscope the fluorophore order is: 

DAPI > Alexa 488 > Alexa 568 > Alexa 647. 

b. The slide bar labelled ‘Z” refers to each slice taken in the Z – direction. 

 

2. Generate a maximum Z-projection of all channels. 

a. Go to Image > Stacks > Z-project 

b. In the projection menu select max intensity. The starting and stopping slice can be 

altered to exclude images that are out of focus. 

 

3. To colour the image slices with the corresponding colour go to: Image > Color > Make 

Composite. 

a. Select Color in the dropdown bar. 

b. Tick Chanel 1 > select more>> and choose the appropriate colour (i.e blue). 

c. Repeat for all channels imaged 

Note: this step is not essential as the fluorescence can be imaged in black and white. 

 

4. Split the image into its separate colour channels. 

a. Go to Image > Color > Split channels. 

 

5. To minimise background fluorescence and show staining restricted to within the nuclei, firstly 

convert each of the Z-projections to 8-bit by going to Image > Type > 8-bit. 

 

6. To analyse the protein of interest within the nucleus only. Adjust the threshold according to 

the nuclei by going to: 

a. Go to Image > adjust > Threshold 

b. Tick dark background and adjust the threshold using the horizontal toggle so that the 

background is minimised and only the strong nuclear staining is evident. 

c. Click apply. 

 

7. Generate a binary image of this threshold blue channel. 

a. Go to Process > Math > Divide 

b. Divide by 255 to generate a binary image corresponding to a distribution of 0 and 1 

values. This image is the mask. 

 

http://fiji.sc/Fiji
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8. Go to Process > Image Calculator and multiply the channel of interest (stain of interest e.g 

the protein Nrf2) by the blue nuclear channel. Ensure create new window is selected. The 

final product is an image that encompasses the staining of interest restricted specifically to 

within the nuclear regions. 

 

9. To measure mean fluorescence in the nucleus only 

a. Go to Image > adjust > Threshold 

b. Adjust threshold to 1- this selects only the nuclear region. 

c. Go to Set measurements > tick 1. Mean gray value and 2. Limit to threshold and 3. 

Display label. 

d. Go to Analyse > Measure and the results will be given in a new results window.  

 

10. To measure mean fluorescence in the cytoplasm only 

a. Repeat steps 5-7 for the cytoplasm (green) channel 

b. To make a mask of the cytoplasm without the nuclear staining subtract the nuclear 

mask from the cytoplasm mask 

i. Go to > Image Calculator and subtract the blue mask from the green mask. 

ii. Go to >  Image Calculator and multiply the channel of interest by the new 

mask 

c. Adjust threshold on the new red channel to 1- this selects only the cytoplasm region. 

d. Go to Set measurements > tick 1. Mean gray value and 2. Limit to threshold. 

e. Go to Analyse > Measure and the results will be given in a new results window.  

Note: This is only possible is a cytoplasm stained has been used. 

 

11. To measure the average protein expression in the whole cell  

a. Select the protein of interest channel (red) and adjust the threshold according to the 

whole cell by going to Image > adjust > Threshold. 

b. Tick dark background and adjust the threshold using the horizontal toggle bar so that 

the background is minimised and only the strong staining is evident.  

c.  Measure the fluorescence intensity by going to Analyse > Measure. 

d. The data can be recorded in excel spreadsheets.  

 

12. The mean can be calculated by taking the average of 100 cells from multiple frames. A 

minimum if 100 cells should be analysed and recorded.  

a.  Data obtained from the colour controls should be subtracted from the results. 

b.  Go to Set measurements > tick 1. Mean gray value and 2. Limit to threshold. 

c. Go to Analyse > Measure and the results will be given in a new results window.  
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SOP 014: Antifade Mounting Medium 

 

Description: Glycerol based mounting medium with a RI: 1.47  

 

 

Preparation: 

 

1. In a 50mL centrifuge tube add: 

a. 5mL of 0.2M Tris (pH 8.5) 

b. 43 mL glycerol (non autofluorescence)  

c. 2.5g n-propyl gallate  

 

2. Wrap tube completely in foil to protect from light. 

 

3. Mix on stirrer until dissolved (overnight). 

 

4. Store at 4°C or aliquot and store at -80°C for longer term storage. 

Procedure:  

 

1. Do final wash in pH 8 (to pH 8.5) buffer. 

 

2. Drain buffer from slide. 

 

3. Add enough antifade to cover specimen. 

 

4. Let sit 5 minutes, drain off antifade. 

 

5. Mount with fresh antifade.  
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SOP 015: Citrate Buffer Antigen Retrieval 

 

Description: Formalin or other aldehyde fixation forms protein cross-links that mask the antigenic sites 

in tissue specimens, thereby giving weak or false negative staining for immunohistochemical detection 

of certain proteins. The citrate based solution is designed to break the protein cross-links, therefore 

unmask the antigens and epitopes in formalin-fixed and paraffin embedded tissue sections, thus 

enhancing staining intensity of antibodies. 

 

 

Solutions and Reagents: 

 

Sodium Citrate Buffer  

(10mM Sodium Citrate, 0.05% Tween 20, pH 6.0) 

Tri-sodium citrate (dihydrate) --------- 2.94 g 

Distilled water --------------------------- 1000 ml 

Mix to dissolve. Adjust pH to 6.0 with 1N HCl and then add 0.5 ml of Tween 20 and mix well. Store 

this solution at room temperature for 3 months or at 4°C for longer storage. 

 

Tip: This buffer is commonly used and works perfectly with many antibodies. It gives very nice 

intense staining with very low background. 

 

Citrate Buffer  

(10mM Citric Acid, 0.05% Tween 20, pH 6.0) 

Citric acid (anhydrous) --------------- 1.92 g 

Distilled water -------------------------- 1000 ml 

Mix to dissolve. Adjust pH to 6.0 with 1N NaOH and then add 0.5 ml of Tween 20 and mix well. 

Store this solution at room temperature for 3 months or at 4°C for longer storage. 

 

Procedure:  

1. Hydrate slides in two changes of 100% ethanol for 3 minutes each, 95% and 80% ethanol for 1 

minute each. Then rinse in distilled water. 

 

2. Pre-heat steamer or water bath with staining dish containing Sodium Citrate Buffer or Citrate 

Buffer until temperature reaches 95-100 °C.  

 

Tip: Microwave or pressure cooker can be used as alternative heating source to replace steamer or 

water bath. 

 

3. Immerse slides in the staining dish. Place the lid loosely on the staining dish and incubate for 

20-40 minutes (optimal incubation time should be determined by user). 

 

4. Turn off steamer or water bath and remove the staining dish to room temperature and allow the 

slides to cool for 20 minutes. 

 

5. Rinse sections in PBS Tween 20 for 2x2 min. 

 

6.  Block sections for 30 minutes. 
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7. Perform avidin/biotin blocking if necessary.  

 

8. Incubate sections with primary antibody at appropriate dilution in primary antibody dilution 

buffer for 1 hour at room temperature or overnight at 4°C. 

 

9. Rinse sections with PBS Tween 20 for 2x2 min. 

 

10. Block sections with peroxidase blocking solution for 10 minutes. 

 

11. Rinse with PBS Tween 20 for 3x2 min. 

 

12. Proceed to standard immunohistochemistry protocol. 
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SOP 016: Cell Cycle Analysis using Flow Cytometry (FACS) 
 

Description: Fluorescence-activated cell sorting (FACS) is utilized to sort cells into the stages of the 

cell cycle using the relative levels of DNA by detection of the DNA dye Propidium Iodide (PI). The 

fluorescence intensity of the stained cells at certain wavelengths will therefore correlate with the amount 

of DNA they contain. As the DNA content of cells duplicates during the S phase of the cell cycle, the 

relative amount of cells in the G0 phase and G1 phase (before S phase), in the S phase, and in the G2 

phase and M phase (after S phase) can be determined, as the fluorescence of cells in the G2/M phase 

will be twice as high as that of cells in the G0/G1 phase. 

 

 

SOP 016.1: Preparation of Cells for FACS 

 

 
Procedure: 

 
1. After test samples have been treated for the required time frames, collect cells as a single cell 

suspension in a 15mL centrifuge tube. 

 

2. Pellet the cells by centrifugation at 1200rpm for 5 mins and discard the supernantent. 

3. Wash cells twice with PBS (w/o Ca2+/Mg+)/containing 2% FBS (approx 5-10mL). 

 

4. Tap pellets to resuspend well. 

  

5. Add 1 mL ice-cold PBS (w/o Ca2+/Mg+)/containing 2% FBS - keep cells on ice. 

 

6. Add 3 mL 100% Ethanol and immediately vortex for 30sec. 

a. IMPORTANT: Keep cells vortexing vigorously during this step to avoid 

clumps. 

 

7. Parafilm samples and rotate overnight 4°C (Level 4 cold room). 

 

8. Remove paraffin and pellet the cells by centrifugation at 1200rpm for 5 mins. 

a. You will see a flocculent pellet (White and cloudy) - this is good. 

 

9. Discard supernatant and wash with 5mL PBS (w/o Ca2+/Mg+) and pellet the cells by 

centrifugation. This time the pellet should appear normal. 

 

10. Add 1 ml 100µg/ml propidium iodide (straight from concentrated stock in PBS) and 

10µL RnaseA (from 2 mg/ml stock) or 20µL (from 1 mg/ml stock). 

 

11. Parafilm and foil the samples and rotate overnight in 4°C cold room. 

 

12. Transfer samples to 5 ml labelled FACS tubes. These can be stored at -20°C for long-

term storage until analysis. 

 

13. On the day for running FACS: thaw the samples and keep them on ice. 

a. Samples may need to be vortex to resuspend if a pink cloudy cell sample 

appears. 
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18. Analyse for PI staining: 

a. Create a histogram plot - Counts vs. PI 

 

19. For cleanest result - The gating should be forward scatter vs side scatter (take the 

healthy population); PI-A vs PI-W (take the linear population). 

 

 

SOP 016.2: FACS analysis using Flowing Software v.2. 

 

 

Procedure: 

 
1. Create tools 

a. Create – visualisation – pick tool 

b. Click shift for multiple selections 

c. Select the box to load data into or click next/previous 

d. Right click tools for different pop-up menus. 

e. Right click axes to change parameters. 

f. Tool properties – change font, size, and show file name. 

 

2. Regions 

a. Right click – create new region – click to mark 

 

3. Connection 

a. Make connection to link files (master - servant) 

b. Only update master to see changes in the servant. 

c. Right click to see statistics. 

 

4. Collection 

a. Create statistics – crate stats list 

b. Collection tools – Image collector – ctrl N – collect and save image. 
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SOP 017: Blood Fractionation from Whole Blood 
 

Description: Differences in cell density are exploited to separate granulocytes and erythrocytes from 

mononuclear cells. Granulocytes and erythrocytes have a higher density at the osmotic pressure of 

Ficoll-paque™ PLUS, and they sediment through the Ficoll layer during centrifugation. Ficoll-paque™ 

PLUS also enhances erythrocyte aggregation to increase erythrocyte sedimentation through the Ficoll 

layer. Mononuclear cells, with lower densities, remain at the plasma-Ficoll interface. 

 

Procedure: 

 

1. Collect 9-10ml blood in purple capped EDTA tubes. 

2. Bring all reagents to room temperature. 

3. Centrifuge EDTA tubes at 3000rpm for 15 mins at 20°C. 

4. Carefully remove the tubes- the sample should have a clear WBC Buffy layer with RBC 

below and plasma above. 

 

PERFORM ALL THE FOLLOWING STEPS IN A STERILE FUME HOOD 

 

5. Using a 1mL pipette tip, transfer the plasma to a fresh 15mL tube without disturbing the 

opaque WBC layer (leave 2mm of plasma above the WBC/RBC layer). Store at -80°C. 

 

Proceed with separation of RBC/WBC. 

6. Dilute blood 1:1 with PBS(-) + 2% FBS (sterile) in a 50ml centrifuge tube. 

7. Mix Ficoll-Paque™ PLUS (Ficoll) thoroughly before use by inverting the bottle several 

times. 

8. Add Ficoll to tube (see Table 1). 

9. Layer blood on top of Ficoll being careful to minimize mixing of blood with Ficoll. 

10. Centrifuge at room temperature (15 - 25°C) for 30 minutes at 400 x g with brake off. 

11. Remove and retain mononuclear cell layer at the plasma-Ficoll interface without disturbing 

erythrocyte/granulocyte pellet and place in 15mL centrifuge tube. 

12. Add 10ml PBS + 2% FBS and centrifuged at 100g for 10mins and normal acceleration and 

deceleration. 

13. Discard supernant, tap pellet and repeat wash. 

14. Resuspend in RPMI + 10% FBS and perform cell count. 

15. Proceed with cell plating for experiment or cryopreserve in FBS with 10% DMSO and store 

in liquid nitrogen. 

 

Table 1. Ficoll-Paque™ PLUS indicated amounts. 

Whole Blood (mL) PBS+2% FBS (Ml) Density Medium (mL) Tube size (mL) 

1 1 1.5 5 

2 2 3 14 

3 3 3 14 

4 4 4 14 

5 5 15 50 

10 10 15 50 

15 15 15 50 
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SOP 018: Isolation of White Blood Cells (PBMCs) from Buffy Coat 

Obtained from ARCB 
 

Description: Differences in cell density are exploited to separate granulocytes and erythrocytes from 

mononuclear cells. Granulocytes and erythrocytes have a higher density at the osmotic pressure of 

Ficoll-paque™ PLUS, and they sediment through the Ficoll layer during centrifugation. Ficoll-paque™ 

PLUS also enhances erythrocyte aggregation to increase erythrocyte sedimentation through the Ficoll 

layer. Mononuclear cells, with lower densities, remain at the plasma-Ficoll interface. 

 

Procedure:  

 

PERFORM ALL THE FOLLOWING STEPS IN A STERILE FUME HOOD 

 

1. Bring all reagents to room temperature. 

2. Collect blood bags from ARCB and cut tubing at the top. Be careful to not spill blood and 

clean any spills with 10% sodium hypochlorite (bleach) solution. Use guaze to aid in this 

process. 

Tip: Do not wipe up blood spills with 70% (w/v) ethanol as it is a fixative. 

 

3. Dilute blood 1:1 with PBS(-) + 2% FBS (sterile) in a 50ml centrifuge tube. 

4. Mix Ficoll-Paque™ PLUS (Ficoll) thoroughly before use by inverting the bottle several 

times. 

5. Add Ficoll to tube (see Table 1). 

6. Layer blood on top of Ficoll being careful to minimize mixing of blood with Ficoll. 

7. Centrifuge at room temperature (15 - 25°C) for 30 minutes at 400 x g with brake off. 

8. Remove and retain mononuclear cell layer at the plasma-Ficoll interface without disturbing 

erythrocyte/granulocyte pellet and place in 15mL centrifuge tube. 

9. Add 10ml PBS + 2% FBS and centrifuged at 100g for 10mins and normal acceleration and 

deceleration. 

10. Discard supernant, tap pellet and repeat wash. 

11. Resuspend in RPMI + 10% FBS and perform cell count. 

12. Proceed with cell plating for experiment or cryopreserve in FBS with 10% DMSO, freeze in a 

frosty boy and store in -80°C freezer. Transfer to liquid nitrogen for permanent storage after 

24 hours. 

 

Table 1. Ficoll-Paque™ PLUS indicated amounts. 

Whole Blood (mL) PBS+2% FBS (Ml) Density Medium (mL) Tube size (mL) 

1 1 1.5 5 

2 2 3 14 

3 3 3 14 

4 4 4 14 

5 5 15 50 

10 10 15 50 

15 15 15 50 

 

  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 76 

 

 
 
 
 
 
 
 

STANDARD OPERATING PROCEDURE 
 
 

Title:  Cell Viability and Apoptosis Assays 

Document ID: 019 

Author: Katherine Ververis Date:  5 December 2012 

Effective date: 5 December 2012 

Lab name: Epigenomic Medicine  

Version: 2  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 5 December 2012 

  

 

  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 77 

 

SOP 019: Cell Viability and Apoptosis Assays 
 

Description: Cell viability and apoptosis assay can be used to test the toxicity profile of test compounds 

or cancer therapies. The assays listed in this method include: 

1. CellTiter-Blue® Cell Viability Assay (G8080; Promega, Madison, USA) 

2. Apo-ONE® Homogeneous Caspase-3/7 Assay (G7790; Promega, Madison, USA) 

3. Cell death detection by crystal violet staining. 

Detailed protocols can be found on the manufacturer’s websites. 

 
 

SOP 019.1 CellTiter-Blue® Cell Viability Assay 

 

Procedure:  

 

1. Seed cells between 15 x 103 – 50 x 103 cells/mL in 96-well, flat bottom black or opaque 

sterile culture plates. 

 

2. Perform cell treatments of test compounds for the appropriate incubation periods. 

Tip: Use a multichannel pipette to plate the cells or for drug treatments to reduce pipetting error. 

 

3. At the end of your incubation period, adjust growth medium to 100µL of appropriate growth 

medium per well. Remember to plate at least three wells with growth medium only for 

background controls. 

 

4. Pipette 20µL of CellTiter-Blue® per well incubate for 4 hours at 37°C, 5% CO2.  

a. Can incubate CellTiter-Blue for up to 16 hours according to manufacturers protocols, 

however 4 hours has displayed the optimal incubation time. 

 

5. Measure the fluorescence intensity on  the Perkin Elmer Victor3 (Perkin Elmer, MA, USA) 

multi-label plate reader (Level 3, communal area) 

a. Select CellTiter-Blue protocol -550 nm excitation; 615 nm emission. 

 

SOP 019.2 Apo-ONE® Homogeneous Caspase-3/7 Assay 

 

Procedure:  

 

1. Seed cells between 15 x 103 – 50 x 103 cells/mL in 96-well, flat bottom black or opaque 

sterile culture plates. 

 

2. Perform cell treatments of test compounds for the appropriate incubation periods. 

Tip: Use a multichannel pipette to plate the cells or for drug treatments to reduce pipetting error. 
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3. At the end of your incubation period, adjust growth medium to 50µL of appropriate growth 

medium per well. Remember to plate at least three wells with growth medium only for 

background controls. 

 

4. Add 10µL of Apo-ONE® substrate to the 1mL of Apo-ONE® buffer and slowly mix. 

a. Try not to create bubbles to deactivate the reagent. 

 

5. Pipette 50µL of Apo-ONE® reagent per well incubate for 1-3 hours at RT covered in foil on a 

rotating platform.  

a. Two hour incubation time is optimal. 

 

6. Measure the fluorescence intensity on  the Perkin Elmer Victor3 (Perkin Elmer, MA, USA) 

multi-label plate reader (Level 3, communal area) 

a. Select CellTiter-Blue protocol -485 nm excitation; 525 nm emission. 

 

SOP 019.3 Cell Death Detection using Crystal Violet Staining 

 

 

Procedure:  

 

1. Seed cells between 1 x 105 – 2 x 105 cells/mL in 96-well, flat bottom, clear, sterile culture 

plates. 

 

2. Perform cell treatments of test compounds for the appropriate incubation periods. 

Tip: Use a multichannel pipette to plate the cells or for drug treatments to reduce pipetting error. 

 

3. At the end of your incubation period, adjust growth medium to 200µL of appropriate growth 

medium per well. Remember to plate at least three wells with growth medium only for 

background controls. 

 

4. Add 50µL of 0.05% (w/v) crystal violet in 20% methanol per well and incubation on a 

rotating platform for 30 minutes. 

a. Final concentration of 0.01% crystal violet & 4% methanol per well. 

 

5. Carefully wash excess crystal violet with dH2O and allow plate to dry. 

a. Dry plates in fume hood. 

b. Can store indefinitely at this point in a dark dry environment. 

 

6. Add 100 µL lysis buffer (50% ethanol, 0.1 M sodium acetate buffer) for 15 minutes on a 

rotating platform. 

 

7. Measure absorbance at 560nm on a spectrophotometer or fluorescence reader. 
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SOP 020: Scratch Migration Assay 
 

Description: The scratch migration assay is an in vitro wound healing method to test the proliferation 

or migration of keratinocytes, endothelial cells or fibroblasts in wound healing projects. 

 

 

Procedure:  

 

1. Seed cells between 0.5 x 106 – 1 x 106 cells per well in 6-well sterile culture plates and allow 

to attach overnight. 

 

2. Perform cell treatments of test compounds for the appropriate incubation periods. 

a. To mimic elevated glucose in diabetes patients – treat cells with 30mM glucose for 3 

days and a following day in fresh media after treating with test compounds. 

b. To mimic radiation dermatitis - treat cells with 2 Gy (137Ci) and incubate for a further 

24 hours after treating with the test compounds. 

c. To mimic chemotherapy toxicity – treat cells with 1µM doxorubicin for 1 hour, wash 

cells twice and incubate in fresh media for a further 24 hours after treating with the 

test compounds. 

3. Scratch the cell monolayer using a p1000 (blue) pipette tip in one straight line. 

a. Do not lift the pipette tip or re-scratch as the data will be distorted. 

 

4. Remove the cell debris by washing the plates three times using PBS (without Ca2+ and Mg2+). 

 

5. Replace the growth media (2-3ml) and incubate at 37°C, 5% (v/v) CO2. 

 

6. Mark the scratch zone on the back surface of the plate with a straight line and image the scratch 

zone on the line using a light microscope at time intervals between 0 - 200 hours.  

 

7. Cell migration is determined by measuring the gap distance between the two most inner cells 

from the scratch zone using Fiji, Image J (version 1.4). 
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SOP 021: Angiogenesis Assay using the µ-slide Angiogenesis ibi-

treat Chamber 
 

Description: A µ-Slide used to investigate angiogenesis in tube formation assays. Also perfect for 3D 

cell culture and immunofluorescence staining. Available for purchase cat. no. 81506, Ibidi, Madison, 

WI, USA. Detailed protocols can be found on the manufacturers website: http://ibidi.com/  

 

 

Procedure:  

 

Making agarose stocks 

 

1. Make a 1.6% stock of agarose in sterile PBS (-). 

a. To make 250mL stock, dissolve 4g of agarose (Promega; V3121) in 250mL PBS (-). 

 

2. Heat the agarose in 30-15sec intervals until agarose starts to boil. 

 

3. Cool down to room temperature and aliquot  into 5mL aliquots in a 15mL centrifuge tube. 

 

4. Long- term storage at 4°C until use. 

 

Making agarose-medium gel 

 

1. Dissolve an aliquot of 1.6% agarose by heating in a microwave for two intervals of 5 seconds. 

 

2. Prepare 5mL of sterile growth medium supplemented with 10% FBS. 

a. For EBM-2 media containing 2% FBS, add 8% FBS in 5 mL - 400µL of FBS to 

4.6mL EBM-2 media to give EBM-2 media + 10% FBS (v/v). 

 

3. Mix media and agarose to 1:1 ratio to give a final mixture of 0.8% agarose solution to 0.5x 

medium with 5% FBS while agarose is still warm. 

a. Agarose-medium mixture must be used on the same day and not stored. 

Gelation 

 

4. Apply 10µL of the gel to each inner well, holding the pipet tip upright in the middle of the 

well to prevent the gel from flowing into the upper well. Avoid any air bubbles. 

 

5. Allow the gel to set in to the wells under the lamina flow for approximetely 5 minutes. 

 

6. Incubate the slide in a humidity chamber in the incubator while cell preparations are made. 

Seeding cells 

 

7. For a final cell number of 10,000 cells per well, adjust a cell suspension of 2 x 106 cells/well. 

 

http://ibidi.com/
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8. Aliquot 50µL of cell suspension to each upper well. Keep the pipet tip upright and take care 

not to touch the gel with the pipet tip. 

 

9. Close the slide with the lid and observe cells under the microscope. 

 

10. Incubate the slide in a humidity chamber in the incubator and allow the cells to attach 

overnight. 

 

11. Aspirate media and replace media containing test compounds for the appropriate time period. 

 

12. Begin imaging cells at recorded time intervals and collect data of tube formation. 
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SOP 022: Clonogenic Assay 

 

Description: The clonogenic (or colony forming) assay has been established for more than 50 years; 

the original paper describing the technique was published in 1956. Apart from documenting the method, 

the initial landmark study generated the first radiation-dose response curve for X-ray irradiated 

mammalian (HeLa) cells in culture. Basically, the clonogenic assay enables an assessment of the 

differences in reproductive viability (capacity of cells to produce progeny; i.e. a single cell to form a 

colony of 50 or more cells) between control untreated cells and cells that have undergone various 

treatments such as exposure to ionising radiation, various chemical compounds (e.g. cytotoxic agents) 

or in other cases genetic manipulation. The assay has become the most widely accepted technique in 

radiation biology and has been widely used for evaluating the radiation sensitivity of different cell lines. 

Further, the clonogenic assay is commonly used for monitoring the efficacy of radiation modifying 

compounds and for determining the effects of cytotoxic agents and other anti-cancer therapeutics on 

colony forming ability, in different cell lines. A typical clonogenic survival experiment using adherent 

cells lines involves three distinct components, 1) treatment of the cell monolayer in tissue culture flasks, 

2) preparation of single cell suspensions and plating an appropriate number of cells in petri dishes and 

3) fixing and staining colonies following a relevant incubation period, which could range from 1-3 

weeks, depending on the cell line. 

 
 

SOP 022.1: Cell Culture and Experimental Set-up 
 

Procedure:  

 

1. Human keratinocytes are maintained as monolayers in 75 cm2 tissue culture flasks containing 

15 mL of keratinocyte-SFM (K-SFM) medium (GIBCO, serum-free medium) supplemented 

with L-glutamine (2 mM), epidermal growth factor (5 ng/ mL), bovine pituitary extract (40 μg/ 

mL) and 20 mg/ mL gentamicin. Cells are grown in a humidified 5% CO2 environment at 37°C. 

 

2. Cells are seeded into 12 x 25 cm2 tissue culture flasks containing 5 mL of K-SFM medium. 

 

3. Single cell suspensions are prepared by trypsinization. Cells are washed with phosphate 

buffered saline and incubated with a 0.05% trypsin / EDTA solution for 5-10 minutes.  

 

4. When the cells start to become rounded and ~30% are detached, 3 volumes of Dulbecco's 

modified eagle medium containing 10% fetal bovine serum is added to neutralize the trypsin.  

 

5. The cells are detached by pipetting up and down (20 times).  

 

6. Cells are counted using a hemocytometer. Appropriate cell numbers are seeded according to 

the doubling time of the cell line (approximately 20 hours for human FEP-1811 keratinocytes).  

a. The aim is to achieve ~90% confluency (~106 cells per flask) on the day of the 

experiment.  

b. An experiment consisting of 12 flasks is optimal for a single clonogenic assay (six un-

irradiated control and six irradiated flasks) which can be completed in approximately 

four hours. 
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SOP 022.2: Treatment and Irradiation 
 

Procedure:  

 

1. Treat cells for an appropriate time with a relevant radiation-modifying compound and expose 

cells to ionising radiation either γ-radiation or X-rays. 

a. Typically six flasks serve as plating efficiency (untreated) and drug only controls. 

The other six flasks are irradiated. 

 

2. Cells are irradiated with 4 Gy using a 137Cs source (Gammacell 1000 Elite irradiator; 

Nordion International, ON, Canada; 1.6 Gy/min). 

 

SOP 022.3: Plating 
 

Procedure:  

 

1. Following treatment, single cell suspensions are obtained as described earlier. 

 

2. The number of cells in each sample are counted carefully using a hemocytometer and diluted 

such that appropriate cell numbers are seeded into petri dishes (five replicates of each in 15 

mm dishes). 

a. The plating efficiency and / or surviving fraction should be anticipated when deciding 

the number of cells to seed per plate. The aim is to achieve a range of between 20 - 

150 colonies. 

 

3. Petri dishes are arranged in a humidified plastic cloning box and incubated in a 5% CO2 

environment at 37°C for colony formation. 

 

4. The incubation time for colony formation varies from 1-3 weeks for different cell lines; it is 

accepted that the time must be equivalent to at least six cell divisions. In this example, the 

control dishes for human keratinocytes require eight days to form sufficiently large clones 

consisting of 50 or more cells. 

 

SOP 022.4: Fixing and Staining Colonies 

 

 
Procedure:  

 

1. Gently remove the media from each of the plates by aspiration. 

 

2.  Wash each plate with 5 mL 0.9% saline. 

 

3. Fix the colonies with 5 mL 10% neutral buffered formalin solution for 15-30 minutes. 

 

4. Stain with 5 mL 0.01% (w/v) crystal violet in dH2O for 30-60 minutes. 

 

5. Wash excess crystal violet with dH2O and allow dishes to dry. 
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SOP 022.5: Colony Counting 
 

Procedure:  

 

Stereomicroscope 

 

1. Colonies containing more than 50 individual cells are counted using a stereomicroscope. 

Digital imaging and counting using imaging software 

 

2. Digital images of the colonies are obtained using a camera or scanning device 

 

3. Colonies are counted using imaging analysis software packages as described below. 

Cell counting using ImageJ (Fiji Version 1.44a) 

 

1. Open the image file in Fiji, go to File -> Open. 

 

2. If required convert the image to 8-bit format, go to Image -> Adjust...-> Threshold. 

 

3. Adjust threshold to reduce levels of non-specific background so that only the colonies are 

detected. 

 

4. Count colonies using the following: go to Process -> Binary -> Find maxima. 

 

5. For this image format, noise tolerance can be set to 0. Ensure that light background option is 

ticked and preview the detected maxima to check that all cell colonies have been correctly 

registered. 
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SOP 023: Mitochondrial Stress Test using Seahorse 

 

Description: Functional mitochondrial measurements are key to understanding cellular activation, 

proliferation, differentiation and dysfunction. The Seahorse XF Cell Mito Stress Test Kit provides a 

complete mitochondrial profile, and reveals critical information not evident in basal metabolism 

measurements alone. The key parameters of mitochondrial function that can be determined include: 

Basal Respiration, ATP Production, Proton Leak, Maximal Respiration, Spare Respiratory Capacity 

(Appendix A). Detailed manufacturer’s protocols can be found here:  

http://www.seahorsebio.com/resources/pdfs/XF_Cell_Mito_Stress_Test_Kit_Flyer_Web.pdf 

http://www.seahorsebio.com/support/software/PDF/XF_Cell_Mito_Stress_Test_Kit_User_Guide.pdf 

 

SOP 023.1 Mitochondrial Stress Test using the Seahorse Bioscience System  

 

Procedure:  

 

1. Seed cells at the required seeding density in 100µL of growth medium in the 96-well culture 

treated plate and allow to attach overnight. 

 

2. Treat with 20µL of test compounds at 5x concentrated stock and incubate for the required 

period. 

a. Total volume should be 100µL as 20µL would have evaporated overnight. 

 

Day before the assay: 

 

3. Hydrate the cartridge plate (green plate) with 200µL XF calibrate fluid to all wells and 

incubate in the non- CO2 incubator (level 2 communal area). 

 

4. Prepare 100mL of Seahorse assay DMEM media – with 1mM pyruvate and the same 

concentration of D-glucose found in the growth medium. 

a. For RPMI – 11.1Mm D-glucose 

b. For DMEM, MCBD and -MEM -  5.5Mm D-glucose 

i. 1mL of 100mM pyruvate in 100mL seahorse media 

ii. Prepared 5mL of  1M glucose (900.8mg) 

iii. Measure Ph to 7.4 when warm (37°C) 

iv. Sterile filter (0.22µm) 

On the day of the assay: 

 

5. Warm assay medium in non-CO2 incubator. 

 

6. Prepare injectable compounds using assay medium pH to 7.4 at 37°C. 

 

7. Load injectable compounds into ports of cartridge 

A. Oligomyocin (8x, 12.8µL[2.5mM stock] in 4mL media)  

B. FCCP (9x, 14.4µL [2.5mM stock] in 4mL media)  

C. Antimyocin (10x, 16µL [2.5mM stock] in 4mL media)  

D. Rotenone (11x, 17.6µL [2.5mM stock] in 4mL media)  

http://www.seahorsebio.com/resources/pdfs/XF_Cell_Mito_Stress_Test_Kit_Flyer_Web.pdf
http://www.seahorsebio.com/support/software/PDF/XF_Cell_Mito_Stress_Test_Kit_User_Guide.pdf
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8. Incubate injectable compounds at 37°C, non-CO2 incubator, for 15 minutes. 

 

9. If using suspension cells - centrifuge (level 1, level 2) at 1000x g for 15 mins, at 5 acc and 1 

dec. 

 

10. Adjust volume to 175µL by removing 80µL and add 165µL Seahorse XF DMEM medium 

using a multi-channel pipette. Total volume in the plate will be 275µL following 4x 25µL 

injectables. 

 

11. Incubate for 30-60 min in non-CO2 incubator. 

 

12. Begin seahorse assay by ‘mito stress test’ protocol to calibrate cartridge plate. 

 

13. Log in to program: XF wave 

a. Username: admin 

b. Password: sh 

 

14. Sample: Mito C stress test. 

 

15. Add groups 

c. Select Mito C stress test 

d. Select seahorse media 

e. Name sample  

f. Highlight sample wells 

 

16. Sample protocol > ok 

 

17. Review and run > enter name, date and save. 

 

18. Click test ready, should take approx 2-3 hours. 

 

19. Discard utility plate and cartridge plate after run and keep cell plate to measure protein. 

a. Can store the plate at -20°C until ready to run Bradford assay. 

 

SOP 023.2: MPER Extraction Protocol for 96-well Plate Following Seahorse Assay 
 

 

Procedure:  

 
1. Wash cells twice with ice cold PBS (-) for 5 mins on ice on a rotating platform. 

 

2. Carefully aspirate supernatant and lyse the cells with 30µL MPER reagent/well. 

a. 40µL Pi to 1mL MPER reagent. 

 

3. Agitated for 10 minutes at 4°C (level 5 cold room or use rotator). 

 

4. Centrifuge the plate at 14,000g for 15 minutes at 4°C (level 1, level 2 plate centrifuge). 
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5. Transfer supernatant to fresh 96-well plate (discard cell pellet/debris). 

 

6. Store at -80°C for long-term storage or continue to measure protein content by performing a 

Bradford Assay. 

Bradford Assay 

 

7. Transfer 10µL of protein to a fresh 96-well plate. 

 

8. Add 250µL Bradford Coomassie Reagent (stored in 4°C fridge, level 4). 

 

9. Incubate in foil at room temperature on a rotating platform for 10 mins. 

 

10. Measure absorbance at 595nm on a spectrophotometer (Level 2, Communal area). 

a. Select microplate manager 

b. Select > open –place plate with lid off in the plate holder 

c. Go to > File> new endpoint protocol. Select measurement filter to 595nm. Click > 

run. 

d. Go to > file > export to excel > save document on T: drive. 

 

11. Normalise raw Seahorse data to protein content. 
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Appendix A  
 
 

 
 

 

Figure 1: Mitochondrial modulator oligomycin prevents state 3 phosphorylating 

respiration and is an ATP coupler. By inhibiting ATP synthase, oxygen consumption rate 

is reduced and the percentage of oxygen consumption devoted to ATP synthesis can be 

calculated (ATP production). In addition, the percentage of oxygen required to overcome 

the leak across the inner membrane can be determined (Coupling efficiency). 

 

 

 

 

 

 

Figure 2:   FCCP is mobile ion carrier and ETC accelerator as it transports hydrogen ions 

across the mitochondrial membrane instead of through the proton channel of ATP 

synthase. This uncoupling agent disrupts ATP synthase and collapses MMP which 

sequentially allows for a rapid consumption of energy and oxygen consumption without 

generating any ATP molecules. This allows for the maximal mitochondrial respiration to 

be determined as well as the spare respiratory capacity by removing the initial basal 

respiration from the maximal respiration. A large spare respiratory reserve in cells 

ensures their survival. 
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Figure 3:  Rotenone is a complex I inhibitor and Antimycin A is a complex III inhibitor in 

the electron transport chain. By inhibiting these complexes, mitochondrial respiration is 

essentially ‘shut down’. This allows us to determine both the mitochondrial and non-

mitochondrial fractions contributing to respiration. Following the rotenone and 

antimycin injection we see a decrease in oxygen consumption rate due to impaired 

mitochondrial function. 

 

 

 

 
 

Figure 4: Mitochondrial respiration is determined by the rate of oxygen consumed by the 

cells and allows for basal respiration of cells to be investigated. 
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SOP 024: Mitochondrial Extraction 
 

 

Description: This method is used for the isolation of crude mitochondria from intact cells. Cytoplasmic 

junk such as other organelles and proteins are a by-product of this extraction and can also be used 

experimentally. 

 

   

For adherent cells  

 

1. Wash cells with PBS (-). 

 

2. Create a single cell suspension by trypsination (Refer to SOP 001.6) 

For suspension cells 

 

3. Centrifuge cells at 600x g for 5 mins at 4°C (to prevent mitochondrial degradation) at a low 

speed (acceleration/deceleration of 3). 

 

4. Decant media and tap pellet. Resuspend cell pellet in 500µl of ice cold IB cells -1 (See reagents 

A) in a 1.5ml eppendorf microcentrifuge tube. 

 

5. Pre-cool everything in an ice bath for 5 mins.  

 

6. Homogenization: 

a. Add 500µl of hypotonic buffer 1 (See reagents B).  

b. Incubate for 5 mins at 0°C (on ice with water).  

c. Add equal quantity of hypotonic buffer 2 (See reagents C) and vortex for 5 mins at 

4°C.  

d. Pass through a 21 gauge needle 6 times and reverse pipette 20 to 30 times.  

 

7. Place back on ice before centrifugation at 1800 rpm (700x g) for 10 min at 4°C. 

a. Remember to pre-cool the centrifuge and check temperature before centrifugation. 

  

8. Keep pellet (cytoplasm junk) and transfer solution in to a new microcentrifuge tube. 

a. Can discard pellet if not interested. 

 

9. Pellet mitochondria at 7000x rcf for 10 min at 4°C in a bench top centrifuge (in the cold 

room).  

 

10. Keep supernatant containing the cytoplasmic fraction (~1mL) and wash pellet with 1 ml Mito 

buffer (See reagents D). 

 

11. Resuspend cell pellet and mitochondria pellet in RIPA buffer (See reagents E). 

a. ~200µl for mitochondria, or 300µl for cell pellet. 
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Preparations of Buffers and Reagents 
 

A. IB cells -1 

 

Mannitol---------------------20.5 g 

Sucrose------------------------ 13 g 

Bi-distilled water--------- 400 ml 

Tri-HCl pH 7.4 ------------- 15ml 

 

Bring final volume to 500 ml. Mix together until mannitol and sucrose dissolve completely. Aliquot 

150 ml of this stock solution and add 60µl of EGTA.  

Final concentrations: 225 mM Mannitol, 75 mM sucrose, 0.1 mM EGTA, 30 mM Tris-HCl pH 7.4 

 

B. Hypotonic Buffer 1 

       

 

      1M Tris ----------------------500µl  

      CaCl2 ------------------- 16.647 mg  

      Acetic Acid -----------------100µl 

        

 Mix together until completely dissolved. Fill up to 50 ml with milliQH2O 

 

 

C. Hypotonic Buffer 2 
     

      1M Tris ---------------------500µl  

      CaCl2 -------------------16.647 mg  

      Acetic Acid -----------------100µl 

      10% Triton-X ---------------- 5ml 

 

 Mix together until completely dissolved. Fill up to 50 ml with milliQH2O 

 

D.  Mito Buffer 
    
       Suctose -------------------100mM 

       EGTA --------------------- -0.1mM 

       TrisHCl pH7.4 ------------50mM 

       KCl ------------------------100mM 

       KH2PO4 ---------------------- 1mM 

      FFA free BSA (+inhibitors) 2% 

   

E. RIPA Buffer  
 

      1x RIPA+ Pi (Protease Inhibitor) (final volume of 5 ml) 
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SOP 025: Isolation of Nuclei 

 

 

Description: This method is used to measure drug content in cell and nuclei components. You will 

need a large cell number: ~10 mL at 1 million cells per mL for cellular drug and ~20 mL at 1 million 

cells per mL for nuclear drug. 

 

 

SOP 025.1 Determination of Drug Contents in the Cell 

 

Procedure:  

 

1. Following cell treatments pellet the cells by centrifugation at 700 x g for 5 minutes. 

 

2. Remove the supernatant and incubate the cells in 13% acetonitrile / 0.1% TFA in dH2O 

overnight.   

 

3. Following incubation centrifuge at 1000 x g for 10 minutes, remove fraction of supernatant (~3 

mL of 5 mL).  

 

4. Lyophilize to dryness. 

 

5. Dissolve drug in 45% methanol for measuring absorbance at 350 nm.   

a. Dilute as required. 

 

SOP 025.2 Isolation of Nuclei and Determination of Drug Contents in the Cell 

 

Procedure:  

 

1. Following cell treatments pellet the cells by centrifugation at 700 x g for 5 minutes. 

 

2. Remove the supernatant and resuspended in ice-cold 10mM Tris-HCl, pH 7.4, 3 mM CaCl2, 2 

mM magnesium acetate (hypotonic buffer).   

 

3. After incubation for 5 minutes at 0°C, add an equal volume of hypotonic buffer containing 1% 

Triton X-100 while vortexing. 

 

4.  Shear the cells by passage through a 22-gauge needle.   

 

5. Separate the nuclei from the cytosol by centrifugation at 1000 x g for 10 minutes.   

 

6. Wash the nuclear preparations in hypotonic buffer and pipette to avoid clumping.   

 

7. Use a heamocytometer to determine the concentration of nuclei isolated from each sample.  
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8. Incubate the nuclei in 13% acetonitrile / 0.1% TFA in dH2O overnight.  

 

9. Following incubation, pellet the nuclei by centrifugation at 1000 x g for 10 minutes, remove 

fraction of supernatant (~ 3 mL of 5 mL).  

 

10. Lyophilize to dryness. 

 

11. Dissolve drug in 45% methanol for measuring absorbance at 350 nm.   

a. Dilute as required. 
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SOP 026: Iodination Protocol 

 

Description: This method is used to prepare iodoHoechst 33258 by electrophilic aromatic substitution; 

iodophenyl ring.   

 

 
 

Procedure:  

 

1. Typical cold and radioactive iodination (100 µL final reaction) – reagents MUST be added in 

the following order: 

a. Hoechst 33258 – 10-20 µg lots (take stock in 45% methanol; aliquot into test tubes and 

lyophilize to dryness). 

b. 20 µl 45% methanol to dissolve Hoechst 33258. 

c. 65 µl 0.1 M sodium acetate buffer, pH 5.6. 

d. 2 µl – 1 mg/ml lactoperoxidase (prepare stock and freeze in small aliquots 5 µl in -

20°C). 

e. 2-5 µL 10 mM KI solution – prepare KI (cold) stock OR 1-5 µL Na125I in NaOH (hot). 

f. 10 µL H2O2 30% stock freshly diluted 1:500 in dH2O. 

 

2. Vortex and incubate for 60 min at room temperature. 

 

3. Add 200 µL 2% tri-n-butylamine in methanol. 

 

4. Purify using thin layer chromatography (TLC; silica gel 60 F254 aluminium sheets, Merck 

KGaA, Darmstadt, GER; mobile phase methanol:ethanol:tri-n-butylamine, 200:100:3). 

 

5. Excise the band containing the iodoHoechst analogue (use UVA to draw band) from the TLC 

plate and elute overnight in 13% acetonitrile in methanol.   

 

6. Lyophilize to dryness, re-dissolved in absolute methanol and lyophilized to dryness for storage. 
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SOP 027: UVA Phototherapy Fluence 

 

Description: This method is used to measure the fluence of cells exposed to UVA. 

 

 

Procedure:  

 

1. UVA Phototherapy – Fluence.  

 

1 Watt = 1 Joule / sec 

 

Flux – from UV-X radiometer (µWatts / cm2) 

 

2. Adjust height of UV lamps. 

 

100 µWatts / cm2 = 1 Watt / m2 = 1 J / m2 / sec 

 

Flux = 100 µWatts / cm2 = J / m2 / sec 

 

Fluence = J / m2 = Flux (J / m2 / sec) x time (sec) 

 

Time (sec) = Fluence (J / m2) / Flux (J / m2 / sec) 

 

 

3. Fluence ~ Dose; Flux = Dose rate. 

 

 

Sam Broadhurst – typical cloning experiment 

 

V79 cells (40 k per flask, 3 days ~ 2x 106 cells); ortho-iodoHoechst (1 µM), 2 hrs, UVA, 1 hr, cloning) 

 

Fluence = 10 J / m2  ~1% survival 

 

Fluence = 20 J / m2  ~0.1% survival 
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SOP 028: Iron Saturation of Transferrin 

 

 

Description: This method is used to measure drug content in cell and nuclei components. You will 

need a large cell number: ~10 mL at 1 million cells per mL for cellular drug and ~20 mL at 1 million 

cells per mL for nuclear drug. 

 

 

 

Procedure:  

 

1. Prepare solutions of apo-transferrin in 250mM Tris-HCl, 150mM NaCl, pH 8.0, 10µM 

NaHCO3.   

 

2. Add 100mM disodium nitrilotriacetate/12.5mM ferric chloride (10µl per mg protein) and 

incubate for 30 minutes at 37°C. 

 

3. Pass the conjugates through a NAP-5 or NAP-10 column (Sephadex G-25; Pharmacia Biotech 

Inc., Piscataway, NJ, USA), that had been equilibrated with 20mM Tris-HCl, 150mM NaCl, 

pH 7.4.   

 

4. The binding of iron to transferrin can be monitored by absorbance spectrophotometry and 

estimated from the A465nm/A280nm ratio.   

a. This was routinely found to be approximately 0.046, consistent with full saturation.   
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SOP 029: E13.5 Heart ex-vivo Mouse Model 
 

Description: Mouse heart organ cultures were conducted with embryonic hearts. Hearts were isolated 

from E13.5 embryos and the entire organs were cultured in DMEM similar to previous studies [1, 2]. 

 

References  

1. Wildenthal, K., Long-term maintenance of spontaneously beating mouse hearts in organ culture. J 

Appl Physiol, 1971. 30(1): p. 153-157.  

2. Blewett, C.J., R.E. Cilley, H.P. Ehrlich, J.H. Blackburn Ii, P.W. Dillon, and T.M. Krummel, 

Regenerative healing of incisional wounds in midgestational murine hearts in organ culture. The 

Journal of Thoracic and Cardiovascular Surgery, 1997. 113(5): p. 880-885. 

SOP 029.1 Ordering Mice through AMREP AS   

 

1. Go to: http://www.athos.amrep.org.au/AECNet/Login.aspx 

1. Animal Ethics Application and Animal Services Ordering 

2. Username: email@monash.edu 

Password: ***** 

 

2. Under ‘AMREP AS Services orders’ select – ‘New Live animals’. 

1. Select AppNo 

2. Select  Yes 

3. Fill in Animal Order Form : 

i) User Details 

Name: Jane Betty 

Department: Epigenomic Medicine 

Ph. Number (BH): 99999999 

Ph. Number (AH): 0400****** 

ii) Project Details 

AEC project number: E/xxx/xxx 

Investigator responsible: John Smith 

Project title: Diabetes project 1 

iii) Order Details 

Order type: Single 

Species: mouse 

Genetic Type: Traditional model 

Strain: C57BI/6 (Pregnant) 

Animal zone: (blank) 

Room: (blank) 

Sex: F 

Preferred supplier: WEHI Kew 

Number to Order: 1 

Requested commencement date: eg 26/08/2014 

End point date: 28/08/2014 

Other information:  

“Dear Belinda, Could we please order 2 pregnant mice to be delivered to AMREP AS on 

Tuesday 26/08/2014 with embryos at E12.5 or E11.5 (1st preference: E12.5  and E11.5, 2nd 

preference: 2x E12.5, 3rd preference: 2x E11.5). 

If this is too short notice or the order can’t be fulfilled, can I have these mice delivered to 

AMREP AS on Tuesday 2nd September instead. 

Thanks and best regards, Katherine” 

 

http://www.athos.amrep.org.au/AECNet/Login.aspx
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SOP 029.2 Booking a Procedure Room through AMREP AS   

1. On receipt of the order via email, book a procedure room online.  

1. Under ‘AMREP AS Services orders’ select – ‘New AEC approved Procedure’ 

2. Select AppNo 

3. Select  Yes 

4. Fill in theatre/ procedure request for AEC approved procedures : 

i) Order Details 

Species: Mouse 

Total Animals: 2 

Procedure Type: Euthanasia 

Request time: 9.30 

Estimated duration: 30 min 

Location: Any 

Sterile: Yes 

Recovery: No 

Staff Assistance: No 

Date of procedure: 27/08/14, 28/08/14 

Comments: 
“Hi Prue, 
Can I please have a procedure room with a gas chamber? 
Thanks, 
Katherine” 

SOP 029.3 E13.5 Mouse Heart Isolation and Culture Conditions 

 

Description: Time mated pregnant C57Bl/6 mice were killed by cervical dislocation at 13.5 days 

after conception (E13.5). Uteri were dissected out and placed in ice cold sterile Hanks balanced salt 

solution (Sigma). Embryos at E13.5 were removed from the uteri and amniotic sac. Under a dissecting 

microscope, the chest of the embryos was opened up, and forceps were placed above and below the 

tip of the outflow tract and the entire heart removed. After removal of all hearts, they were 

equilibrated in DMEM supplemented with 1% penicillin/streptomycin at 37oC with 5% CO2 for 1 

hour to allow residual blood to pump out of the hearts. To reduce confounding factors, only embryos 

of a similar size from the same mother were compared within one experimental set. 

 

E13.5 mouse hearts were cultured in 60mm x 15mm organ culture dishes (Falcon), which contain a 

central well surrounded by an outer well, and had their outer well filled with DMEM supplemented 

with 1% penicillin/streptomycin (Gibco, NY, USA) to maintain a humid environment. The medium 

consisted of DMEM (Gibco, NY, USA), supplemented with 1% penicillin/streptomycin. Treatment 

groups consisted of: DMEM control, or DMEM supplemented with NGF (50ng/ml); K-252a (100nM), 

or 0.01% DMSO (vehicle control for K-252a), incubated for 2 and 24 hours. Hearts were cultured at 

37oC with 5% CO2. 

 

Solutions and Reagents: 

 70% ethanol 

 Hanks balanced salt solution (Sigma; H2784) 

 DMEM supplemented with 1% penicillin/streptomycin 

 Phosphate buffered saline (PBS) without Ca2+ and Mg2+ 

 4% paraformaldehyde (PFA) 

 Optimal cutting temperature (OCT) 
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Materials:  

 Gas chamber 

 Dissecting scissors 

 Vannas scissors 

 Dumont 5 forceps 

 Blunt Dumont forceps 

 60mm x 15mm organ culture dishes (Falcon BD) 

 Dissecting microscope 

 

Section: Cryosections cut at 10µm.  

Fixation: 4% PFA for 1 hour or overnight at 4°C 

 

Procedure:  

   

1. Using a pre-booked procedure room, first ethanol all surfaces and utensils and cull the 

pregnant C57Bl/6 mice at 13.5 days after conception (E13.5) using a gas chamber.  

 

2. Dissect the uterus containing the embryos in one piece and transfer into a wee jar containing 

ice cold sterile Hanks balanced salt solution (Sigma).  

 

3. Clean the procedure room and return animal house containers. 

 

To be performed in Epigenomic Medicine Laboratory. 

 

4. Ethanol surfaces and dissecting microscope. 

 

5. Using vannas scissors, remove embryos from the uteri and amniotic sac in a bath containing 

Hanks solution.  

 

6. Dissect the head and tail in one clear sweep against the forceps. 

 

7. Using a dissecting microscope, open the chest of the embryos and place the forceps above and 

below the tip of the outflow tract to remove the entire heart in one piece.  

 

8.  After removal of all hearts, equilibrate the heart in DMEM supplemented with 1% 

penicillin/streptomycin at 37oC with 5% CO2 for 1 hour to allow residual blood to pump out 

of the hearts.  

Tip: To reduce confounding factors, only embryos of a similar size from the same mother were 

compared within one experimental set. 

 

9. Culture the hearts in 60mm x 15mm organ culture dishes (Falcon), which contain a central 

well surrounded by an outer well, and their outer well filled with DMEM supplemented with 

1% penicillin/streptomycin (Gibco, NY, USA) to maintain a humid environment. (Apply a 

treatment here if necessary). 

 

10. Wash hearts with PBS once for 5 mins. 
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11. Fix in 4% PFA for 1 hour at RT or overnight at 4°C. 

 

12. Wash 3 times in PBS for 5 mins. 

 

13. Incubate in 30% sucrose for 20-30mins or until the hearts sink in the bottom. 

 

14. Orient and emded in OCT – freeze on dry ice and store in -80°C freezer until use. 

 

15. Cut cyrosections 10µm to slides. 
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SOP 030: Haematoxylin and Eosin Stain 
 

 

Description: This method is used for the detection of nuclei and the cytoplasm of cells in tissue 

morphology on formalin-fixed, paraffin-embedded sections, and may be used for frozen sections as 

well. The nuclei will be stained blue and the cytoplasm will be pink to red. 

 

 

Fixation: 100% ethanol 

Sections: paraffin sections at 5 µm.  

 

 

Solutions and Reagents:  

 

Lillie Mayer Haemalum: 

      Haematoxylin -------------------------------5 g 

      Ammonium Sulphate -------------------- 50 g 

      Distilled Water------------------------- 700 ml   

      1% Sodium Iodate------------------------30 ml 

      Glacial Acetic Acid --------------------- 20 ml 

      Glycerol---------------------------------- 300 ml   

      Dissolve Haematoxylin and Ammonium aluminium sulphate in distilled water with gentle heat. 

Cool, and then add sodium iodate, glacial acetic acid and glycerol. 

 

Scott’s Tap Water Substitute:  

   

      Sodium Bicarbonate ------------------------------------- 3.5 g  

      Magnesium Sulphate (MgSO4) (Epson salts) --------- 20 g  

      Or, MgSO47H20 ----------------------------------------24.44g 

      Tap Water --------------------------------------------- 1000 ml   

 Mix together until completely dissolved. 

 

Buffered Alcoholic Eosin Stock Solutions: 

 

      Stock Alcoholic Eosin:  

      Eosin ---------------------------------------- 10 g  

      Distilled Water --------------------------- 50 ml  

      Absolute Ethanol------------------------- 950ml  

Dissolve eosin in water, then add ethanol. 

   

      0.2M Sodium Acetate in 95% Ethanol:  

      Sodium acetate (NaCH2COOH) --------- 10 g  

      95% Ethanol ----------------------------- 500 ml  

 

      1M Acetic Acid in 95% Ethanol:  

      Glacial Acetic Acid -------------------- 31.2ml 

      95% Ethanol ----------------------------- 520 ml  
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      Buffered Alcoholic Eosin Working Solution: 

      Stock Alchoholic Eosin ------------------------------- 500ml  

      0.2M Sodium Acetate (alchoholic) ------------------ 80 ml  

      1M Acetic Acid (alchoholic) ------------------------ 170 ml  

      95% Ethanol ------------------------------------------ 1250 ml 

 

 

Procedure:  

   

1.   Deparaffinize in 2 changes of xylene for 10 minutes each and rehydrate through 100% 

alcohol, 95% alcohol 70% alcohol for 5 minutes each.  

 

2.   Wash in distilled water for 1 min. 

 

3.   Stain in Lillie Mayer haemalum for 5 min. 

 

4.   Rinse running tap water until water is clear. 

 

5.   Blue in Scott’s Tap water for 1 min. 

 

6.   Rinse in running warm tap water once.   

 

7.   Immerse in 95% ethanol for 1 min. 

 

8.   Stain in buffered alchoholic eosin (working solution) for 10 mins. 

 

9.   Rinse in 95% ethanol. 

 

10. Dehydrate in absolute ethanol 3 times for 3 mins each. 

 

11.  Clear in xylene twice for 5 min each. 

 

12. Mount with resinous mounting medium (DPX).  

   

 

Results: 

   

     collagen.............................................pale pink 

              muscle..............................................deep pink 

          acidophilic cytoplasm.................................red 

     basophilic cytoplasm.............................purple 

         nuclei........................................................blue 

         erythrocytes....................................cherry red 
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SOP 031: Masson's Trichrome Stain 

SOP 031.1 Masson’s Trichrome Stain 

Description: This method is used for the detection of collagen fibers in tissues such as skin, heart, 

etc. on formalin-fixed, paraffin-embedded sections, and may be used for frozen sections as well. The 

collagen fibers will be stained blue and the nuclei will be stained black and the background is stained 

red. 

 

Fixation: 10% formalin or Bouin's solution 

Section: paraffin sections at 5 µm.  

 

Solutions and Reagents:  
 

Bouin's Solution: 

      Picric acid (saturated) ------------------- 75 ml 

      Formaldehyde (37-40%) ------------------ 25 ml 

      Glacial acetic acid ------------------------- 5 ml   

      Mix well. This solution will improve Masson Trichrome staining quality. 

 

Weigert's Iron Hematoxylin Solution:  

   

      Alcoholic Hematoxylin Stock Solution A:  

      Hematoxylin ----------------------------- 1 g  

      95% Ethanol ----------------------------- 100 ml  

 Dissolve over gentle heat – do not boil. Store at room temperature for up to 1 year. 

 

      10% Ferric Chloride Stock Solution B:  

      Ferric chloride (Iron III chloride) --------- 5.8 g  

      Milli-Q water ------------------------------- 95 ml  

      Glacial acetic acid----------------------------- 1ml  

Dissolve ferric chloride in 50mL water, and then add remaining water. Add acetic acid last. Store at 

room temperature for up to 1 year. 

   

      Weigert's Iron Hematoxylin Working Solution:  

      Mix equal parts of stock solution A and B. This working solution is stable for 3 months (no good 

after 4 months)  

   

Biebrich Scarlet-Acid Fuchsin Solution:  

      Biebrich scarlet, 1% aqueous --------- 90 ml  

      Acid fuchsin, 1% aqueous --------------10 ml  

      Acetic acid, glacial --------------------- 1 ml  

Store at room temperature for up to 1 year. 

   

Phosphomolybdic-Phosphotungstic Acid Solution:  

      5% Phosphomolybdic acid ------------- 25 ml  

      5% Phosphotungstic acid -------------- 25 ml  

Store at room temperature for up to 1 year. 

 

  Aniline Blue Solution:  

      Aniline blue ------------------------------- 2.5 g  

      Acetic acide, glacial --------------------- 2 ml  

      Distilled water --------------------------- 100 ml  

Store at room temperature for up to 1 year. 
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1% Acetic Acid Solution:  

      Acetic acid, glacial ----------------------- 1 ml  

      Distilled water ---------------------------- 99 ml  

Make fresh before use. 

   

Procedure:  

   

1.  Deparaffinize in 2 changes of xylene for 10 minutes each and rehydrate through 100% alcohol, 

95% alcohol 70% alcohol for 5 minutes each. 

 

2.  Wash in distilled water for 1 min. 

 

3.  For Formalin fixed tissue, re-fix in Bouin's solution for 1 hour at 56°C to improve staining 

quality although this step is not absolutely necessary.  

 

4.  Rinse running tap water until yellow color clears then wash in distilled water for 1 min. 

 

6.  Stain in Weigert's iron hematoxylin working solution for 10 minutes.   

  a. Solution can be saved for future use.   

 

7.  Rinse in running warm tap water for 10 minutes then wash in distilled water for 1 min.  

 

9.  Stain in Biebrich scarlet-acid fuchsin solution for 10-15 minutes.  

  a. Solution can be saved for future use.   

 

10. Wash in distilled water for 1 min.  

 

11. Differentiate in phosphomolybdic-phosphotungstic acid solution for 30 minutes or until 

collagen is not red. 

 

12. Transfer sections directly (without rinse) to aniline blue solution and stain for 10 minutes.  

 

13. Rinse briefly in distilled water – one quick dip. 

 

14. Differentiate in 1% acetic acid solution for 4 minutes – discard after use. 

 

15. Wash in distilled water – couple of quick dips.  

 

16. Dehydrate very quickly through 95% ethyl alcohol, absolute ethyl alcohol (these step will 

wipe off Biebrich scarlet-acid fuchsin staining) and clear in xylene.  

 

17. Mount with resinous mounting medium (DPX).  

 

Results: 

        Collagen and mucus ---------------------------------------------- blue  

      Nuclei ------------------------------------------------------------- black  

      Muscle, cytoplasm, keratin and erythrocytes ------------------- red  
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SOP 031.2 Quantification of Masson’s Trichrome Stain using Image-Pro Plus®  

 
Description: This method of analysis quantifies collagen via measuring the epithelial and sub-

epithelial thickness of the lung. Note this method is tailored for lung tissue; please modify the steps 

accordingly to suit alternative tissue.   

 

Software:  

 Image-Pro Plus® (version 7.0) 

 

Procedure: 

 
1. Image Pro Plus > file > open > image  

 

2. Calibrate the image to the correct magnification (use an image with a scale bar) 

a. Measure > calibration> spatial calibration wizard 

b. Follow the prompts: name the calibration > select the units (ums) > select your 

objective (include reflective index- for DPX its 1.51) > tick ‘ create a reference 

calibration > next > draw reference line (draw reference line over the scale bar and 

select the correct units) > next > finish 

c. Once calibrated save the calibration name so you can re-use this calibration for next 

time 

 

3. Select the ‘spatial calibration’ icon  > tick list reference calibrations only > and select the 

calibration you just created (x20 magnification) > OK 

 

4. Select the ‘manual measurements’  icon  

 

5. To measure the Epithelial Thickness: select the ‘create trace feature’ tool  in the 

‘Measurements’ window 

a. First trace around the apical surface  

b. Trace around the basement membrane (the layer just after the epithelium and before 

the smooth muscle). Refer to Appendix A figure 1 if necessary.  

Tip: you can let go of the left clicker and it will remain in place, and to end you trace just right click 

and it will turn yellow. 

6. Select the ‘Add thickness measurements between two lines or traces’  > trace a rectangle 

area between the apical surface and the basement membrane > the result will pop up under the 

features tab as CT1 

a. This will calculate the average thickness between the apical and basement membrane 

lines 

 

7. To measure the Sub-epithelial Thickness: Re-select the ‘create trace feature’ > trace around 

the edge of the surrounding collagen (stained blue) 

Tip: if the collagen is shared between one airway and another/a blood vessel, at that section trace 

exactly halfway between the two areas 
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8. Once again select the ‘Add thickness measurements between two lines or traces’> trace a 

rectangle area between the basement membrane and collagen > the result will pop up under 

the features tab as CT2 

 

9. To export the results each image measurements can be exported to a notepad before copied 

and pasted into an excel spreadsheet. 

a. Back in the measurements panel; select the Input/Output tab > Export > features + 

File (Append..) > Export now 

 

10. The thickness for the Epithelial Thickness will be ‘average distance’ value under CT1 

(yellow) 

 

11. The thickness for the Sub-epithelial Thickness will be the ‘average distance’ value under CT2 

(orange)  

Tip: the basement membrane length will be the recorded as the length of T2 (circled) 
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Appendix A 
 

 
 

Figure 1: A Masson’s trichrome stain of an airway, with the apical surface, basement and collagen 

(stained blue) labelled within Image-Pro Plus.  
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SOP 032: Prussian Blue Staining Protocol for Iron 
 
 

Description: Small amounts of ferric iron are found normally in the spleen and bone marrow. Excessive 

amounts are present in hemochromatosis and hemosiderosis. Prussian blue reaction involves the 

treatment of sections with acid solutions of ferrocyanides. Any ferric ion (+3) present in the tissue 

combines with the ferrocyanide and results in the formation of a bright blue pigment called Prussian 

blue, or ferric ferrocyanide. This is one of the most sensitive histochemical tests and will demonstrate 

even single granules of iron in blood cells.  

   

SOP 032.1 Prussian Blue Staining 
 

Fixation: 10% Formalin.  

Sections: Paraffin sections at 5 um.  

   

Solutions and Reagents:  
   

20% Aqueous Solution of Hydrochloric Acid:  

      Hydrochloric acid, concentrated ------------ 20 ml  

      Distilled water -------------------------------- 80 ml  

      Mix well.  

   

10% Aqueous Solution of Potassium Ferrocyanide:  

      Potassium ferrocyanide, Trihydrate  

      (K4Fe(CN)6.3H2O, FW 422.4, Sigma, Cat# P-3289) -----10 g  

      Distilled water ----------------------------------------------- 100 ml  

      Mix to dissolve  

  

Working Solution:  

     Mix equal parts of 20% hydrochloric acid and 10% potassium ferrocyanide solution JUST before 

use. 

  

Nuclear Fast Red Solution (See SOP 022.2) 

       

Procedure:  

   

1.   Deparaffinize in 2 changes of xylene for 10 minutes each and rehydrate through 100% 

alcohol, 95% alcohol 70% alcohol for 5 minutes each. 

 

2. Mix equal parts of hydrochloric acid and potassium ferrocyanide prepared immediately before 

use. Immerse slides in this solution for 20 minutes.  

 

3.   Wash in distilled water, 3 changes.  

 

4.   Counterstain with nuclear fast red for 5 minutes.  

 

5.   Rinse twice in distilled water.  

 

6.   Dehydrate through 95% and 2 changes of 100% alcohol for 3 minutes each. 

 

7.   Clear in xylene, 2 changes, 5 minutes each.  

 



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 122 

 

8.   Coverslip with resinous mounting medium (DPX).  

 

Results:  
   

      Iron (ferric form) ------------------------ bright blue  

      Nuclei ------------------------------------- red  

      Cytoplasm -------------------------------- pink  
 

SOP 032.1 Nuclear Fast Red 

 

Product Number:  N 8002, Store at Room Temperature 

Product Description 

Molecular Formula: C14H8NNaO7S 

Molecular Weight: 357.3 

CAS Number: 6409-77-4 

CI: 60760 

Synonyms: Kernechtrot, Calcium Red1 

 

Solutions and Reagents:  

   

Nuclear fast red (Kernechrot) solution for use as a counterstain 

Dissolve 25 g of aluminum sulfate in 500 ml of distilled water. 

Add 0.5 g of nuclear fast red. Use heat to dissolve. 

Cool, filter, and add a few grains of thymol as a preservative. 

 

Tip: A comparable solution is prepared and offered by Sigma (Product No. N 3020). 

 

Procedure (For use as a counterstain): 

 

1. Rinse sections in distilled water. 

 

2. Counterstain sections in nuclear-fast red solution for 5 minutes. 

 

3. Wash in running tap water for 1 minute or more. 

 

4. If using an aqueous mounting medium, the slides are ready to coverslip. If using a permanent 

mounting medium, dehydrate in 2 changes of 95% alcohol, 2 changes of absolute ethanol, and 

2 changes of xylene. Slides can now be mounted using a synthetic, permanent mounting 

medium (DPX). 

 

Tip: Inadequate washing of the slides after nuclear fast red staining will result in cloudy slides. If the 

slides have not been coverslipped in a permanent mounting medium, return to running water and wash 

well. If slides have been coverslipped in a permanent mounting medium, soak in xylene to remove the 

coverslip, soak in 3 changes of xylene to remove the mounting medium, in 3 changes of absolute 

alcohol to remove the xylene, and then in 3 changes of 95% alcohol. Wash slides for 5 minutes in 

running tap water and repeat step 4 above. If the chromagen in immunochemistry is water soluble, 

skip the dehydration steps and mount in an aqueous mounting medium. 
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SOP 033: Alcian Blue and PAS Staining Protocol 
 

 

Description: This is a combined method utilising the properties of both the PAS and Alcian blue methods 

to demonstrate the full complement of tissue proteoglycans. 

  

The rationale of the technique is that by first staining all the acidic mucins with Alcian blue, those remaining 

acidic mucins which are also PAS positive will be chemically blocked and will not react further during the 

technique.  Those neutral mucins which are solely PAS positive will subsequently be demonstrated in a 

contrasting manner.  Where mixtures occur, the resultant colour will depend upon the dominant moiety. 

  

The combined result from the port-manteau method demonstrates both acidic- neutral- and mixtures of 

acidic and neutral mucins. 

  

Fixation: 10% formalin.  

Section: paraffin sections at 5 µm.  

 

Solutions and Reagents:  

 

Alcian Blue pH 2.5 

  1% Alcian blue in 3% aq acetic acid 

          Alcian blue 8GX (CI 74240) ------ 1.0 g 

          Distilled water -------------------- 97.0 ml 

    Glacial acetic acid ---------------- 3.0 ml 

Dissolve the dye in the distilled water, add acid, mix well.  Filter into the reagent bottle and filter 

before use. 

 

0.5% Periodic Acid Solution 

      Periodic acid ---------------------- 0.5 g  

      Distilled water -------------------- 100 ml  

 

Schiff Reagent Recipe:  

1. Dissolve 5g of basic fuchsin in 900ml of boiling distilled water. 

 

2. Cool to approximately 50oC and slowly add 100ml of 1N HCl. 

  

3. Cool to approximately 25oC and dissolve 10g of Potassium Metabisulphite (K2S2O5). 

  

4. Shake for 3 minutes and incubate in the dark at room temperature for 24 hours. 

  

5. Add 5 grams of fine activated charcoal to extract the colour and shake for 3 minutes. 

  

6. Stand for 5 minutes and filter solution (should be clear). 

  

7. Repeat step 6 until the final product appears clear. 

 

8. Store at 4oC in a foil covered bottle (Store for 6 months). 

 

9. Bring to room temperature before staining. 
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Tip: To test for Schiff reagent - Pour 10 ml of 37% formalin into a watch glass. To this add a few 

drops of the Schiff reagent to be tested. A good Schiff reagent will rapidly turn a red-purple color. A 

deteriorating schiff reagent will give a delayed reaction and the color produced will be a deep blue-

purple.   

 

1% Acid Alcohol 

70% ethanol.........................990ml 

Concentrated HCl.................10ml 

 

 

*Schiff Reagent Alternative:  

0.5% (w/v) basic fuchsin in acid alchohol 

      Basic fuchsin -----------------------2.5 g  

 70% ethanol --------------------- 495ml 

Concentrated HCl------------------5ml 

 

Technical Points 
  

1. Diastase pre-treatment may be used to eliminate the presence of glycogen, prior to staining in 

Alcian blue. 

 

2. Fixation not-critical, however fixation by aldehyde addition, eg glutaraldehyde, will produce non 

specific general PAS positivity. 

  

 

Procedure: 

 

1. Deparaffinize in 2 changes of xylene for 10 minutes each and rehydrate through 100% 

alcohol, 95% alcohol 70% alcohol for 5 minutes each.  

 

2. Stain with Alcian blue 30 mins at room temperature. 

 

3. Wash in running tap water until water is clear then rinse in distilled water for 1 min. 

 

4. Treat with periodic acid 5 mins. 

 

5. Wash well in distilled water for 5 mins. 

 

6. Stain with Schiff's reagent 30 mins at room temperature* 

 

   *Stain for 20 min in Schiff’s alternative followed by a rinse in 70% ethanol. 

The shade of the basic fuchsin staining is a little yellower than that achieved with Schiff 

reagent but the selectivity, light fastness, response to different fixatives, and to prior histo-

chemical blocking of the tissue section were much the same for the two methods. The need 

for prior oxidation or hydrolysis and the inhibitory effect of aldehyde blocking techniques 

indicate that basic fuchsin, like Schiff reagent, reacts with aldehyde groups. Infrared studies 

indicate that for cellulose the reaction product is an azomethine. 

 

7. Wash well in running tap water 5 mins then rinse in distilled water for 1 min. 
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8. Stain nuclei with Lillie Mayer’s haematoxylin 1-3 min. 

 

9. Wash in running tap water 2 mins. 

 

10. Differentiate with acid alcohol - 10 dips. 

 

11. Wash and blue nuclei in Scott’s tap water - 10 dips. 

 

12. Wash in water for 5 mins. 

 

13. Dehydrate in absolute ethanol 3 times for 10 dips each. 

 

14. Clear in xylene twice for 5 min each. 

 

15. Mount with resinous mounting medium (DPX).  

 

Results 

 acidic mucins ............................... blue 

 neutral mucins ............................. magenta  

 mixtures of above ......................... blue/purple  

 nuclei ....................................... deep blue  
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SOP 034: Picrosirius Red Stain 
 
 

Description: This method is used to measure fibrosis of cells in tissue morphology on formalin-fixed, 

paraffin-embedded sections, and may be used for frozen sections as well. Stains collagen red and 

cytoplasm and other protein-rich material yellow. 

 

Procedure:  

 

1. Deparaffinize in 2 changes of xylene for 10 minutes each and rehydrate through 100% 

alcohol, 95% alcohol 70% alcohol for 5 minutes each.  

 

2. Wash in running tap water for 3 min. 

 

3. Stain with 0.1% Picrosirius Red solution for 30 minutes. 

 

Tip: DO NOT deposit Sirius red solution into the sink – pour the solution back into the glass cricuble 

– reusable. Always perform this step in a fume hood. 

 

4. Rinse briefly in 70% ethanol. 

 

5. Check staining under the microscope.  

 

6. Wash with 95% ethanol – if staining was strong leave for 3-4 minutes, if staining was weak 

leave for ~1 min. 

 

7. Wash with 100% ethanol - if staining was strong leave for 3-4 minutes, if staining was weak 

leave for ~1 min. 

 

8. Wash with 100% ethanol for 30sec-1min twice. 

 

9. Dehydrate in absolute ethanol 3 times for 3 mins each. 

 

10. Clear in xylene twice for 5 min each. 

 

11. Mount with resinous mounting medium (DPX).  

 

12. Image using a light microscope at 20x magnification (1 slide/10 images). 

  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 129 

 

 
 
 
 
 
 
 

STANDARD OPERATING PROCEDURE 
 

 
Title:  Picrosirius Red imaging on BX61 and Analysis in Image J  

Document ID: 035 

Author: Nadia Mazarakis Date:  7 July 2015 

Effective date: 7 July 2015 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 7 July 2015  

 
 
 



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 130 

 

SOP 035: Picrosirius Red Imaging on BX61 and Analysis in Image J 

 
 

Description: This stain is used to detect fibrosis - Type I and III collagen. In bright field-microscopy 

collagen will appear red while the remaining protein-rich tissue will be pale orange/yellow. If imaging 

with polarised light (BX61) Type I collagen is seen as red and yellow fibres, while Type III collagen 

is green against the black background. 

 

SOP 035.1: Picrosirius Red Imaging using the Olympus BX61 Flourescence Microscope 

 
Procedure: 

 
1. Turn the BX61 Olympus (Baker Tower, LG, morphology lab) BX-USB  lamp on (the light 

box). 

a. No need for fluorescence lamp on (box far right) 

 

2. Turn the computer on and log in:  

a. Username: fluromicroscope  

b. Password: fluromicroscope  

 

3. Open software > AnalySIS LS Research.  

a. In software in the top toolbar select > microscope control > password: user. 

b. Select icons for bright field (BF) and select your magnification from one of the top 

toolbars.  

 

4. Insert your microscope slide and find your tissue region of interest > snapshot > file save as 

your bright field image. 

 

5. To switch to polarised light:  

a. Under the stage of the microscope there is another filter with a top and bottom 

rotation. 

i. Rotate the bottom of the round filter first  > until nonagon is in  visual range 

and adjust until in focus > rotate this bottom filter again until the nonagon is 

just out of the visual eye-piece range. 

 

Tip: If the nonagon (condenser) is not coming in focus > seek assistance from Iska/Stephen for a 

small screwdriver to adjust the nonagon back into the visible range. 

 

ii. Push the shutter filter on the right hand side of the microscope in to one click. 

iii. Rotate the top of the round  filter (below the stage) until the light becomes 

polarised (black background, and visible collagen). 

 

6. Within the software right click on camera icon (bottom right hand corner) and select the third 

camera option > Qimaging colour. 

 

Tip: If this option is not available - this means the camera from the microscope is not correctly linked 

up with the computer. So the camera at the back of the microscope you may need to change the 

connection port to the alternative option. 

 

7. Change the eye piece from the microscope to the computer screen (both rods out on the top 

right of the microscope) - picture should now appear on the screen. 

 

8. To acquire an image > acquire (top toolbar) > camera control.  
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a. In the newly opened ‘BX control panel’ > general > lamp transmittance > adjust the 

toggle bar until the image displays a crisp image (black background and no visible 

saturation of the collagen). 

b. The other window that opened is ‘Camera control’ > adjust the ‘Exposure time’ 

(~200sec) and ‘Gain’ (this will adjust the brightness of the collagen present). 

 

9. To take the image > select ‘snapshot’ > file > save image as. 

 

10. Shutdown software and microscope once your session has concluded. 

 
SOP 035.2: Picrosirius Red Analysis using Image J (Fiji) 

 
1. Open the TIF. File and you will see the polarised light image as one file. 

 

2. Image > colour > split channels. 

a. The image will automatically separate the colours into red, yellow and green (in 

windows 1, 2 and 3 respectively). 

 

3. Select the ‘free hand selection’ icon in the toolbar and circle the tissue of interest for analysis. 

 

4. To save the selection (so that the same selection can be used on each of the different 

channels). 

a. File > save as > selection  

 

5. To remove the unwanted surrounding tissue: 

a. Edit > Clear outside 

 

6. To analyse the amount of the collagen present on each channel: 

a. Image > adjust > threshold  

i. Tick dark background and adjust the threshold using the horizontal toggle bar 

so that the background is minimised and only the collagen staining is evident. 

b. Repeat for channel 2 and 3. 

 

7. To set measurements: 

a.  Analyse > set measurements > select boxes area, grey value, limit to threshold and 

display label.  

 

8. Analyse > measure (or Crtl + M). Copy these results into an excel spread sheet. 
 

9. Go back through all the saved ROI selections and calculate the area of each of the ROIs: 

a. File > open > ROI  

b. Analyse > set measurements > select boxes area, perimeter and display label 

i. N.B make sure that the ‘limit to threshold’ box is not selected here  

c. Analyse > measure ( or Crtl + M). 

 

10. Display your results as Type I collagen (red + yellow mean area) and Type III (green mean 

area). 

 

11. For a relative representation of the collagen present in each ROI selection: 

a. Tabulate your results as a percentage of mean area of the collagen per ROI selection 

area ( i.e. area of each type of collagen divided by the corresponding ROI selection 

area – calculated in step 9.C).  
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SOP 036: Immunohistochemistry (IHC) 

 
Description: Immunohistochemistry (IHC) involves a specific antigen-antibody reaction in order to 

identify the location of these antigens within the formalin-fixed paraffin-embedded tissue sections. 

The advantage of IHC over immunofluorescence is ability to use light microscopy, allowing for the 

visualisation of surrounding tissue morphology.   

 
Procedure:  

 

1. Deparaffinise in xylene (10mins), xylene (10mins), and rehydrate in absolute alcohol (7mins), 

absolute alcohol (7mins) and 70% alcohol (7mins). 
 

DO NOT ALLOW THE TISSUE TO DRY OUT AT ANY POINT THROUGHOUT 

 

 

2. Incubate in 3% hydrogen peroxide (H2O2) for 10mins (See reagent A). 
 

3. Meanwhile heat citrate buffer solution for 5mins in the microwave on high and cool at room 

temperature (RT) (See reagent B). 
 

4. Rinse slides in dH2O before immersing slides into the cooled citrate buffer solution, and heat 

in microwave on high for 5 mins. 

 

5. Cool slides still immersed in the citrate buffer in a water bath (at RT) for 25mins. 

 

6. Once slides are cooled back to RT circle the tissue with a pap pen and add 50L of DAKO 

antibody diluents (See appendix A). 

 

7. Blot off the diluents and add 50µL of primary antibody for 4 hours (or alternatively 

overnight) in a humid chamber at RT. 

a. Consult Epigenomic Medicine antibody inventory for optimised antibody dilutions or 

company product sheets for suggested dilution factors 

b. Add DAKO biotin if tissue and primary antibody are raised in the same species (See 

appendix A). 

 

8. Create 3 x Tris buffer stations (See reagent C):  

a. The first station - dip and rinse one slide at a time and transfer to the next buffer 

station. 

b. Second station - rack the slides up and leave in there for 7mins. 

c. Transfer slides into the final station and incubate for 7mins. 

 

9. Add one drop of HRP DAKO to each slide and incubate for 30mins (See appendix A). 

 

10. Rinse slides in Tris buffer in 3 stations: 

a. The first station - dip and rinse one slide at a time and transfer to the next buffer 

station. 

b. Second station - rack the slides up and leave in there for 7mins. 

c. Transfer slides into the final station and incubate for 7mins. 

 

11. Add a 1:1000 dilution of DAB, 1 drop per slide for 5mins (See appendix A). 

 

12. Create 2 stations of H2O: 

a. Rinse slides in the first H2O station. 
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b. Transfer slides to the second H2O station and rack up (no time limit here). 

 

13. Counter stain the slides via immersion in hematoxylin (30sec). 

 

14. Rinse with running tap water (until water is clear of hematoxylin). 

 

15. Immerse in Scott’s tap water for 1min (See reagent D). 

 

16. Rinse slides in running tap water. 

 

17. Immerse slides in dH2O.  

 

18. Rehydrate slides through alcohol solutions (70% alcohol 7mins, 100% alcohol 7mins, 100% 

alcohol 7mins) followed by xylene (10mins) and xylene (10mins). 

 

19. Mount slides with DPX and coverslip. 

 

RT = room temperature 

 

 

 
Preparation of reagents 
 

A. 3% hydrogen peroxide (H2O2) 

Dilute 30% hydrogen peroxide solution in H2O to make up 3%. (E.g to make up 100ml; add 

10ml 30% hydrogen peroxide to 90ml H2O). 

 

B. 1x citrate buffer 

Mix 1.92g citric acid (anhydrous) into 1000ml distilled water until dissolved. Adjust the pH 

to 6.0 with 1N NaOH and then add 0.5ml if Tween 20 and mix well. Store solution at RT for 

3 months or in 4oC for longer storage.  

 

C. Tris buffer (1M, pH 7.5) 

Dissolve 6.05g of Tris base in 30ml of H2O. Adjust pH to 7.5 with 5M HCl. Adjust final 

volume to 50ml with H2O. 

 

D. Scott’s tap water 

Dissolve 10gm of sodium hydrogen carbonate and 100gm of magnesium sulphate in 5L of 

distilled water. Store solution at RT.  
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Appendix A 
 
IHC DAKO kit for mouse primary antibodies 

Reagents 
provided 

Description Purpose 

Peroxidase Block 0.03% hydrogen peroxide 
containing sodium azide 

Pretreatment of the peroxidise block 
before the primary antibody will 
eliminate the background 
endogenous peroxidise activity 
found in tissue via its reaction with 
DAB substrate 

Biotinylation 
Reagent 

Normal mouse serum in Tris-
HCL buffer containing 
stabilizing protein and 
0.015mol/L sodium azide 

Used in solution with primary 
antibody if the tissue sections and 
primary antibody are raised in the 
same species 

Streptavidin-
Peroxidase 

Streptavidin conjugated to 
horseradish peroxidise in PBS 
containing stabilizing protein 
and an antimicrobial reagent 

Used in the labelled strepavidin-
biotin immunoenzymatic antigen 
detection system 

DAB+ Substrate 
Buffer 

Substrate Buffered solution, pH 
7.5, containing hydrogen 
peroxide and a preservative 

In combination with the DAB 
chromogen reacts with the 
peroxidise to create the brown stain 
of the protein of interest 

Liquid DAB+ 
Chromogen 

3,3’-diaminobenzidine 
chromogen solution 

In combination with the DAB 
substrate buffer reacts with the 
peroxidise to create the brown stain 
of the protein of interest 

Antibody Diluent Tris-HCL buffer containing 
stabilising protein and 
0.015mol/L sodium azide 

To optimise the performance of the 
antibody 
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SOP 037: Immunohistochemistry Analysis using Image J 
 

Description: Immunohistochemistry (IHC) involves a specific antigen-antibody reaction in order to 

identify the location of these antigens within the formalin-fixed paraffin-embedded tissue sections. 

The advantage of IHC over immunofluorescence is ability to use light microscopy, allowing for the 

visualisation of surrounding tissue morphology.   

 
Procedure:  

 

1. Open the TIF. File to see your IHC image obtained from light microscopy. 

a. File > Open > Select image. 

 

2. Select the ‘free hand selection’ icon in the toolbar and trace the tissue of interest for analysis 

a. For lung tissue for example: remove the lumen first: edit > clear. 

 

3. If you want to save the selection (so that the same selection can be used on each of the 

different channels). 

a. File > save as > selection.  

 

4. To remove the unwanted surrounding tissue, go to Edit > Clear outside. 

 

5. Convert the image into RGB, go to Image > Type > RGB. 

 

6. Using the plugin already installed, deconvolute the image: 

a. Plugins > colour deconvolution 

b. The colour deconvolution plugin obtained from the link below, 

http://www.dentistry.bham.ac.uk/landinig/software/cdeconv/cdeconv.html is required 

in order to quantify immunostain intensity. 

 

7. Select ‘H DAB’ in the Vectors drop-box, and select Hide Legend. Delete the unwanted 

windows (all excluding Colour_2). 

 

8. To ensure that only the protein of interest is selected, you need to make the lumen and 

background tissue white: 

a. Select the ‘dropper’ icon and select a nice clean white area. 

b. Now select the ‘bucket background’ icon and click on the background and lumen 

areas (should now be convert to white). 

 

9. To measure staining intensity, determine the Threshold that is to remain constant throughout 

the analysis. 

a. Image > adjust > threshold > apply 

b. E.g. Threshold was determined to be between 0 and 120.  

c. Keep this threshold value consistent amongst all treated tissue for the specific protein 

of interest. 

d. N.B. Click Apply until background is coloured black, and tissue is coloured white. 

 

10. To mesure the intensity: 

a. Ctrl+M 

b. N.B. Results Window appears with the quantification of staining intensity (record the 

Mean area for analysis. 

i. To select the area to be included in the measurements: Analyze > set 

measurements > tick area).      

http://www.dentistry.bham.ac.uk/landinig/software/cdeconv/cdeconv.html
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SOP 038: Nanoparticle Preparation 

 

Description: Nanoparticles are currently widely investigated for their potential applications in 

biomedical, optical and electronic fields. 

 

SOP 038.1 Nanoparticle Synthesis   

 

Solutions and Reagents: 

 

1% PVA: 

1100mg PVA (polyvinyl alchohol; Mw 78000, 88% hydrolysed) + 110mL milliQH2O.  Stir on a 

heated magnetic stirrer (~50°C), until PVA has dissolved, then filter using WHATMAN card. 

Parafilm on stirrer. Do not store for more than 4 days 

 

0.667% PLGA (Poly(D,L-lactic-co-glycolic acid)): (once drug solution is added it makes 0.5% 

PLGA) 

-make on the day of nanoparticle preparation 

-166.75g PLGA 5004A (lactide:glycolide, 50:50; Mw 44kg/mol; acid terminal end group) 

-25mL 45% meOH/DCM (dichloromethane) 

-rotate on a rotary mixer until dissolved 

(for 5004A samples, dissolve just before experiment) 

 

400µM drug 

-4mL 1mM stock in 45% meOH/DCM and 6mL 45% meOH/DCM 

-parafilm and store at 4°C 

 

45% meOH/DCM 

-45mL meOH + 55mL DCM – use glass it evaporates quickly 

 

Procedure:  

 

Prepare using an oil-in-water emulsification-solvent evaporation method. 

 

1. Weigh microcentrifuge tubes before beginning. 

 

2. Prepare 100µM drug and 0.5% (w/v) PLGA.  

a. Add 6mL 0.667% PLGA into tube with 2mL 400µM drug solution/45% meOH/DCM 

(control) then vortex 15sec to mix. 

 

3. Pour PLGA solution into glass beaker and add 24mL 1% PVA slowly ( 1part PLGA: 3 parts 

PVA = 50:50). 
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4. Sonicate immediately at ~17 W (Amp 70) for 90 secs (~1580J energy). 

 

5. Stir using a magnetic stirrer at room temperature for 4 hours to allow meOH/DCM to 

evaporate. 

 

6. Switch on freeze dryer. 

 

7. Put NP suspension into 50mL tube and centrifuge at 4750rpm for one hour at RT. 

 

8. Remove supernatant and resuspend in 1mL milliQH2O using a sonicator bath. 

 

9. Transfer to a 1.5 mL microcentrifuge tube and centrifuge at 8000rpm for 10mins. 

 

10. Remove supernatant and resuspend in 1mL milliQH2O. 

 

11. Repeat wash to a total of 3 washes. 

 

12. Resuspend in 1mL milliQH2O and cover with parafilm. Poke a couple of small holes in the 

parafilm. 

 

13. Snap freeze using liquid nitrogen and take down to the freeze dryer and freeze overnight. 

 

14. Store dried NP at 4°C for up to 1 year 

SOP 038.2 Microparticle Synthesis   

Procedure:  

 

Prepare using an oil-in-water emulsification-solvent evaporation method. 

1. Weigh microcentrifuge tubes before beginning. 

 

2. Prepare 100µM drug and 0.5% (w/v) PLGA.  

a. Add 6mL 0.667% PLGA into tube with 2mL 400µM drug solution/45% meOH/DCM 

(control) then vortex 15sec to mix. 

 

3. Add 24mL of 1% PVA into a glass beaker and fit with four baffles. 

 

4. Stir using a IKA RW 20 overhead stirrer to mix the aqueouos phase while adding PLGA 

solution dropwise into the beaker ( 1part PLGA: 3 parts PVA = 50:50). 

 

5. Stir overnight at 1500 rpm to allow solvernt evaporation and microsphere formation. 

 

6. Collect MP emulsion by centrifugation at 2851g for 5 mins at RT. 

 

7. Switch on freeze dryer. 

 

8. Remove supernatant and wash 5 times with 1mL milliQH2O. 

  

9. Transfer to a 1.5 mL microcentrifuge tube and centrifuge at 8000rpm for 10mins. 

 

10. Resuspend in 1mL milliQH2O and cover with parafilm. Poke a couple of small holes in the 

parafilm. 
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11. Snap freeze using liquid nitrogen and take down to the freeze dryer and freeze overnight. 

 

12. A small portion is left to air dry in a fume hood for 24 hours at RT.  

 

13. Store dried MP at 4°C for up to 1 year. 

SOP 038.3 Freeze Drying   (Level 2, Room 2U58, ACBD) 

Procedure:  

 

1. Switch on 30 minutes before use. 

 

2. Check that the oil level in the pump is between min and max 

 

3. Check the oil colour. If the oil appears dark or clouded, it must be changed. 

 

4. Check that all yellow valves are closed. 

 

5. Turn on the freezer and the temperature sensor, and wait until -25°C is displayed. 

 

6. Open the speed vac inserting a thin piece of metal into the bottom right opening on the right 

side of the speed vac, and pushing up while opening the lid. Put the sample in the speed vac. 

Orient the samples so the bottom is facing away from the middle of the centrifuge. 

 

7. Turn on the speed vac without starting the centrifuge, and adjust the temperature settings. 

 

8. Check that the vacuum pump oil valve is oriented to “C”. Only open it if you have an organic 

solvent that needs to be evaporated into oil. 

 

9. Turn on the vacuum pump. The switch is located on the rear. Wait until the vacuum indicator 

needle is at the lower end of the yellow area, close to the green area. 

 

10. Start the centrifuge. 

 

11. Once the vacuum is sufficient, open the valve to the speed vac. Wait until the samples have 

dried (usually overnight). 

 

12. Open the yellow valve opposite the speed vac outlet valve to release the vacuum. 

 

13. Turn off the vacuum pump. 

 

14. Check that no vacuum remains in the speed vac by lifting the lid. 

 

15. Turn off the speed vac, wait until the centrifuge stops, and remove the samples. 

 

16. Turn off freezer and temperature sensor. 

 

17. Drain the freezer once the freezer is back to room temperature. 
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SOP 038.4 Lipid Coating   

Procedure:  

 

1. Prepare 2.5mg of lipid in 4:1 or 3:1 ratio (DOPC:DPPS, DOPE:PHC, DOPC:DPPTE) in 1mL 

chloroform and vortex. 

 

2. Evaporate chloroform under continuous stream of nitrogen (filtered) for 1 hour in a round 

bottom flask (first swirl flask until dry). 

 

3.  Add 4mg of freeze-dried NP in 2mL milliQH20 and add to the flask. 

 

4. Vortex to form an even lipid coat around the nanoparticle via lipid fusion, check to see if film 

comes off. 

 

5. Transfer 2mL (1mL each) to two miocrocentrifuge tubes. 

 

6. Wash 3 times with milliQH20 to remove excess lipid from the NP surface. 

 

7. Re-suspend in PBS or NaOac to use immediately for freeze-dry for future use. 

 

8. To obtain fluorescently labelled lipid coated nanoparticles, add 10% (w/w) of NBD-PC to the 

lipid solution.  

 

SOP 038.5 Pegylation Coating   

 
Procedure: 

 

1. Prepare 10mg PEG in 2mM NaOH dissolved in milliQH2O (NaOH + H2O total 500µL). 

 

2. Add PEG in 1:1 ratio with lipid-coated NP dissolved in milliQH2O (total 1mL). 

 

3. Incubate at room temperature for 30 minutes or overnight with constant gentle agitation. 

Optimum pH for formation of disulfide bonds is pH 11. 

 

4. Neutralise the PEG solution with 50µL of 100mM HCl, then wash 3x with milliQH2O. 

 

5. Sample can be kept for size and zeta-potential analysis. 

 

SOP 038.6 Transferrin Coating 

 

Procedure: 

 

Tf thiolation 

1. Add 20mg of Tf in 1ml 250mM, pH 8 Tris-HCl to make 20mg/mL Tf. 

 

2. Transfer 700µL into a fresh microcentrifuge tube. 
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3. Add 200µL of FeCl3/NTA. 

 

4. Add 92µL Trauts (Total volume ~ 1mL). 

 

5. Incubate for 1 hour at RT. 

 

6. Run through NAP-10 desalting column equilibrated with PBS/EDTA, pH 8, 3 times. 

 

7. Use syringe to put Tf solution. Allow solution to run through column. 

 

8. Add 1.5mL milliQH20 to collect thiolated Tf. 

 

9. Dilute and check absorbance at 280nm and 465nm. 

 

10. Freeze aliquots at -80°C at ~10mg/mL. 

 

Tf (thiolated) coating of PEG-Lipid-NP 

1. Prepare 1mg/mL Tf. 

 

2. Mix with PEG-lipid coated NP for 15 mins on a rotator at RT. 

 

3. Wash 3x with milliQH20. 

 

4. Snap freeze using liquid nitrogen and take down to the freeze dryer and freeze overnight. 

 

5. Use parafilm to cover the tube lid. Store dried MP at 4°C for up to 1 year. 
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Appendix A  
 

Equipment required for nanoparticles measurements 

 

Measurements Equipment Location 

Nanoparticles   

Size distribution 

 

Malvern Zetasizer Nano ZS Melbourne Uni 

Chem. Eng. Faculty 

Polydispersity 

 

Malvern Zetasizer Nano ZS Melbourne Uni 

Chem. Eng. Faculty 

Surface morphology 

(also size distribution) 

Scanning Electron Microscope 

(SEM) 

Bio 21 

Monash Micro Imaging 

(Clayton) 

Hoechst encapsulation  Cary 50UV spectrophotometer 

 

Halo SB-10 spectrophotometer 

Level 2 communal area 

Baker Tower 

EpiMed (Level 4 lab 3) 

Baker Tower 

Surface charge Malvern Zetasizer Nano ZS Melbourne Uni 

Chem. Eng. Faculty 

Drug release Cary 50UV spectrophotometer 

 

Halo SB-10 spectrophotometer 

Level 2 communal area 

Baker Tower 

EpiMed (Level 4 lab 3) 

Baker Tower 

Microparticles   

Size, surface morphology Confocal Microscope 

 

Confocal Microscope with 

VAAS 

Lower ground 

Baker Tower 

ACBD, Level 6 

Burnett Tower 
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SOP 039: Freeze-Drying of Biological Samples 

 

Description: This method is to freeze-dry biological samples including cells, tissue and plants such as 

broccoli.  

 

 

Materials:  

 Liquid Nitrogen 

 Dewar 

 Dry Ice 

 Esky 

 Freeze-drying jar 

 Tissues 

 Parafilm 

 Freeze-dryer 
 

SOP 039.1 Sample Preparation   

 
Procedure:  

 

1. Your sample should be as cold as possible when starting the freeze-drying process. For this: 

a. Either drop your samples in liquid nitrogen for a few mins or keep your samples on  

dry ice for an hour until just before transferring them to the freeze-drying jar. 

b. Put the jar in the freezer for a couple of hours or dip it in liquid nitrogen just before 

putting samples in or place in a dry ice container, submerged, for a few min.  

 

2. Use tissues or cut up holders to keep your samples upright. 

 

3. The more surface area available for your sample to be freeze-dried the better, so you could 

use a larger container and coat the wet sample onto the side of that container over dry ice to 

freeze it in that position.  

 

4. To prevent loss of product, parafilm the container’s mouth and prick a few holes through.  

 

SOP 039.2 Sample Freeze-Drying 

 
Procedure:  

 

1. Flip on switch (on the right side of machine). 

 

2. Close drain (on the left side of machine – follow arrows). 

 

3. Ensure the grey rubber taps on the tree are all upwards. 

 

4. On the screen, click ‘Mode’ ‘warm up vacuum pump’. 

  

5. Wait for 15 min until alarm rings. 
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6. Click ‘Yes’ to ‘main drying’. 

 

7. Wait until vacuum is set at below -20°C (a few seconds). 

 

8. Fit a black lid onto a jar. 

 

9. Fit the lid of the jar on a free opening on the tree. 

 

10. Turn your grey rubber tap down. 

 

11. When finished (only do this if there are no other samples being freeze-dried). 

 

12. Click ‘Mode’  ‘Standby’  ‘Enter’ (Vacuum pump should stop). 

 

13. Turn one grey rubber tap down (hissing while vacuum is being released). 
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SOP 040: Probe Sonication 
 

Description: The Probe Sonicator is located at Baker IDI, Level 5 communal area. The responsible 

person for this instrument is Natalie Mellet (Natalie.Mellett@bakeridi.edu.au).  

 

Materials:  

 70% w/v Ethanol 

 Probe Sonicator 

SOP 040.1: Sample Preparation and Pre-Sonication  

Procedure:  

1. A minimum 100uL of sample are required. 

 

2. Temperature sensitive samples will need to be placed in an ice bath.  

 

3. The sonicator becomes hotter with time. 10-15 sec pulses at a time will be ideal. 

 

4. Samples can be manually help to submerge the probe – this will allow to check for 

overheating. 

 

5. Fill in the diary for the records and turn on the blue unit from the back. 

 

6. Check the correct probe is on (microtip for nanoparticles) and that the probe is tightly 

attached to holder (if doing several samples, check after every few). 

 

7. Rinse probe with 70% (w/v) ethanol and wipe off. 

SOP 040.2: Sonication  

Procedure:  

1. Choose between select/modify a program or operate manually. 

a. If operating manually: set amplitude (power and energy will be calculated as you 

sonicate). 

2. If setting up a program:  

a. Note there are only two programs which will need to be re-set every time. 

b. Time and amplitude can be programmed allowing the instrument to be automatically 

stopped. 

c. You can also program pulse ON and pulse OFF – this is the time you want the probe 

to take to get up to desired amplitude and back. 

d. A sequence can also be programmed, i.e. several programs automatically in a row. 

3. Wear ear muffs and place the sample in position (probe in sample – not too high, not too 

low). 

 Press Start. When finished, press Stop. 

4. If the same sample requires further sonication, press Resume to add the power and energy 

calculations to the first run.  

 

Post Sonication  

5. Rinse probe with 70% ethanol and wipe off. 

6. Turn off the blue unit from the back 

  

mailto:Natalie.Mellett@bakeridi.edu.au
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SOP 041: Dynamic Light Scattering for Nanoparticles  

 

Description: Dynamic light scattering (DLS) determines particle size by measuring changes in 

scattered light intensity from a suspension or solution. The DLS is located at the University of 

Melbourne, Building 165, Level 2. Key contacts for the DLS are:  

 

Dylan Liu (liu.z@unimelb.edu.au, Room 227), key holder for the room 

Dong lin (donglinx@student.unimelb.edu.au, Room 227), key holder for the laser 

SOP 041.1 DLS   

Procedure:  

 

1. Turn on the laser with the key. 

 

2. Turn on the solvent filter box (filters the solvent, can be turned off after 5 mins). 

 

3. Turn on the water bath. 

 

4. Choose intensity (black box with 2 sliders, use slider closest from probe). 

a. The more concentrated the sample, the less light intensity is required. 4000 is highest 

possible intensity. 

 

5. Choose filter (black box with 2 sliders, use slider furthest from probe- usually 633). 

 

6. Open software (BIC/DLS). 

 

7. Click on Motor to change angle to 90°. 

 

8. Click on Parameters to change refractive index. 

a. Need to know refractive index – use  literature. 

 

9. Click on Duration to 2 min max.  

 

10. Click on Clear to erase current data. 

SOP 041.2 Sample Preparation   

Procedure:  

 

1. 1 ml of sample is required. Concentration is flexible however intensity slider needs to be 

adjusted.  

 

2. Place sample in a glass cuvette, add a lid. 

 

3. Spray ethanol on sides of cuvette to remove dust or smudges and dry with tissues. 

 

4. Place cuvette in the white plastic tube, itself inside the brass tube, until it pokes out from 

underneath. 

 

5. Place brass tube in DLS machine, replace black round lid on top. 

 

6. Check that cuvette is visible from slit underneath and touches the bottom surface. 

mailto:liu.z@unimelb.edu.au
mailto:donglinx@student.unimelb.edu.au
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SOP 041.3 Reading the Sample 

 
Procedure:  

 
1. Switch on laser at its mouth.  

 

2. Click on large green button  to start reading. 

 

3. The  will turn into  – wait until it turns back to . 

 
 

SOP 041.4 Data 

 

Procedure:  

 

1. The data has three main features: 

Correlation graph 

 

 If it is a smooth-ish line, the reading is accurate. 

 If there is a break in the line, ther reading may be incorrect. 

 

a. Diameter per Volume  

Larger volume of particles  more intensity  only used if particles are all similar 

size 

b. Diameter per Intensity  

Intensity of light scattering larger for larger particles  only used if  particles are 

similar size  

c. Diameter per Number  

Number of particles/light scattering  used if particles are of different sizes 

 

2. Data can be saved in two ways: 

a. Click on Copy for spreadsheet, then paste on excel sheet. This is raw data, but needs to be 

formatted 

b. Click on Copy for download, then paste. This provides a picture of what was on the 

screen, but data will need to be manually put in a spreadsheet.  
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SOP 042: Sample Preparation for Australian Synchrotron IRM 

Beamline 
 

Description: This method is used for the preparation of biological samples for detection using Infrared 

Microspectroscopy (IRM) at the Australian synchrotron to gain spatial resolution between 3-8µm. 

Biological samples that can be used for transmission include: microtomed sections, cryosections and 

cultured cells. 

 

Materials 

 

 Bruker V80v Fourier transform infrared (FTIR) spectrometer 

 Hyperion 2000 IR microscope 

 Hyperion 3000 Focal Plane Array (FPA) FTIR microscope 

 IR transmitting window i.e calcium fluoride (CaF2 ) windows 

 

Tip: IR transmitting windows include CaF2, BaF2 and ZnSe, however calcium fluoride (CaF2) windows 

are the most commonly used window material for transmission. They are particularly good for cell 

culturing purposes or when working with wet samples, e.g. cyrosectioning. Windows can be carefully 

washed and reused unlike BaF2 or ZnSe windows. CaF2 transmission range = 0.13 to 10 microns and 

0.5mm thick should be used for biological samples.  

Can be purchased at Crystran Ltd - www.crystran.co.uk and are available in sizes 12, 13, 22 and 25mm 

x 0.5mm. 
 

SOP 042.1 Sample Preparation of Paraffin Embedded Sections   

 
Solutions and Reagents: 

 10% formalin (Can use Bouin’s fixative if required) 

 Xylene 

 

Fixation: 10% formalin or Bouin's solution 

Section: paraffin sections cut at 4µm (<10µm if  samples are more delicate).  

 

Procedure:  

   

1. Cut paraffin sections to 4µm to a CaF2 window. 

 

2. Deparaffinize by three consecutive washes in clean xylene. 

 

3. Air dry section under laminar flow in a biological safety cabinet or fume hood. 

 

4. Store dried windows in a dessicator until use. 
   

SOP 042.2 Sample Preparation of OCT Embedded Sections   

 
Solutions and Reagents: 

 4% paraformaldehyde (PFA) 

 Optimal cutting temperature (OCT) 

 70% ethanol 

 100% ethanol 
 

Fixation: 4% PFA 

http://www.crystran.co.uk/
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Section: cryosections cut at 5µm (<10µm if  samples are more delicate).  

 

Procedure:  

   

16. Fix tissue in 1 mL 4% PFA overnight at 4°C. 

 

17. Orient and emded in OCT – freeze on dry ice and store in -80°C freezer until use. 

 

18. Cut cyrosections 5µm (<10µm) to CaF2 window. 

  

19. Air dry at room temperature for 1 hour. 

 

20. Permeabilize with 70% ethanol (-20°C) for 10 mins, then 100% ethanol (-20°C) for 10 mins. 

 

21. Air dry sections under laminar flow in a biological safety cabinet or fume hood. 

 

22. Store dried windows in a dessicator until use. 
 

 SOP 042.3 Sample Preparation of Cultured Adherent Cells   

 

Solutions and Reagents: 

 4% paraformaldehyde (PFA) 

 Phosphate buffered saline without Ca2+ and Mg2+ (PBS) 

 MilliQH2O or ddH2O 

 

Fixation: 4% PFA 

 

Procedure:  

   

1. Grow adherent cells on pre-cleaned 12 x 0.5mm or 13 x 0.5mm  CaF2 window in a 6x well 

plate at a cell density between 0.1 – 0.2 x106 cells per well and allow to  attach overnight. 

Tip: If fibronectin, collagen or other cell attachment mediums are required for specific cell lines, 

CaF2 can be pre-coated prior to cell attachment as per standard sub-culturing protocols. 

 

2. After cell attachment and appropriate experiment treatments, aspirate culture medium and 

wash in 5 mL PBS.  

 

3. Fix tissue in 1mL 4% PFA for 10 mins at RT. 

 

4. Aspirate PFA and wash once in PBS and twice in milliQH2O or ddH2O for 5 mins each on a 

orbital shaker at RT. 

 

5. Aspirate the H2O and air dry under laminar flow in a biological safety cabinet or fume hood 

until completely dry. 

 

6. Store dried windows in a dessicator until use. 
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SOP 042.4 Sample Preparation of Cultured Cells Grown in Suspension   

 

Solutions and Reagents: 

 4% paraformaldehyde (PFA) 

 Phosphate buffered saline without Ca2+ and Mg2+ (PBS) 

 MilliQH2O or ddH2O 

 

Fixation: 4% PFA 

 

Procedure:  

   

1. After appropriate experiment treatments, collect suspension cells by centrifugation at 

1200rpm for 5 min and transfer to 1.5mL eppendorf after resuspension in 1ml PBS. 

 

2. Centrifuge cells at 700g for 5 mins on a benchtop centrifuge and resuspend in 200-300µL 4% 

PFA for 10 mins at RT. 

 

3. Remove PFA by centrifugation and wash once in PBS and twice in milliQH2O or ddH2O. 

 

4. Remove H2O by centrifugation and resuspend cell in milliQH2O or ddH2O at the required 

density ~2x106 cell/mL (Perform a cell count if needed). 

 

5. Drop 10-20µL of cell suspension in the centre of a pre-cleaned CaF2 window to give a final 

cell total of 2.0-4.0x105 cells. 

 

6. Air dry windows under laminar flow in a biological safety cabinet or fume hood until 

completely dry. 

 

7. Store dried windows in a dessicator until use. 

 

SOP 042.5 Cleaning CaF2  Windows 

 

Solutions and Reagents: 

 MilliQH2O or ddH2O 

 2% soap (e.g morning fresh or hand soap from dispenser) 

 100% ethanol 

 

Tip: CaF2 windows are expensive and delicate and need to be washed carefully for reuse. Always 

handle with a flat end forceps as they are prone to chipping or splitting. 

 

Procedure:  

   

1. Dip window into dh2O to remove previous sample or leave immersed overnight. 

 

2. Wash in 2% soap (e.g Morning fresh or hand soap from dispenser) for 2-5 min. 

 

3. Wash in fresh milliQH2O or ddH20 for 2-5 min. 
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4. Wash in 100% ethanol for 2-5 min. 

 

5. Air dry in fume hood or Biological safety cabinet on kimwipe tissue paper in a 12-well or 6-

well plate. 

 

6. Store long-term in a dessicator or parafilm and store in dry, temperature controlled location. 

 

 

 

 

 

Troubleshooting 

 

 

Cause Problem 

Don’t wash the cells first in PBS May cause osmotic shock and the cells can 

rupture 

Don’t finish with two washes in H2O Salt crystal will form when drying and will 

contaminate spectra 

Don’t dry out the samples completely before 

acquiring the data 

Water may be trapped in the sample and will 

contaminate the spectra 

Tissue sections are greater than 10µm Increased noise ratio and decreased spatial 

resolution will occur with heavily contaminated 

peaks in the spectra 

 

  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 158 

 

 
 
 
 
 
 
 

STANDARD OPERATING PROCEDURE 
 

 
Title:  Collection of FTIR spectral data using Australian 

Synchrotron Beamline 

Document ID: 043 

Author: Nadia Mazarakis Date:  21 February 2015 

Effective date: 21 February 2015 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue (21 February 2015 ) 

  

 

  



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 159 

 

SOP 43: Collection of FTIR Spectral Data using Australian Synchrotron 

Beamline 
 

 

Description: This method is for the collection of FTIR spectra for biological samples such as cells 

and tissue mapping at the Australian synchrotron.  

 

 SOP 043.1 FTIR for Cells (video without 3D mode) 

 
1. Open OPUS (7.0 version)  password = OPUS. 

 

2. Select the ‘movie reel’ icon  Change the file under the correct name and location  In the 

first tab to start select ‘Video without 3D mode’. 

a. N.B Names must be changed in the first two tabs 

b. N.B If there is a yellow band present, select ‘SAVE’  

 

3. In VIS mode, check the condenser. 

 

4. Right click in the live image and change the setting to create a mark  right click the mark  

change aperture  in edge knife blades change the aperture to 5 x 5  position. 

a. N.B if the aperture (red box) is not aligned with the blades manually have to 

realign the aperture in the microscope (please talk to someone who knows what to do 

here). 

 

5. In IR mode check signal by selecting the ‘movie reel’ icon and the last tab will be signal 

a. A good signal is around 12,000. 

  

6. Switch back to VIS mode re-open aperture. 

 

7. Create an overview (mosaic) over your area of interest  click the overview icon, and select 

‘add region’ at one corner of the area of interest, and once focused select ‘add region’ at the 

other end of the area of interest  select ‘overview’. 

  

8. Define background  find a nice clear area where no cells are present  right click in the 

live image  defining positions  define background position. 

a. N.B that the background here is just the little green circle within the green square. 

 

9. Right click the live image again select mark positions  select your cells (~120 cells) 

a. N.B Be sure to have the aperture in the centre of the cells for the best results. 

 

10. Switch back into IR mode  select START. 

  

11. Once your sample is complete  Unload all your files to save them.  
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SOP 043.2 FTIR for Tissue Mapping (video with 3D mode) 

 
1. Open OPUS (7.0 version)  password = OPUS. 

 

2. Select the movie reel icon  change the image in the appropriate file  first select ‘video 

without 3D mode’ 

a. N.B: If yellow at the top  be sure to click ‘SAVE’ otherwise the normal process 

will not automatically save the image. 

 

3. In ‘Video without 3D’ mode  check the condenser and signal (same as cells, refer to 

031.2.1). 

a. Mark a few spectra (5x5 aperture, background check every 7 apertures) and test run- 

just like the cells protocol. 

 

4. If the spectra look good  unload samples  click on the ‘movie reel’ icon  change to 

‘Start in video mode’. 

  

5. Take a quick snapshot. 

 

6. Run an overview of the area of interest and export the file.  

a. Enlarge the overview screen first  right click  file export image. 

 

7. Move to an area for a background check rick click in the live image  define positions  

define background. 

 

8. Right click in the live image  create rectangular grid in your overview image. 

a. Right click in the live image  measurements- define rectangular grid. 

b. Carefully select the area of interest e.g. 25 x 25 (125 x 125 microns) takes ~ 2hrs 

20mins. 

c. Change the x and y directions to be 25 x 25, and manually change the x and y 

aperture to 5 x 5. 

 

9. Enlarge the overview image with the grid  right click and export the file  save as jpeg. 

 

10. Right click live image  move mouse  select an area near the grid  click on an aperture 

and check its 5 x 5 and select ‘set to all’. 

  

11. Right click and check your background  move to background position. 

 

12. Switch to IR mode  and RUN your sample. 

 

13. Once your map is complete  exit the video screen/ measurement window (top right corner) 

this will save the map automatically  DO NOT CLOSE OPUS ENTIRELY. 
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Troubleshooting for cells and tissue mapping 

 

Cause Problem 

No picture on VIS (black screen) Check illumination, it may have gone back to 

0%, therefore increase to ~3% 

If aperture tilts when opening 

 

 Try a larger aperture (50 x 50), see if fits 

 Then go smaller (10 x 10) 

 Then finally back to 5 x 5  

If aperture not aligned (red box not matching 

black) 

 

 Open microscope at top (under eye piece) and 

realign 

 Be sure to check with someone who knows 

what to do  

Check signal if amplitude is not strong 

enough (i.e. less than 7000) 

Use Aglis and adjust (up and down) until the 

signal is stronger 

  Right click  select controller  connect 

 N.B left column is X axis, and right column is 

the Y axis 

 (To click on the X and Y controls for either 

up and down, select the middle sized ones) 

 

If signal still not high enough (~12000) 

 Use the two knobs on the left side of the 

microscope (again, one represents the X axis 

and the other the Y axis) 

  Then go back to Algis and see if the signal 

will go any higher 

Signal check  

 

Must be on ‘background position’ + closed 

aperture 

To check background    Right click  

  Starting measurement 

  Set parameter 

  7 (therefore every 7 points, background, 

check  is done) 

 

If you are completely desperate: shut down 

the computer 

 

Turn the computer back on (from computer says 

no) select to use ‘windows XP’ 

o Go to WIN-commander 

 ‘connect’ 

 misc. ‘software reset’  yes 

 joy-stick on 

 close 

o Go to OPUS 

 Motor stage control (the X, Y stage control) 

and calibrate (wait for it to do its thing)  

click okay 

 Continue as normal 
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SOP 044: Fourier Transform Infrared (FTIR) Analysis using OPUS and 

Unscrambler® 
 

Description: This method is used for the analysis of raw data collected from the Synchrotron IRM 

beamline for the calculation of the average spectrum from an experimental sample group, as well as the 

band ratios that may be used in the interpretation of data collected following treatment.  

 

Software:  

 

 OPUS 7.2.139.1294 

 

Tip: All raw spectra collected at the Synchrotron IRM beamline for biological samples should follow 

a similar absorbance pattern (see below). This includes a lipid region (between ~3000-1800cm-1), and 

two distinct peaks at ~1700cm-1 and ~1560cm-1 for the amide I and amide II bands, respectively. The 

region between the lipid region and the amide region should be relatively free of any peaks. The 

fingerprint region (between 1800-1000cm-1) should also be observed to have a series of peaks that 

correspond to carbohydrates, DNA, RNA etc. If a raw spectrum fails to follow this pattern significantly, 

it should be excluded from further analysis.      

 

 

 
 

Figure 1. Representative FTIR absorbance spectrum of K562 cells in the spectral region of 3600-

1000cm-1 obtained at the Australian Synchrotron (i). The corresponding second order derivative 

calculated in order to emphasise small differences in spectral regions (ii). The assignment and 

interpretation of the major bands labelled in the average and second derivative spectrum according to 

the literature (iii).    
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SOP 044.1 Analysis of Spectral Data for the Calculation of Averages and Band Ratios 

using OPUS Software 

SOP 044.1.1 Data Upload  

 
Procedure:  
 

1. Go to: https://vbl.synchrotron.org.au/index.php  

a. username (baker email) 

b. password 

 

2. Select: Storage gateway – data archives  

 

3. Beamline access 

a. Infra Red Microscope (IR1) 

b. RAIDAR (Remotely Accessible Infrared Data Analysis Resource)  

i. Book a remote analysis session 

ii. Start remote session  

 

4. Data upload: accept the terms and conditions and upload data to RAIDER 

 

5. Open OPUS 7.2.139.1294  

a. OPUS Login  

i. User ID: Administrator  

ii. Password: OPUS *must be capital letters 

 

6. Load raw data  

a. File – Load file  

b. In Load Spectrum window:  

i. Select and highlight raw data for analysis *load all spectra from sample 

group i.e untreated  

ii. Click Open  

 

7. In the OPUS Browser:  

a. Highlight (*indicated by a red outline) all boxes corresponding to the AB spectra  

i.    Left click AB box of first spectra – Hold Shift key – Left click AB box of 

last spectra 

ii.  All AB boxes should then have a red outline before proceeding   

SOP 044.1.2 Data Processing and Normalisation (for the calculation of averages and 

band ratios)  

 
Procedure:  
 

1. Cut spectrum (between 3200-900cm-1) 

a. Manipulate – Cut 

b. In Cut window, select Frequency Range tab: 

i. X start-point: 3200 (3000) 

ii. X-Endpoint: 900 (1000) 

iii. Click Cut 
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2. Remove bad spectra or anomalies 

a. Click title (light grey) – unload files 

 

3. Vector normalisation 

a. Manipulate – Normalization 

b. In Normalization window: 

i. Method: Vector Normalization  

ii. Click Normalize 

 

4. Baseline correction  

a. Manipulate – Baseline Correction  

b. In Baseline Correction window, select Select Method tab: 

i. Select Concave rubberband correction (used for biological samples) 

ii. Number of iterations: 5 

iii. Number of baseline points: 16 

iv. Click Correct 

 

SOP 044.1.3 Spectral Ratio Calculation  

 
Procedure:  

 

1. Evaluate – Integration  

a. For first-time, select Setup Method  

i. Select Method A 

ii. Create Integration areas depending on ratio required  

i.e Amide I = 1700-1600cm-1 

Amide II = 1570-1500cm-1 

iii. Store Method  

iv. Click Save  

b. For subsequent times, select Load Integration Method  

i. Select the saved integration method required  

ii. Click Open  

iii. Click Intergrate  

c. To record results, in the OPUS Browser: 

i.  Highlight (*as indicated by a red outline) all boxes corresponding to INTEG  

ii. Right Click – Show Report  

iii. Record Result values in Excel for each processed spectrum   

iv. Following data collection, calculate ratios using Excel 

For example: 

Amide I 11.547 

Amide II 5.498 

Amide I/Amide II 

ratio 

11.547/5.489 = 

2.104 
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SOP 044.1.4 Average Spectrum Calculation  
 

Procedure:  
 

1. Click Average icon in the toolbar:  

a. In Averaging window: 

i. Select by symbol 

ii. Weighting with no of scans  

iii. Click Average 

iv. Save Average in a separate folder to raw data  

**make sure you do not override raw data with processed data from this analysis. Either save 

separately, or discard changes.  

 

*** To transfer data to GraphPad Prism – transfer averages to the scratch folder – copy to excel 

online and download a copy to your computer. 

 

SOP 044.2: Principal Component Analysis (PCA) of Spectral Data using The 

Unscrambler X 

 

Description: This method is used for the analysis of raw data collected from the Synchrotron IRM 

beamline for principal component analysis that may be used in the comparative analysis of 

experimental groups i.e untreated vs. treated.     

 

Software:  

 

 OPUS 7.2.139.1294 

 Remotely Accessible Infrared Data Analysis Resource (RAIDAR; required if offsite from 

Synchrotron)  

 The Unscrambler X 

 

Tip: Understanding PCA as a method for explaining the variance observed in the spectra collected 

from each sample group is important before conducting the analysis. Furthermore, it is important to 

interpret the loadings plot also calculated in this method to evaluate and confirm the overall variance 

observed in the PCA plot.    

 

SOP 044.2.1 Data Upload  
 

Procedure:  

 

1. Open OPUS 7.2.139.1294  

a. OPUS Login  

i. User ID: Administrator  

ii. Password: OPUS *must be capital letters 

 

2. Load raw data  

a. File – Load file  
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b. In Load Spectrum window:  

i. Select and highlight raw data for analysis *load all spectra from sample 

group i.e untreated  

ii. Click Open  

 

3. In the OPUS Browser:  

a. Highlight (*indicated by a red outline) all boxes corresponding to the AB spectra  

i.    Left click AB box of first spectra – Hold Shift key – Left click AB box of 

last spectra 

ii.  All AB boxes should then have a red outline before proceeding   

SOP 044.2.2 Data Processing (for PCA) – Statistical Testing for Biological Samples 
 

Procedure:  

 

1. Baseline correction 

a. Manipulate – Baseline Correction  

b. In Baseline Correction window, select Select Method tab: 

i. Select Rubberband Correction  

ii. Number of baseline points: 16 

iii. Save all corrected data in separate folder to raw data  

 

2. Create a reference spectrum (with corrected spectra from untreated/control sample group)  

a. Click Average icon in the toolbar:  

b. In Averaging window: 

i. Select by symbol 

ii. Weighting with no of scans  

iii. Click Average 

iv. Save Average in a separate folder to raw data/corrected data  

 

SOP 044.2.3 RAIDAR Access and Data Upload   
 

Procedure:  

 

1. To access RAIDAR:  

a. https://vbl.synchrotron.org.au 

b. Login to synchrotron account *created following synchrotron induction  

c. Beamline Access – Infra Red Microscope (IR1) – RAIDAR (Remotely Accessible 

Infrared Data Analysis Resource)  

d. Book a remote analysis session  

 

2. Upload all processed data (including reference spectrum) from experiment using the 

instructions in the Data upload section of RAIDAR index 

 

3. Click Start remote session; and agree to the terms of use 

a. Data will be located in Scratch (\\vboxsvr) (Y:) 

b. Organise data so that spectra from each sample group is in a separate folder 

https://vbl.synchrotron.org.au/
file://///vboxsvr


 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 168 

 

SOP 044.2.4 PCA using The Unscrambler X 
 

Procedure:  

 

1. Open The Unscrambler X 

a. The Unscrambler X Login: 

i. User Name: iruser1 (if it doesn’t work, use iruser2)  

ii. Password: iruser1 (if it doesn’t work, use iruser2) 

 

2. Load corrected data 

a. File – Import Data - OPUS  

i. Import all data by Browsing for Scratch folder  

ii. Import Reference spectrum in separate data matrix (create column set: 3260-

980 (see below)) 

iii. Click Sample naming... – Include File Name  

iv. Click OK 

Tip: If the data is not loading (usually with CytoSpec data as there is no loading method available), 

manually drag the files from the scratch folder into the left browser window of Unscrambler. 

Furthermore if the sample name is not included in the yellow box of the matrix, manually enter the 

label name into yellow box so different spectra can be identified later in the large matrix that contains 

all the samples.   
 

 

3. Create Matrix 

a. Tools – Matrix calculator 

i. Tick experimental groups (but not the reference spectrum) 

ii. Shaping – append. 

 

4. Create Row and Column sets  

a. Create row sets corresponding to sample groups i.e untreated and treated  

i. Highlight rows by:  Left click row of first spectra – Hold Shift key – Left 

click row  of  last spectra   

ii. Right click – Create row set  

 

b. Create column sets by highlighting required columns (similar to rows) –  Right click 

– Create column set 

Make column sets as follows: 

i. 3620-980 (for pre-processing; IMPORTANT; also make column set for 

reference spectrum)  

ii. 3020-2780-1820-980 (for regions of interest; to create this column set: 

highlight 3020-2780 – hold control key – then shift-control to highlight 

1820-980) 

 

5. To create line plots of data:  

a. Right click the required data matrix in left side window – Plot – Line  

b. In Line Plot – Scope window:  

i. Rows = All; Cols = All  

ii. Plot type = Sample  
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iii. Click Ok 

 

6. EMSC correction  

a. Tasks – Transform – MSC/EMSC  

b. In Multiplicative Scatter Correction window, select Scope tab:  

i. Matrix with all corrected data should be highlighted 

ii. Rows = All; Cols = 3260-980  

c. In Multiplicative Scatter Correction window, select Options tab:  

i.   Function: Full MSC  

ii. Select Extended options  

d. In Multiplicative Scatter Correction window, select Spectral Info Tab:  

i. Enable reference spectrum  

ii. Select  reference spectrum matrix; Rows = All, Cols = 3260-980 

e. Click OK 

 

7. Second derivative (17 smoothing points) (from EMSC matrix) 

a. Tasks – Transform – Derivative – Savitzky-Golay  

b. In Savitzky-Golay Derivative window: 

i. Select EMSC corrected data matrix  

ii. Rows = All; Cols = 3260-980 

iii. Derivative order: 2nd Derivative; Polynomial order = 2 

iv. Number of left side points = 8; Number of right side points = 8 

v. Select Symmetric kernel  

vi. Click OK  

 

8. Vector Normalisation (from 17 smoothing points total) 

a. Tasks – Transform – Normalize  

b. In Normalize window:  

i. Select EMSC, 2nd derivative data matrix 

ii. Rows = All; Cols = 3020-2780-1820-980 

iii. Select Unit vector normalization  

iv. Click OK  

 

9. PCA analysis  

a. Tasks – Analyze – Principal Component Analysis  

b. In Principal Component Analysis window: 

i. Select EMSC, 2nd derivative, vector normalised data matrix  

ii. Rows = All; Cols = 3020-2780-1820-980 

iii. Maximum components = 14 

iv. Confirm NIPALS algorithm and cross-validation are selected    

 

10. PCA plots 

a. Explained variance – red line should be close to the standard blue 

b. Influence plot: 

i. Right click the influence plot > mark > one by one > select outliers  

ii. Right click ‘PCA’ in the left window >  recalculate >  without marked > 

samples > OK 
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N.B. the maximum components at this stage may decrease from 14 

components, this is fine. 

c. Loadings plot: 

i. Right click the loadings plot > PCA > loadings > line (ensure that the PC 

with the highest % variance is selected, usually PC1) 

d. Scores plot: 

i. Right click the scores plot > sample grouping >  select data set > within the 

available row sets select the groups of interest > move into Marker Settings -

make changes if necessary (e.g. colour, symbol etc) 

 

11. Export results of PCA plot into an Excel Online spreadsheet: 

a. In the left window expand the Results tab and copy the matrices- including header of 

i. X Loadings 

ii. Scores 

 

12. Repeat these lasts steps with additional fingerprint regions 

a. Go back to the processed data matrix in the left window: 

b. Create more column sets by highlighting required columns (similar to rows) >  Right 

click > Create column set 

i. 1800-1000 (fingerprint region) 

ii. 1800-1350 (fingerprint region – less noise)  

iii. 1280-1040 (phosphate region – DNA, RNA)  

iv. 3000-2800 (lipid region)  

 

13. Repeat PCA analysis for new column sets to identify the fingerprint region(s) with the 

greatest impact on the data.  

 

14. Load the average spectrum into Unscrambler and extract the matrix into the excel 

spreadsheet. 

 

15. Transform this average spectrum for the 2nd derivative  

a. Tasks > Transform > Derivative > Savitzky-Golay  

b. In Savitzky-Golay Derivative window: 

i. Select average spectrum matrix 

ii. Rows = All; Cols = 3620-980 

iii. Derivative order: 2nd Derivative; Polynomial order = 2 

iv. Number of left side points = 8; Number of right side points = 8 

v. Select Symmetric kernel  

vi. Click OK  

vii. And copy the matrix into excel 

 

16. In GraphPad four main graphs need to be produced from the data just collected using the XY 

graph >  enter/import data  >  y: enter and plot a single Y value for each point: 

a. Average spectrum 

i. X column corresponds with the wavenumber values, the group columns 

correspond to the different sample groups 

b. 2nd derivative  
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i. X column corresponds with wavenumber values, the group columns 

correspond to the different sample groups 

c. Loadings 

i. X column corresponds with wavenumber values, and group A is the PC-1 

values 

d. PCA plot (scores) 

i. X column corresponds with wavenumber, group A is PC-1, the remaining 

groups make up the samples with the PC-2 values.  
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SOP 045: Hierarchical Cluster Analysis (HCA) using CytoSpec™ 
 
SOP 045.1: Hierarchical cluster analysis (HCA) using CytoSpec™ 
 

Description: Hierarchical Cluster Analysis (HCA) using CytoSpec™ is a specific analysis technique 

derived for FTIR tissue mapping. The aim of this analysis is the separate the tissue mapping into clusters 

of the same cell/tissue type, providing a 2nd derivative of the FTIR spectra. 

 

Software: 

 CytoSpec v. 2.00.02 

 
Procedure: 

1. Clear the previously processed data:  

a. File > Clear > “Clear all?” and “Yes” 

2. Load a map data (e.g., OPUS from Bruker):  

a. File > import binary > Bruker OPUS (*.0) > select the target file > open > tick 

“absorbance” and select load > data loaded successfully? Okay 

3. Visualize the map:  

a. Chem. image (an icon under the main window) > choose “Method A” and “Original” 

> plot > cancel (to return to the main window) 

b. If double click on this map (top right corner) the spectrum at the point will display 

c. To save the original chem. map (top right corner): Tools > display large maps > upper 

map (original data) >> Tools > Capture to bitmap > and save the original chem. map 

4. Cut spectral range to only the informative spectral region:  

a. Spectral Preprocessing > cut > cut spectra (spectral dimension) and “region to keep” 

(i.e. 1000 – 3600 cm-1) > cut 

b. Chem. image (an icon under the main window) > choose “method A” and “original” 

> plot > cancel (to return to the main window) – you should see narrower region 

(1000 – 3600 cm-1) now in the bottom right corner 

Tips:  

1) The spectral range is usually at 3600-1000cm-1 when the aperture size is 5µm, anything less 

than 1000cm-1 will not necessarily be ‘true’ peaks.  

2) Always press the ‘enter’ key when putting in digits (e.g. spectral range 1000-3600cm-1), this is 

true in all future steps too, otherwise CytoSpec will not perform the task to your specifications.  

5. Perform quality tests on the data map: 

a. Spectral Preprocessing > quality tests  

b. Choose “criterion 3: SNR (signal-to-noise ratio)” > keep the offset value at default > 

SNR: select the best value to reduce noise here (the closer to 100 the better) > test 

c. Chem. image > “method A or B” and “preprocessed” > plot > cancel (to return to the 

main window) this time the preprocessed map will appear in the bottom right corner 

d. To save the preprocessed chem. map (bottom right corner): Tools > display large 

maps > lower map (preprocessed data) >> Tools > Capture to bitmap > and save the 

original chem. Map 

 

Tip: To identify the number of spectra remaining: File Info > Measurement Parameters > number of 

data points. You want to only the highest quality of spectra to extract into Unscrambler for PCA 

analysis. So at this point it is important to check the number of spectra, as Unscrambler works most 
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efficient with approximately 200-300 data points per group. Alternatively you can reduce the number 

of spectra in Unscrambler (e.g. it has a tool to average every specified number of spectra). 

 

6. Reduce the noise level: 

a. Spectral Preprocessing > noise reduction > select “the first 10 PCs” and 

“preprocessed” > correct  

b. Chem. image > “method A or B” and “preprocessed” > plot > cancel (to return to the 

main window) this will replace the last preprocessed map in the bottom right corner 

and save map (same procedure as in 5.d.) 

 

Tip: For samples with less spectra (data measurement points), you can swap steps 5 and 6. Therefore 

improve the quality of the spectra first with the noise reduction step (step 6) and then use the quality 

test to remove the ‘bad’ spectra (step 5). This will minimise loss of spectra.  

 

7. Perform 2nd derivatization: 

a. Spectral Preprocessing > derivatives > “preprocessed”, “derivative order = 2”, 

“smoothing pts = 9” > derive (this value will smooth the spectra, so once you reach 

the final stage of the 2nd derivative and it is still too noisy you may need to come back 

to this step and select a higher smoothing pt value)  

b. Chem. image > “method A or B” and “derivative” > plot > cancel (to return to the 

main window) 

c. Tools > set colour (an icon under the main window) > keep “jet”, “processed data”, 

“interpolation” and “invert” (to invert the minimum points in the derivative spectra) 

> draw > cancel (to return to the main window) and save map (same procedure as 

5.d.) 

 

Tip: Only perform the 2nd derivative if there is no water band, otherwise it will pick up the water band 

in the derivative and calculate it as a band.  

 

8. Perform vector normalization 

a. Spectral Preprocessing > normalize > “vector norm”, “derivatives” and choose the 

whole range for “spectral region” (default) > norm 

b. Chem. image > “method A or B” and “derivative” > plot > cancel (to return to the 

main window) and save map (same procedure as 5.d.) 

 

9. Perform HCA analysis  

a. Multivariate Imaging > HCA imaging > create HCA maps from spectra > select 

number of spectra regions “2” and put in 1050-1800* (top line) and 2810-3040* (2nd 

line) > select “derivatives” > go to HCA  

*these ranges are specific to your sample groups. Please choose the appropriate range for 

your sample.  

b. In Distance matrix calculation, choose “distance method = D-Values*” > click “use 

shortcut” > calc 

*the method works well for HCA of biological samples 

c. In Hierarchical clustering, use the default (Ward’s algorithm) > calc 

d. In Cluster imaging, choose “number of clusters = 5 (this number is dependent on 

how may cell/tissue types there are per tissue sample” > click “image” or 

“dendrogram” (to show spectral similarity by colour or dendrogram, respectively)  
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e. In Cluster imaging: click “image” to display HCA map in the bottom right window.  

f. Save HCA map (same procedure as 5.d.) 

g. In Cluster imaging: click “spectra” > “derivatives” > “display averages” (average 2nd 

derivative spectra of each colour/group of same similarity present in the main 

window) 

h. Save 2nd derivative spectra: File > export spectra > x,y - ASCII 

i. In Cluster imaging: click “spectra” > “derivatives” > “save averages” (this will be 

the average of the different clusters only) 

j. In Cluster imaging: click “spectra” > “derivatives” > “save all spectra” (this will save 

all the original spectra with the associated cluster number to which it belongs to)  

k. Note that, in order to acquire a cursor to locate band positions of the average spectra 

in the main window, switch to “show mode” by Tools > display options > show mode 

 

Additional Notes: 

 

10. Obtain an average spectra from specified spectra selected through the processed map 

a. Tools > display large maps > lower map (processed data)  

b. In Hierarchical cluster map in the new window, choose ROI > define ROI  

c. add ROI point according to ROI # by selecting positions in the processed map  

d. to define more than 3 positions (default), click “add a ROI point”  

e. to remove any ROI #, select the certain ROI (highlighted in yellow) and click “delete 

ROI point” 

f. after all ROI points were specified, click “calc average spec” to acquire an average 

spectrum based on the ROI-selected spectra 

g. save all spectra 

11. If exporting this data to Unscrambler for PCA analysis, it is important to use an OPUS 

Macro to convert the files from ‘.dat’ to ‘,spc’, This will ensure the file names are 

connected to the correct spectra in Unscrambler.  

a. Load all exported files into OPUS > Macro > Run Macro >select 

"DIRTOSPC.MTX" and make sure "Source File Mask" is *.dat (you can convert 

*.asc or *.csv files as well, just change it here), then fill out the "Source Path" 

(where the .dat data is) and "Destination Path" --- then OK. 

 

SOP 045.2: Regions of interest (ROI) method of FTIR mapping analysis using 

CytoSpec™ 

 

Description: This method allows for a selected area of the spectral map to be selected and analysed in 

an accurate manner. It incorporates the selecting multiple ‘regions of interest’ (ROI) as an alternative 

quality test control in the CytoSpec™ software in combination with the SOP045, followed by the 

extraction of spectra to be analysed in OPUS following SOP044.1.2 (Edition 2). 

 

This protocol with detail how to obtain selected spectra from the hypercube map obtain from the 

Australian Synchrotron from the OPUS software, using CytoSpec™ and OPUS to present data as an 

average spectra, 2nd derivative, ratio analysis, statistical analysis and principal component analysis 

(PCA).  
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Software: 

 CytoSpec v. 2.00.02 

 OPUS 7.2.139.1294 

 Remotely Accessible Infrared Data Analysis Resource (RAIDAR; required if offsite from 

Synchrotron)  

 The Unscrambler X 

 

Procedure: 

 

1. In CytoSpec™ clear previous data: 

a. File > Clear > “Clear all?” and “Yes”. 

 

2. Load a map data (e.g. OPUS from Bruker): 

a. File > import binary > Bruker OPUS (*.0) > select the target file > open > tick 

“absorbance” and select load > data loaded successfully? Okay. 

 

3. To visualise the map: 

a. Chem. Image (an icon under the main window) > choose “Method A” and “Original” 

> plot > cancel (to return to the main window). 

b. If double click on this map (top right corner) the spectrum at the point will display. 

c. To save the original chem. map (top right corner): Tool > display large maps > upper 

map (original data) > Tools > capture to bitmap > and save the original chem. map. 

 

4. Cut the spectral range to only the informative spectral region: 

a. Spectral Preprocessing > cut > cut spectra (spectral dimension) and “region to keep” 

(i.e. 930-3600cm-1) > cut. 

b. Chem. image (an icon under the main window) > choose “method A” and “original” 

> plot > cancel (to return to the main window) – you should see narrower region 

(930-3600cm-1) not in the bottom right corner.  

 

5. To select spectra from only a selected area of the map: 

a. Right click on the original chem. map (top right corner) > display large map and a 

new window will appear (chemical map) 

b. ROI > define ROI a new window will appear. Select ROI # 1, and select “add a ROI 

point”, in the 1st ROI point click on the top left corner of the chemical map, 2: click 

the top right corner of the map, 3: click on the bottom right corner of the map and 4: 

click the bottom left corner of the map > “display roi” 

c. The large chem. map will now display all spectra within this range. Save this image > 

Tools > capture to bitmap > and save the ROI#1 original chem. map. 

d. Define the next ROI region (#2). Add as many ROI points as needed (note that 

maximum roi points is 20), refer to the original grid overview map (saved previously 

from the synchrotron data collection protocol) and any H&E images to help identify 

the region of the map wanted for analysis. 

 

 

Tips:   

1) Only 3 ROI points can be used at a time, so this process may need to be repeated from the 

start until an accurate collection of ROIs cover the whole region of interest of the map. Use 
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the original map with ROI #1 as a guide to not overlap any points, saving each ROI as a 

bitmap each step of the way.  

2) Do not close the large display map window, otherwise all ROIs will automatically be deleted. 

 

6. To obtain the spectra from each ROI: 

a. ROI > apply pre-proc data > ROI # 2 

b. Return to the main window (WITHOUT CLOSING THE LARGE DISPLAY MAP 

WINDOW) 

 

7. Perform HCA analysis: 

a. Multivariate Imaging > HCA imaging > create HCA maps from spectra > select 

number of spectra regions “2” and put in 1050-1800 (top line) and 2810-3040 (2nd 

line) > select “pre-processed” > go to HCA. 

b. In Distance matrix calculation, choose “distance method = D-values*” > click “use 

shortcut” > calc. 

c. In Hierarchical clustering, use the default (Ward’s algorithm) > calc. 

d. In Cluster imaging, choose “number of clusters = 2” (this is just a default number for 

obtain the original spectra) 

e. In Cluster imaging, click “image” to display the HCA map in the bottom right hand 

window. 

f. In Cluster imaging click “spectra” > “original” > save all spectra (this will save the 

original spectra from the ROI without any modification, this is the data that will be 

analysed in OPUS software) 

g. Save the HCA map 

 

8. Repeat if needed for ROI#3 or the whole process until all spectra from this one map’s area of 

interest are saved.  

 

9. In OPUS conduct data processing and normalisation:  

Select all spectra in the OPUS browser window by selecting the ‘AB’ icon under each 

individual spectra; 

a. Cut spectrum (between 3600-930cm-1) 

i. Manipulate –cut 

ii. In Cut window, select Frequency Range tab: 

 X start-point: 3600 

 X end-point: 930 

 Click > cut 

b. Vector normalization 

i. Manipulate- normalization 

ii. In normalization window: 

 Method: vector normalization 

 Click > normalize 

c. Baseline correction 

i. Manipulate – baseline correction 

ii. In Baseline Correction window, select Select Method tab: 

 Select Concave rubberband correction (used for biological samples) 

 Number of iterations: 5 
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 Number of baseline points: 16 

 Click > correct 

d. Remove bad spectra or anomalies 

i. In the display window, right click any bad spectra > remove from display 

ii. Then proceed to find the bad spectra that you removed from display in the 

OPUS browser window, their AB icon will appear ‘unselected grey’ > right 

click each individual bad spectra title  > unload file until all bad spectra are 

removed 

e. Average the spectra 

i. Select all spectra > select the average icon  

ii. In the Average window 

 Select by symbol 

 Weighing with no. of scans 

 Click average 

f. 2nd derivative  

i. Once the average is complete click on the AB icon, manipulate > derivative 

ii. In the derivative tab Order of derivative >  2, smoothing points > 17 > click 

process 

g. Create peaks for the average and average 2nd derivatives 

i. In the display window right click screen > single peak pick, and select each 

peak in the average and repeat for the 2nd derivative 

ii. In the OPUS browser window, right click the peaks icon > show peak list > 

save peak list in an excel spreadsheet 

h. Save the average and 2nd derivative file with peaks in a new file name. 

 

10. Ratio analysis in OPUS: 

a. Import the spectra of interest into OPUS, and repeat step SOP 045.2.9 

b. Once bad spectra* has been removed and data is manipulated, highlight all data (via 

the AB icon) > evaluate > integration 

 

Tip: it is important to record in separate document what your bad spectra are, so this step is repeated 

in the same manner as the average step. 

 

c. In the integration method for the first time > setup method > select method A > 

manually load in the range left to right of the bands that you want to integrate > store 

method 

d. Back in the integration window > load method > select the integration bands you just 

stored that you want to integrate (e.g. Amide I/Amide II) > integrate 

e. A new icon below the spectra title will appear next to the AB icon in the OPUS 

browser, INTEG, select all the INTEG icons > right click one of these icons > show 

report. For each spectra there will be a new report display tab. 

f. Choose the amount of spectra you want to analyse, e.g. 50 spectra. And in each report 

display > right click the integration results > copy to clipboard > and paste in an excel 

spreadsheet. Repeat this until all spectra (e.g. 50 spectra) are recorded in an excel 

spreadsheet. 
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g. Repeat this method until ALL ratios of interest has been loaded > integrated > 

recorded. (Ensure all spectra are re-selected for integration method via the AB icon, 

NOT the INTEG icon) 

h. Once all integrations methods are collected in excel, intra- and inter-analysis and 

statistical analysis can be conducted.  

 

11. Principle Components Analysis (PCA) in RAIDAR; 

a. Follow SOP 044.2. (version 3) 
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SOP 046: Tissue Mapping using the Offline Focal Plane Array 

(FPA) at Australian Synchrotron 

 

SOP 046.1: Tissue mapping using the Offline Focal Plane Array (FPA) at Australian 

Synchrotron 

 

Description: The focal plane array system installed (offline) at the infrared beamline (Hyperion 3000 

Focal Plane Array (FPA)) FTIR should be used to collect a large area overview infrared images to 

inform high resolution (~5µm) FTIR mapping using the beamline (much smaller maps). 

 

Procedure:  

 

Prior to imaging 

 

1. Before beginning, fist check to make sure the microscope and detector are cooled down to 85.4k 

with liquid nitrogen.   

 

2. Using a funnel and the appropriate PPE, add liquid nitrogen to the detector (right hand side) 

and microscope (left hand side).  Fill until bubbles form below the funnel and wait 20 minutes.   

 

3. Top-up both sides with liquid nitrogen (to allow for boil off) and wait a further 10 minutes. 

 

Tips:  

1). It usually takes two full canisters of liquid nitrogen to adequately fill both sides. Must be patient. 

2). Left hand side should be filled every 8-12 hours and right hand side (detector) every 4 hours. 

3). If too warm the signal will deteriorate and this will become evident when checking the “blue signal 

box” before collecting background.  If this happens, top-up liquid nitrogen until the signal returns to 

the appropriate position and the temperature is at 84.5k. 

 

4. Before opening Opus, calibrate the stage using appropriate software (Refer to FPA users 

manual). Set-up stage and activate joystick (twist top of joystick to focus and up/down/left/right 

is intuitive). 

 

5. Open Opus software and click “waving man with film roll icon” – “start video wizard”; ensure 

you are in “Videobased FPA measurement Tab”. 

 

6. Place sample on the stage (<10 µm prepared appropriately on CaF2 window). 

 

FPA Imaging 

 

1. At the microscope, press “eye symbol” in the humidity chamber– it will flash and then stop 

flashing and an image of the tissue will appear on the monitor – focus the z-direction with the 

joystick at this point.  

 

2. At the computer – Select Device “Hyperion 3000-FPA” press Next and ensure you are in 

“Transmission mode”. 

 



 

Epigenomic Medicine Methodologies | Volume 3 Edition 1 182 

 

3. At microscope: 

a. Move CaF2 window to area where there is no tissue – focus.  

b. Check condenser by closing condenser all the way.  

c. Fine focus using “hard silver knobs” – very sensitive.  

d. Align condenser - circle to fit perfectly in centre (very tricky fine knobs) – 50, 50, -50, 

-50. 

e. Once focused and in centre open the condenser. 

 

4. At the computer – “Collect visual images” – select “Single Image” – Select “Image of larger 

area”  

a. If there are any borderpoints – click “Clear all border points”. 

 

5. Using the joystick, go to the edge of the tissue (e.g. West side) and select “Add new border 

point”. 

a. All tissue must be inside the “black hole” to allow illumination and make sure the CaF2 

window does not touch the “Captain” tape – if any problems – select “Clear all border 

points”, arrange CaF2 window and start again. 

 

Tip: Need all four borderpoints for the desired area of tissue to image – West, North, East, South; 

appropriate number of tiles to incorporate area of interest. 

 

6. Using the joystick go to the centre of the tissue (but not a lumen or chamber) and focus in the 

z-direction. 

 

7. At the computer – select “Collect defined image” (usually takes about 10 minutes). 

 

8. Once overview image is acquired, you may drag it to make it larger and Save by right hand 

clicking and exporting as JPEG in appropriate folder; decrease photo to normal size. 

 

9. At the computer – Select “Next” – Select “Measure background once” – “Next” – Select “User 

defined background position” – “Next” – define background position window. 

 

10. Using joystick go to clear area – e.g. lumen or chamber or near area where you will image – 

ensure there is NO artifact or blemish – must be as clear as possible. 

 

11. At computer – Select “Set background position” – Select “Measure background” – Select “OK” 

(usually takes 2-3 minutes to record measurement). 

 

12. At the computer – Check “blue signal box” – if required to get signal in appropriate light blue 

range, right hand click and Select “Customize Focal Plane Array Settings” – Select “Experts 

only” (adjust by very small increments 2-3 units up or down until level of signal is in perfect 

range) and Select “OK”. 

 

Tip: If signal is very weak, check temperature and cool down with liquid nitrogen as described above 

(patiently) until signal returns to normal and temperature is 85.4k. If you make a mistake press “Cancel” 

and start again. 
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13. At the computer – Select “Measurement positions” by clicking on “purple box (with four small 

boxes and no cross)”; set the appropriate size of imaging box by manually typing numbers (e.g. 

8x8; 2x2 etc...).  Purple box turns Green and can click to move imaging box to the position of 

interest. 

 

Tip: Set-up the area for imaging by clicking and dragging box; alter to make it either perfect square or 

rectangle / portrait or landscape BUT be consistent within each individual experiment; e.g. if control is 

4x4 then treatments should also be 4x4. 

 

14. When happy with area for imaging select “Next” – Enter the “Sample Name” and “File Name” 

appropriately and carefully select the “Path” to save in correct folder – usually “Offline data 

area” – “Relevant Study folder” – “Experiment folder”. 

a. Make sure “SCAN” is set at appropriate level – manually type 32, 64, 128; 64 Scans is 

usually appropriate. 

 

15. Select “Measure Sample” and select “OK” 

 

Tip: Typical times =  2 x 2 map ~15-20 minutes, 

4 x 4 map ~45-60 minutes, 

6 x 8 map ~ 2-2.5 hours,  

8 x 8 map ~2.5-3 hours,  

8 x 12 map ~3.5-4 hours. 

 

16. Once finished press “Repeat” then right-hand click name of sample and select “Unload file” – 

“Unload”. 

a. Critical step or else will not save data or you will end up with a corrupt file. 

 

SOP 046.2: Focal Plane Array (FPA) analysis using OPUS software 

 

Software: 

 OPUS 7.2.139.1294 

 

Procedure: 

1. Open OPUS: 

a. User ID: administrator 

b. Password: OPUS 

c. Assigned workspaces: C:\OPUS_7.2.139.1294\MIR_FullAccess.ows 

d. Login 

 

2. Upload data into OPUS: 

a. Drag the files into the left window ‘OPUS Browser’ 

b. Double click on the ‘AB’ icon of the newly added file 

c. A new file ‘Chem.Imaging.’ will appear > click on the new ‘AB’ icon – now the FPA 

will be displayed with two upper windows showing the chemical imaging/ selection 

and a third window at the lower third of the screen with the corresponding spectrum. 
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3. In the upper left window, select the Overview tab, and ensure you have selected the correct 

image for analysis. 

a. Return to the ChemI1 screen  

 

4. In the upper right window ‘ChemI2/Selection view’– select the  ‘selection view’ tab: 

a. Select two data points in the FPA grid that represent good spectra (as seen in the 

lower window) and that the data points are in fact on the tissue itself.  

b. These data selection points colour can be changed in the lower ‘Selection/List’ 

window, select the List tab and in the colour column, adjust the colour as required. 

c. If you need to unselect the measurement points simply click the measurement point 

again OR right click the ‘selection view’ FPA grid > delete measurement points. 

 

5. Integration of the FPA data: 

a. In the lower window select the ‘Spectra’ tab: 

i. Hold and drag your cursor over the region of interest (one at a time); 

1.  lipid region (3000-2800) 

2. Amide region (1700-1480) 

ii. Manually adjust the correct number range (to match the exact regions above) 

and press enter 

iii. Right click the newly highlighted area > integration > integrate 

 

6. Once the integration is complete: 

a. Go to the ChemI1 image (upper left window) and right click the image > colour 

scheme > SBF 

b. Ensure in the lower window with the ChemI1 image is selected: 

i. Select trace range to the newly integrated region 

ii. Plot type: 2D contour plot 

iii. Plot mode: colour blending 

c. Adjust the ChemI1 image to correct settings 

i. Right click image in upper left window > display > remove FPA grid, 

background image and annotations. Basically ensure that the colour bar is 

displayed.  

d. Ensure that all your colour bars are scaled the same across the corresponding regions 

of samples: 

i. Right click the scale bar in the ChemI window > set colour contour levels  

e. Export all integrated FPA maps: 

i. Right click the integrated map > export > this plot > save as a JPEG file with 

at least 300dpi 

 

7. Save this OPUS file with a new file name (_integration) so the original remains the same.  
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SOP 047: E13.5 Brain ex-vivo Mouse Model 
 

Description:  
 

Time mated pregnant C57Bl/6 mice were killed by cervical dislocation at 13.5 days after conception 

(E13.5). Uteri were dissected out and placed in ice cold sterile Hanks balanced salt solution (Sigma). 

Embryos at E13.5 were removed from the uteri and amniotic sac. Under a dissecting microscope, the 

skull of the embryos was opened up, and the brain was scooped out. After dissectioning all brains, were 

fixed in 4%PFA, incubated in 30% sucrose and frozen in OCT similar to previous publications [1]. 

  

References:  

1. Azari, H., Sharififar, S., Rahman, M., Ansari, S. and Reynolds, B. (2011). Establishing 

Embryonic Mouse Neural Stem Cell Culture Using the Neurosphere Assay. Journal of 

Visualized Experiments, (47). 

 

SOP 047.1 Ordering Mice through AMREP AS   

 

Refer to SOP 030.1 

 

SOP 047.2 Booking a Procedure Room through AMREP AS   

 

Refer to SOP 030.1 

 

SOP 047.3 E13.5 Mouse Brain Isolation and Culture Conditions 

 

Description:  
Time mated pregnant C57Bl/6 mice were killed by cervical dislocation at 13.5 days after conception 

(E13.5). Uteri were dissected out and placed in ice cold sterile Hanks balanced salt solution (Sigma). 

Embryos at E13.5 were removed from the uteri and amniotic sac. Under a dissecting microscope, the 

skull of the embryos was opened up, and the entire brain removed.  

 

Solutions and Reagents: 

 70% ethanol 

 Hanks balanced salt solution (Sigma; H2784) 

 DMEM supplemented with 1% penicillin/streptomycin 

 Phosphate buffered saline (PBS) without Ca2+ and Mg2+ 

 4% paraformaldehyde (PFA) 

 Optimal cutting temperature (OCT) 

 

Materials:  

 Gas chamber 

 Dissecting scissors 

 Vannas scissors 

 2 x Dumont 5 forceps 

 Fine curved forceps 

 60mm x 15mm organ culture dishes (Falcon BD) 

 Dissecting microscope 
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Fixation: 4% PFA for 1 hour or overnight at 4°C 

Procedure:  

   

1. Using a pre-booked procedure room, first ethanol all surfaces and utensils and cull the 

pregnant C57Bl/6 mice at 13.5 days after conception (E13.5) using a gas chamber.  

 

2. Dissect the uterus containing the embryos in one piece and transfer into a wee jar containing 

ice cold sterile Hanks balanced salt solution (Sigma).  

 

3. Clean the procedure room and return animal house containers. 

 

To be performed in Epigenomic Medicine Laboratory. 

 

4. Ethanol surfaces and dissecting microscope. 

 

5. Using vannas scissors, remove embryos from the uteri and amniotic sac in a bath containing 

Hanks solution.  

 

6. Dissect the head in one clear sweep against the forceps and transfer to a new Petri dish 

containing cold Hank’s solution and place it under a dissecting microscope for the following 

steps.  

 

7. Using fine curved forceps in one hand, hold the heads from the caudal side leaving the dorsal 

side facing upwards.  

 

8. Using vannas scissors in the other hand, first place one horizontal cut above the eyes. Then 

gently make a continued cut perpendicular and starting from a first cut to the back of the 

head. Make sure to only cut the skin and skull and not damage the brain.   

 

9. Using Dumont 5s peel back the skull and scoop out the brain. If the brain still has some skull 

attached to it, use a second pair of Dumont 5s to clean the brain.  

 

10. Wash brains with PBS once for 5 mins. 

 

11. Fix in 4% PFA for 1 hour at RT or overnight at 4°C. 

 

12. Wash 3 times in PBS for 5 mins. 

 

13. Incubate in 30% sucrose for 20-30mins or until the brains sink in the bottom. 

 

14. Orient and embed in OCT – freeze on dry ice and store in -80°C freezer until use. 
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SOP 048: Isolation and Plating of NSPCs from E13.5 Mouse Brain 
 

 

Description: E13.5 mouse brains were isolated and the ganglionic eminences removed. Neural stem 

progenitor cells (NSPC) were then cultured and plated from the ganglionic eminences.  

 

Solutions and Reagents: 

 

 70% ethanol 

 Hanks balanced salt solution (Sigma; H2784) 

 1:1 Dulbecco’s modified Eagle’s medium [DMEM] and F12, 4 µg/ml heparin, 100 µg/ml 

penicillin/streptomycin; all Invitrogen) supplemented with 10 ng/ml bFGF, 20 ng/ml EGF and 

1:50 B27 without Vitamin A.  

 Phosphate buffered saline (PBS) without Ca2+ and Mg2+ 

 

Materials:  

 

 Vannas scissors 

 2 x Dumont 5 forceps 

 Fine curved forceps 

 60mm x 15mm organ culture dishes (Falcon BD) 

 15ml centrifuge tube 

 25cm2 filter-capped flask  

 Dissecting microscope 

 

Procedure:    

 

1. Isolate whole brains from E13.5 mice following SOP 47. 

 

2. Place the brains in a 10cm Petri dish with cold Hanks solution. 

 

3. Hold the brain steady with your left hand using curved forceps from the caudal side leaving 

the dorsal side facing upwards.  

 

4. Use vannas scissors to cut open the cortex of each hemisphere exposing the ganglionic 

eminences.  

 

5. Using dumont 5s extract the ganglionic eminences by cleaning away the surrounding tissue.  

 

6. Place the dissected tissue in a sterile 15ml centrifuge tube with cold Hanks solution. 

 

7. After all the brains have been micro-dissected and placed in the centrifuge tube, disaggregate 

by gentle reverse pipetting.  

 

8. Next, centrifuge at 1200x g for 5 minutes. Remove supernatant and tap the NSPC pellet.  

 

9. Resuspend the NSPC pellet in 5ml of Neurosphere Basal Medium (1:1 Dulbecco’s modified 

Eagle’s medium [DMEM] and F12, 4 µg/ml heparin, 100 µg/ml penicillin/streptomycin; all 

Invitrogen) supplemented with 10 ng/ml bFGF, 20 ng/ml EGF and 1:50 B27 without Vitamin 

A.  

 

10. Transfer cells to a 25cm2 filter-capped flask and monitor their growth into clonal aggregates 

over the next few weeks.  
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SOP 049: NSPC Cell Culturing 
 

 

Description: This method is used specifically for the culturing of neural stem/progenitor cells 

(NSPCS/neurospheres).  

 

 

Materials:  
 

NSPC Media (NSBM) 

 

      DMEM/F12+Glutamax media ---------------50ml 

      EGF (200µg/ml stock) -------------------------25µl 

      FGF (200µg/ml stock) -------------------------25µl 

      B27 ------------------------------------------------1ml 

      Pen/Strep ---------------------------------------500µl 

 

 

Procedure:  

 

Thawing Neurospheres 

 

1. Heat media in water bath for up to 10 minutes. 

 

2. Fast thaw cryovials for 30 seconds in the waterbath until there is a small icypole floating in 

the cell/DMSO mixture (do NOT thaw 100% because DMSO is toxic to cells).   

 

3. Transfer the contents of the cryovial into 10 ml of media. 

 

4. Centrifuge at 700x g for 7 minutes.  

 

5. Discard supernatant and resuspend pellet in 3 ml of media. Plate in an ultra low attachment 

six well plate. 

 Neurosphere Passaging  

 

1. Centrifuge neurospheres at 700x g for 7 mins. 

 

2. Remove the supernatant and re-suspend pellet gently in 2ml of trypsin EDTA for ~3 minutes 

at RT. Reverse pipette to achieve single cell suspension. 

 

3. Inactivate trypsin with 4 ml of NSBM. 

 

4. Centrifuge at 1200x g for 5 minutes and discard supernatant.  

 

5. Resuspend cells in NSBM and plate in an ultra low attachment six well plate.  
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SOP 050: Sudan Red Staining Protocol 

Description: This protocol describes the histological mechanisms of staining lipids, fat cells and neutral 

fat. This methods relies on the polyazo group of dyes which include the ‘oil red’ series, the ‘Sudan Red’ 

series and the ‘Sudan Blacks’ which can all be interchangeable and substituted in this method. The stain 

relies on the physical properties of the dye being more soluble in lipid than the vehicular solvent.  

SOP 050.1 Sudan Red Staining   

 

Fixation: 10% formalin or 4% paraformaldehyde (Formalin fixation gives good results) 

Section: OCT cryostat sections cut at 8-10µm or formalin fixed smears 

 

 

Solutions and Reagents: 

 

Sudan Red Stock Solution: 

    Sudan IV (Scarlet Red, Solvent Red 24; ProSciTech CI 26105) -------- 0.5 g 

    Isopropanol --------------------------------------------------------------------- 100.0 ml 

    Dissolve the dye in the isopropanol, using very gentle heat.  This is the stock stain. CARE - fire 

hazard. 

  

Sudan Red Working Solution: 

    Sudan Red stock solution ------------------------------------------------------ 120mL 

    Distilled water ------------------------------------------------------------------- 80mL 

    Allow to stand for 10 mins, and filter into a Coplin jar, and cover immediately.  The stain does not 

keep, and should be made up fresh from the stock solution each time. 

  

Procedure:  

 

1. Cut frozen sections at 8 to10mm, air dry the sections to the slides. 

 

2. Fix in formalin for 1 hour at room temperature. 

 

3. Briefly wash with running tap water 1-10 mins. 

 

4. Rinse with 60% isopropanol for 2 mins. 

 

5. Stain with freshly prepared Sudan Red working solution for 15 mins. 

 

6. Rinse with 60% isopropanol for 2 mins. 

 

7. Lightly stain nuclei with Lillie Mayers’ haematoxylin for 5 slow dips. 

 

8. Rinse with distilled water for 1 min. 

 

9. Mount in aqueous mountant or glycerine jelly. Pre-heat the glycerin jelly for 4x 10 secs 

intervals and transfer to the slide with an even distribution. Wait 1 min for the jelly to set and 

cover with a coverslip. 

 

Tips: 

1. Include a positive control for fat cells or lipids. 

2. The sections cannot be prepared in paraffin as they cannot be taken through clearing reagents 

(xylenes) prior to staining or mounting as this will remove the lipid to be demonstrated. 
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Results: 

 

Lipid......................................red 

Nuclei....................................blue 

 

SOP 050.2 Glycerine Jelly Mounting Medium  

 

 

Glycerine Jelly Mounting Medium 

      Gelatin (Kitchen grade) ------------10 g 

      Distilled Water ----------------------60 ml 

      Glycerol ------------------------------70 ml 

      Thymol (Sigma T0501) ------------0.25 g 

      Dissolve the gelatine in the distilled water using sufficient heat to melt the gelatine, add the glycerol 

and Thymol as an antibacterial agent.  Mix well and transfer to a small capped bottle and refrigerate. 

This can be kept for a few weeks at 4°C. Discard when it becomes turbid or mouldy. 

 

 

This traditional mounting medium is the most difficult one to use. Glycerol jelly must be must be 

warmed to about 40°C to melt the gel before using. It commonly needs to be freed of air bubbles, too. 

This can be done by warming the bottle (with cap loosened) in a vacuum-embedding chamber. 

  

After coverslipping with glycerol jelly, leave the slide on a warm (40-45°C), flat surface for about 30 

minutes, to let the medium soak into the section, and then remove it to a cool place to set. It is quite 

difficult to make a bubble-free preparation with this medium, and the bubbles can be tiny and numerous. 

Check with a microscope while the slide is still warm. If it's no good, remove the coverslip by soaking 

in warm water, and try again. 

  

This medium has a low refractive index (1.42). Because of this, many unstained structures remain 

visible, which may be an advantage or a disadvantage, depending on what you expect to see in the 

finished preparation. 
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STANDARD OPERATING PROCEDURE 
 
 
 

Title:  UVASens Suspension in Fluid 

Document ID: 051 

Author: Michael Nakai Date:  12 June 2018 

Effective date: 12 June 2018 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 12 June 2018 
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SOP 051: UVASens Suspension in Fluid 

Description: This protocol describes the creation of a 500µM solution of ortho-iodoHoechst 33258 

(UVASens) in a methanol/dH2O mixture. UVASens is a phototherapeutic agent able to cross 

membranes and can cause DNA double stranded breaks after binding to DNA minor grooves and 

exposure to UVA light. 
 

SOP 051.1 Suspending UVASens in a methanol/dH2O mixture   

 

 

Solutions and Reagents: 

 Dry UVASens (Powder) 

 Methanol 

 dH2O 

 

Procedure:  

 

1. In a dark environment, mix 450µL of methanol with 550µL of dH2O to create 1mL of the 

methanol/dH2O mixture. 

2. Add 500 nanomoles of dry UVASens to the 1mL mixture to create a 500µM stock solution. 

 

Calculations: 
 

500 nanomoles UVASens in 1mL = 500nM/mL 

500nM/mL = 500µM/L = 500µM solution of UVASens 
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STANDARD OPERATING PROCEDURE 

 
Title:  Rodent Brain Region Dissection 

Document ID: 0052 

Author: Sarah Bresnehan and 

Stevano Wijoyo 

Date:  1 July 2019 

Effective date: 1 July 2019 

Lab name: Epigenomic Medicine  

Version: 1  

 

 

 

 

SOP CHANGE LOG  

Version No. Reason for issue 

1 First issue 1 July 2019 
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SOP 0052: Rodent Brain Region Dissection 

Description: 

The dissection of specific brain regions becomes a central preparation step for further 

neuroproteomics studies. This protocol details separate dissections of the striatum, 

hippocampus and prefrontal cortex from a single mouse brain. 

 

Reference: 

Li KW. Neuroproteomics: Deciphering Brain Function and Disorders. In Neuroproteomics 

2011. Humana Press, Totowa, NJ. 

 

 

SOP 0052.1 Dissection 

 

Solutions and Reagents: 

 Formaline 

 

Materials: 

 Dissection Microscope 

 Acrylic plate 

 Small curved blunt forceps with serrated tips (FST11052-10 or FST 11152-10) 

 Larger Forceps with curved blunt tips (e.g. FST 11003-12) or standard pattern forceps 

(FST 11001-12) 

 Razor blade 

 Scalpel handle with scalpel (FST 10003-12 and FST 10011-00) 

 

Procedure:  

 

Note – the brain should be removed from the rodent prior to this procedure. 

 

 

PART 1: Cerebellum dissection 

1. Place the brain with dorsal side facing the dissecting acrylic plate. The pons, medulla, 

and cerebellum should be visible from upwards.  

2. With large curved serrated forceps, pull the medulla and pons upward. 

3. Using the small curved serrated forceps, separate the pons by pinching the 

pons/medulla-rest of the brain connection (the colour is whiter than the rest of the 

brain). 

4. After the pons is cut, put the brain with ventral side facing the dissecting plate. 

5. Place the small forceps between cortex and cerebellum, then snap the cerebellum off 

from colliculus inferior by pinching the groove between the cerebellum and the 

cortex. 

6. Remove the remaining pons sticking to the brain. Note that all previous steps should 

be performed within 1 min. 
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PART 2: Cortex dissection 

1. Place the brain with the ventral side facing the dissection plate. 

2. Using large curved serrated forceps, hold the brain in place gently. Close the small 

forceps, place them between the cerebral fissure 

3. Gently separate the two lobes by opening the forceps slowly. Repeat as needed until 

the corpus callosum (the white layer above hippocampus) below the cortex is partially 

exposed  

4. Once the opening is obtained for 60% along the midline, place small forceps and 

gently push the left cortex from the hippocampus by opening the forceps. Repeat until 

the top of hippocampus is visible. Same thing applies to the right cortex 

5. Lift up the left cortex with large forceps, insert small forceps in closed position. 

Gently open the small forceps repeatedly until the opening reaches caudal part of 

cortex-hippocampus connection 

6. Once the opening reaches the caudal part of cortex-hippocampus connection, push the 

small forceps until the cortex is nearly separated and exposed the whole left part of 

the hippocampus. The cortex can be snapped using small forceps or left attached for 

striatum and prefrontal cortex sample taking. 

7. Inspect the hippocampus (coloured more translucent) for traces of cortex (coloured 

pinkish or yellow) 

8. Repeat steps 5-6 with the right cortex. 

 

PART 3: Hippocampus dissection 

1. When the cortices are removed, fornix is revealed from the anterior part of the brain. 

Use small forceps to separate the fornix from the hippocampus. 

2. Separate two halves of hippocampus using the small forceps.  

3. Keep the whole brain in position with large forceps, while gently pushing right 

hippocampal half using small closed forceps. Push the hippocampal until the right 

hippocampal half is lying sideways of the brain. 

4. Using small forceps, pinch the right hippocampal half and gently roll it out to the 

(frontal/dorsal) side of the brain.  

5. Repeat steps 3-4 with the left hippocampal half. Do part 3 within 2-3 mins. 

 

PART 4: Striatum and Prefrontal Cortex dissection 

1. Following removal of the hippocampus, fold back the cortex into the original position 

using large forceps. Position the brain with its dorsal side facing the cutting board. 

2. Make coronal sections by where the striatum and prefrontal cortex are visible. 

3. To begin making sections, get a sharp razor blade and cut off the olfactory bulb. The 

first section contains primarily the motor cortex. The anterior commissure should be 

clearly visible at this point.  

4. Next, cut the section containing the medial prefrontal cortex.  

5. For the remaining brain, the genus corpus callosum should be visible along with the 

dorsal and ventral striatum which are divided from the adjacent cortex via the capsula 

externa. 
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6. After cutting this section, the main section of the brain should exhibit the joining 

anterior commissure. This denotes the absence of the ventral striatum. Hence, the last 

section should only contain the dorsal striatum.  

7. The last three section should be used for dissection of the prefrontal cortex and the 

striatum. 

8. For the medial prefrontal cortex – take section 1. This contains the prelimbic and 

infralimbic cortex which is visible through the darker area between the AFCC.  

9. Cut through the GCC in order to dissect the medial prefrontal cortex in a diamond 

shape.  

10. For the striatum – take section one, two and three. From section one, the central 

striatum should be visible as a dark structure surround by less translucent and lighter 

cortex alongside the AFCC. 

11. From section two, both the dorsal and ventral striatum appear darker. Along the 

midline, the septum (a structure that has a similar colour as the cortex) will separate 

the striatal halves. 

12. In section three, only the dorsal striatum will be present because the anterior 

commissure will not connect both hemispheres.  

13. Dissect the dorsal striatum away from the corpus callosum, adjacent capsula externa, 

cortex and ventricle and septum. 
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Appendix  I 

List of Companies and their Headquarters locations 
1 Abcam, Cambridge, UK 

2 AJAX Chemicals, Sydney, NSW, Australia 

3 American Type Culture Collection, Manassas, VA, US 

4 Amresco, Solon, OH, USA 

5 Applied Biosystems, Carlsbad, CA, USA 

6 Baxter Health Care, Sydney, NSW, Australia 

7 Beckman-Coulter, Fullerton, CA, USA 

8 Becton Dickinson, Franklin Lakes, NJ, USA 

9 BillupsRothenburg, San Diego, CA, USA 

10 Bio-Rad Laboratories, Hercules, CA, USA 

11 Biovision, Milpitas, CA, USA 

12 Broad Institute of MIT and Harvard, USA 

13 Bruker Optics GmbH., Ettlingen, Germany 

14 Buxco Electronics, UC, USA 

15 Calbiochem, Gibbstown, NJ, USA 

16 Chem Supplies, Gillman, SA, Aus 

17 Crystan, Dorset, England, UK 

18 CytoSpecTM, Berlin, Germany 

19 DAKO, Sydney, NSW, Aus 

20 DuPont, Wilmington, Delawarem USA 

21 Ebewe Pharma, Unterach, Austria 

22 Enzo Life Sciences, Farmingdale, NY, USA 

23 Epitomics, Burlingame, CA, USA 

24 Epitomics-Abcam, Cambrigde, UK 

25 FIJI, NIH, Bethesda, MD 

26 Fluka – Sigma, St. Louis, MO, USA 

27 GE Healthcare, Wauwatosa, Wisconsin, USA 

28 Gibco, Carlsbad, CA, US 

29 GIBCO-Invitrogen, Carlsbad, CA, USA 

30 GraphPad Prism 6, San Diego, CA, USA 

31 Greiner Bio-One, Kremsmünster, Austria 

32 HD Scientific Supplies, Sydney, NSW, Australia 

33 Hopkin & Williams Ltd, England 

34 Ibidi, Martinsried, Germany 

35 Illumina, San Diego, CA, USA 

36 Indofine Chemical, Hillsborough, NJ, USA 

37 Invitrogen, Carlsbad, CA, USA 

38 Leica Biosystems, Sydney, New South Wales, Australia 

39 Lomb Scientific Pty Ltd, Taren Point, NSW, Australia 

40 Lonza, Walkersville, MD, USA 
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41 Media Cybernertics, Maryland, USA 

42 Media Cybernetics, Rockville, MD, USA 

43 Menzel-Glaser, Braunschweig, Germany 

44 MetaSystems, Altlussheim, Germany 

45 Microsoft Office, Redmond, WA, USA 

46 Millipore, Billerica, MA, USA 

47 Molecular Devices, Sunnyvale, CA, USA 

48 Molecular Probes, Eugene, Oregon, USA 

49 NEN™ Life Science Products, Boston, MA, USA 

50 Nikon Ti, Tokyo, Japan 

51 NIS Elements Advanced Research, Tokyo, Japan 

52 Olympus America Inc, Center Valley, PA, US 

53 Omron Corporation, Tokyo, Japan 

54 Partek Inc., St. Louis, Missouri 

55 PerkinElmer, Waltham MA, USA 

56 Pfizer, New York City, NY, US 

57 Promega, Madison, WI, US 

58 Qiagen Inc., Valencia, CA, USA 

59 Quantum Scientific , Murarrie, Queensland, Australia 

60 Roche Diagnostics GmBH, Mannheim, Germany 

61 Santa Cruz Biotechnology, Dallas, Texas, USA 

62 Seahorse Biosciences, North Billerica, MA, USA 

63 Sephadex G-25; Pharmacia Biotech Inc., Piscataway, NJ, USA 

64 Sigma, St. Louis, MO, USA 

65 Sigma-Aldrich, St Louis, USA 

66 The Unscrambler X, CAMO, Norway 

67 Thermo Fisher Scientific Inc., Waltham, MA, USA 

68 Tree Star Inc., Ashland, OR, USA 

69 Universal Imaging Corporation, NY, USA 

70 Universal Imaging Corporation, NY, USA 

71 Unscrambler®, CAMO, Norway 

72 Upstate, New York, USA 

73 Wallac 1470 Wizard®, Perkin Elmer Life Sciences Inc., Wellesley, MA, USA 

74 Wallac, Waltham, MA, USA 

75 Whatman, Maidstone, Kent, UK 
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Appendix II 

Template for 96- well plates 
 

 1 2 3 4 5 6 7 8 9 10 11 12 

A             

B             

C             

D             

E             

F             

G             

H             

 

 1 2 3 4 5 6 7 8 9 10 11 12 

A             

B             

C             

D             

E             

F             

G             

H             
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Appendix III 

Template for 48- well plates 
 

 1 2 3 4 5 6 7 8 

A         

B         

C         

D         

E         

F         

 

 1 2 3 4 5 6 7 8 

A         

B         

C         

D         

E         

F         
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Appendix IV 

Template for 24- well plates 
 

 1 2 3 4 5 6 

A       

B       

C       

D       

 

 1 2 3 4 5 6 

A       

B       

C       

D       
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Appendix V 

Template for 12- well plates 
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Appendix VI 

Template for 6- well plates 
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Appendix VII 

Template for 8- well chamber slides 
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Appendix IX 

Imaging counting Tally 
 

Experiment:____________________________________________________________ 
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